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1  Introduction to DAAAC™ 
 
 
 

 

1.1 Introduction  

The DAAAC 4.0 data acquisition management system simplifies laboratory testing by 
centralizing data acquisition, analysis, archival and instrument control in a single, turnkey 
package.  DAAAC is specifically designed to address the demanding recording requirements 
associated with high-value transient events. 

The DAAAC user interface consists of four modules — Archive, Acquire, Analyze and 
CalMan — that operate as one system, documenting and organizing all test parameters, in-
strumentation, calibrations, characterizations and event data.  The Archive module is 
DAAAC’s database manager.  From Archive, users can select databases, import or export 
data and organize and transfer data.  The Analyze module displays and prints data and pro-
vides tools for examining and processing waveforms and images.  Acquire manages all in-
strument communication and inventory, as well as providing a consistent graphical interface 
for various instrument types.  CalMan manages component inventory and signal path defini-
tions that are then linked to all acquired waveforms.  A fifth DAAAC module, NetCom, pro-
vides the interface between the other DAAAC modules and the database.  While NetCom is 
an important part of DAAAC, it is not one that you will interact with.  Figure 1-1 depicts the 
DAAAC modules and their highest-level relationships.  One of the most important aspects of

the DAAAC architecture is that these five modules use inter-process communication (IPC) to 
exchange information and operate as a single integrated system  
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Figure 1-1- The DAAAC Modules 

1.2 Networked 
DAAAC installation and operation can be categorized in many ways.  One important 

distinction is between Networked and Stand Alone installations.  In “Networked” mode, 
there are two or more host computers, each running its own copy of DAAAC and each con-
trolling and acquiring data from its own set of connected instruments.  Each combination of 
host, DAAAC installation and instrument suite is known as a “Station”.  One station is des-
ignated as “Test Director”.  The test director instructs the other stations to perform an acqui-
sition and transmit data.  All data is gathered by the test director for reduction, display and 
storage in a single shot (see Section 1.5).   
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Figure 1-2 - Networked Dataflow and Communication Links 

1.3 Stand Alone 
Stand Alone mode is a special case of networked mode in which the test director is 

the only station present.  There is no network communication.  Only instruments connected 
directly to the test director will be configured and triggered and have their data acquired.  In 
this configuration the concept of station is an extra abstraction since there is always exact one 
station.  Nevertheless, from the perspective of the NetCom module, DAAAC operation be-
haves as though it were networked.  Figure 1-1 is representative of the Stand Alone DAAAC 
operation mode. 

1.4 DAAAC Installation Types 
Every DAAAC installation is custom.  This section begins by describing the keys that 

determine the characteristics of a particular installation.  Then the most common installation 
types are briefly presented. 

1.4.1 DAAAC Keys 
Every DAAAC installation is customized to the needs of its particular user group.  

All DAAAC installation disks include a set of custom software keys, specific to the user, that 
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lock and unlock various DAAAC features depending on the configuration purchased.  Keys 
are used to enable particular instrument drivers and signal path component types.  They are 
also used to enable custom menu items that are not generally useful to all users.  (For this 
reason, menus that appear in a particular DAAAC installation may not exactly match those 
discussed in this document.)  Keys are discussed in more detail throughout this manual. 

In addition to the custom keys, a user will need to execute a licensing program before 
running DAAAC.  This is discussed in detail in section 2.2 “License”. 

1.4.2 Full 
As the name suggests, this option installs a completely operable DAAAC system, in-

cluding all five modules.  In this context, “Full” installation refers only to the functionality of 
the five modules.  It does not mean that all instrument drivers or custom DAAAC features 
are accessible. 

1.4.3 Analysis Only 
The Analysis Only installation excludes Acquire and CalMan from the installation.  

No acquisition or data reduction is available.  It is a low-cost option for installations that are 
to be used to review and analyze data collected by other DAAAC installations.  Archive may 
be used to connect to existing databases through NetCom.  Analyze may be used to recall and 
review the data using tools available to Analyze. 

1.4.4 Analysis & CalMan 
The Analysis and CalMan installation is the same as Analysis Only except that Cal-

Man is available to reduce the data recalled by Analyze.  Only data acquisition is disabled in 
this installation. 
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1.5 DAAAC Configuration 
DAAAC comprises two distinct paradigms for the organization of its acquisition re-

lated objects.  The acquisition data (waveforms & images) hierarchy is shown in Figure 1-3.  
The instrument representation is seen in Figure 1-4.  Both figures introduce simple terminol-
ogy that has specific meaning in DAAAC. The table below the figures provides detailed 
definition of each term as it pertains to a particular model – data or instruments.  

 
Figure 1-3 - Data Organization 

 
Figure 1-4 - Instrument Organization 

 

A diagram of the entire DAAAC database architecture, including table links is shown 
in Appendix A – Database Organization. 
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Database The Database is common both to the Data and the Virtual Instrument organiza-
tions.  It stores either the raw and processed waveforms or image data captured 
in an acquisition.  It also maintains a complete picture of the DAAAC configu-
ration at the time of the acquisition and establishes links between the two or-
ganizational representations so that configuration parameters may be recalled 
and associated with the data. 

Data Organi-
zation 

Figure 1-3 - Data Organization 

Test  A test is a named collection of shots.  As such, it is a management tool that al-
lows the grouping of shots that share some common collection attribute such as 
instrument configuration, execution configuration, date, etc.  Tests are added 
and/or selected in Acquire by selecting Acquisition->Acquisition Configuration 
(Section 2.3.2.7) or in the Acquisition Configuration dialog that appear when 

 is clicked (Section 2.3.2.9) 
Shot A shot is a single instance of arming the suite of active instruments, detecting 

triggers from all armed instruments and receiving the data from those instru-
ments.  Normally the number of raw waveforms received in a shot will equal 
the total number of instrument channels configured.  If instruments are config-
ured to produce data in burst mode (Section 4.2.7.3) those instruments will pro-
duce multiple waveforms in a single shot.  Shots are distinguished by a serial 
value.  This value is normally automatically incremented by DAAAC.  In re-
petitive mode, multiple shots can be taken in a single acquisition sequence. 

Waveform A single waveform consists of one or two collections of X/Y (independ-
ent/dependent) pairs of data, received from a single instrument, producing a 
two-dimensional plot of the data.  The Raw data is the data collected directly 
from the instrument.  If configured, the Processed data is data produced by 
DAAAC by manipulating the Raw data as described in Section 2.3.3.  With 
multiple instruments and/or burst mode configured, there will be multiple 
waveforms in a single shot. 

Raw Data Raw data is a collection of X/Y (independent/dependent) pairs received directly 
from an instrument.  It can be used to present a two-dimensional plot. 

Processed Data Processed data is a collection of X/Y (independent/dependent) pairs generated 
by performing a series of user-configured operations on a Raw data collection.  
It is associated with its original Raw data in a single waveform. 

Image Data Rather that collecting standard X/Y pair data from instruments such as digitiz-
ers, DAAAC can be configured to control and receive data from cameras.  The 
data is three-dimensional with values representing the horizontal and vertical 
position and intensity of each pixel.  This image data can be processed, dis-
played, stored and recalled and exported just as waveform data in DAAAC.  
Processing functions that may be applied to image data differ from those ap-
plied to waveform data, but the tools have similar organization. 

Instrument 
Organization 

Figure 1-4 - Instrument Organization 

Station A station is a single node on a networked collection of nodes.  Each node con-
sists of a host running its own copy of DAAAC.  The host will be connected to, 
control and collect data from its own series of instruments.  These hosts are 
linked through NetCom and supervised by a Test Director station.  A stand-
alone configuration with a single host acts as a special case of the networked 
configuration, with the single Station acting as its own Test Director. 

Rack A Rack is a model, in Acquire, of a physical rack of instruments. On creation, it 
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is given a height that represents the total number of instruments that it can hold.  
Each station can hold any number of Racks and each rack can hold any number 
of instruments independent of the other racks in the station. 

Instrument An instrument is a model of a physical instrument attached to the station.  The 
instrument occupies a single position in a rack.  Each instrument is accompa-
nied by a driver, developed by VSI for DAAAC, and the suite of instruments 
available to a given customer is determined by that customer’s keys. In a rack, 
the instrument has a custom configuration dialog that allows the user to set pa-
rameters that will be used to configure the physical instrument before an acqui-
sition event. 

Channel Many instruments are able to capture and produce data from more than one 
source in a single shot.  The maximum number of sources for a given instru-
ment is given by the number of instrument channels available.  In a multi-
channeled instrument, DAAAC can be configured to receive data from any 
combination of the available instrument channels. 

1.6 Manual Organization 
This chapter has provided a very brief introduction to the capabilities, organiza-

tion and terminology of DAAAC.  The remainder of the manual will provide a more de-
tail look into DAAAC and examine all of the features that are generally available to any 
installation. 

 
• Chapter 2 -  Getting Started with DAAAC – This chapter begins with a simple de-

scription of the DAAAC installation and licensing process.  It then proceeds 
through every phase of the first execution of DAAAC, using a simple tutorial that 
will be available to all DAAAC Full installation customers.  This process will 
create a database and a station, install racks and add a Voss Wave (virtual) digi-
tizer that requires no actual hardware.  A test will be added, the instrument con-
figured and an acquisition sequence realized.  Finally, the chapter will configure a 
simple data reduction in CalMan and repeat the acquisition, producing Processed 
data derived from the Voss Wave instrument Raw data. 

• Chapter 3 -  Common DAAAC  
Features – This section describes general use elements of DAAAC that are com-
mon to the four main DAAAC modules and are common across the various pos-
sible installations and key sets.  Among the items discussed are the toolbar, the 
status bar, general menuing options and many others. 

 
The next four chapters present the four DAAAC modules.  The chapters begin 

with a narrative discussion of the modules they describe.  This discussion is as extensive 
as necessary to present a complete presentation of the purpose, configuration and opera-
tion of the module.  Detailed subsections discuss important elements of the module. 

The introductory section is followed by a section that describes the toolbar icons 
available to the module.  The presentation is a table showing the toolbar icons and a de-
scription associated with each.  Subsections following the table present detailed discus-
sions of the toolbar functions.  

The third section in the module chapters presents the module’s menu structure.  
This discussion is also tabular and is hierarchical.  The first table presents the main menu 
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items, left-to-right on the module.  Each of the main entries is then broken out into a table 
that contains the menu entries under the main menu.  The entries are presented by name, 
followed by a description.  In many cases the description in the table is sufficient and no 
further detail is provided.  Where the menu entry needs clarification, a section below the 
table provides the additional detail, item-by-item.  The detail will include a discussion 
and any shortcuts to the operation.  Many menu items open one or more dialogs.  If the 
dialog is simple, it is often omitted with a simple reference to its detailed discussion in 
Appendix B.  Otherwise the dialog will appear as an image along with a discussion and a 
table detailing the dialog’s controls. 

Menu presentations may vary depending on the current DAAAC or module pro-
gram status or the keyed features installed.  Where an item depends on the installed keys, 
it will be highlighted with the  icon.  Menu entries may also differ for networked and 
standalone installations.  Where the discussion applies only to networked installations, 
the text is highlighted in blue.  The module chapters are: 

 
• Chapter 4 - Acquire – The Acquire chapter presents, in detail, a complete descrip-

tion of the Acquire module including menuing, dialogs and the acquisition proc-
ess.  The chapter describes virtual instrument configuration and the data acquisi-
tion process 

• Chapter 5 – Archive – The archive module manages the various databases that 
have been created under DAAAC.  It provides access to waveforms that have 
been acquired into a particular database.  This chapter describes all Archive mod-
ule functionality. 

• Chapter 6  - CalMan – This chapter provides a detailed description of the func-
tionality of CalMan.  CalMan allows the captured signal to be modified through 
preprocessing.  Preprocessing mathematically backs out the effect of various 
components (cable, attenuators, etc.) in the signal path to estimate the actual raw 
input signal.  It also provides for signal post processing.  In that case the detected 
signal is manipulated to perform analysis.  Each manipulation of the data is repre-
sented by a Cal Item.  A large number of Cal Items are available.  Several specific 
Cal Items are referred to in Chapter 6 as examples and a detailed discussion of 
operations and parameters that apply to Cal Items in general is provided.   How-
ever, details of specific Cal Items are reserved for Appendix E.  

• Chapter 7 – Analyze – Raw and Processed data is shown in this module after data 
capture by Acquire and processing by CalMan.  Existing data may also be re-
called from the database or imported into DAAAC.  Once displayed in Anaylze, 
the data can be examined using tools that apply directly to the data presentation.  
These include such mechanisms as cursors, combining data into single plots, sub-
sampling data or computing Figures of Merit (FOMs). 

• Chapter 8 – NetCom – A very brief description of the NetCom program is pre-
sented.  The NetCom module is the mechanism that coordinates actions between 
the other modules. 
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1.7 Appendices 
A companion document to this manual contains the appendices.  The appendices 

provide reference information that is ancillary to the manual.  The also provide program 
detail that is beyond the scope of the manual.  The appendices are: 

 
• Appendix A – Database Organization – This is a single image that details 

the various tables in the database and their relationship to each other. 
• Appendix B – DAAAC Dialogs – This section presents a detailed descrip-

tion of every dialog in DAAAC.  Organized by module, each dialog dis-
cussion has four subsections including a typical dialog image, a narrative 
discussion, a table that names and describes each control and an indication 
of the ways the dialog is accessed.   

• Appendix C – Figures of Merit – Every Figure of Merit available within 
DAAAC is presented in one of two tables.  The first table relates to wave-
form data and the second to image data.  Columns in the image data table 
name the FOM, give a detailed description and name and describe any 
user-configurable parameters.  The waveform data table adds a column 
that describes the type of waveform for which the FOM is intended to be 
used.  The FOM will operate on any waveform input, but will provide a 
valid evaluation only for the appropriate input waveform type.  Note that 
FOMs in CalMan have user-configurable parameters.  These are absent in 
Acquire and Analyze.  Table entries for FOMs with such parameters will 
specify what the fixed value is for the parameter.  FOMs are presented al-
phabetically in the tables. 

• Appendix D – DAAAC Installation File Structure – This appendix pro-
vides a hierarchical summary of the files that are written with a typical 
DAAAC installation. 

• Appendix E – Cal Items – This section provides a detailed narrative de-
scription of every Cal Item.  Some Cal Items are generic and grouped un-
der a single common description.  The organization of the entries varies 
depending on the type and complexity of the Cal Item. 

• Appendix F – DAAAC Installation File Structure – This appendix pro-
vides a hierarchical summary of the files that are written with a typical 
DAAAC installation. 
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2  Getting Started with DAAAC 
 
 

2.1 Installing DAAAC 
To install DAAAC 4.0, simply put the disk into your CD-ROM drive and the in-

stallation program will launch automatically.  A few dialogs will open, during installa-
tion, that allow specification of the target directory and other options.  If needed, 
DAAAC will install Microsoft™ DAO and ODBC components, and a CrypKey service.   

DAAAC should be uninstalled only when it will no longer be used on a computer.  
DAAAC is uninstalled using the Add or Remove Programs applet in Control Panel (from the 
Windows Start button, select Settings, then Control Panel).  Be sure to back up any 
DAAAC database (.mdb) files before uninstalling the application.  Many user settings are 
stored in the registry, which is cleared during the uninstall process.  Reinstalling DAAAC 
will not restore those registry settings. 

Note:  Do not change permissions or locations of any files installed by DAAAC.  
You will break it. 

Note:  You must have administrator privileges in order to install since the DAAAC 
installer will be writing to the registry.   

2.2 License 

When first starting DAAAC 4.0, it will tell you that it is not licensed.  When this happens, 
run License.exe (located in the root directory where DAAAC was installed).  The license applica-
tion will display a site code (see Figure), that is 
unique for each DAAAC installation.  Contact Voss 
Scientific at 505-256-1500, daaac@vosssci.com, or 
info@vosssci.com with this site code and we will 
give you the site key to enter in the license applica-
tion.  After you have entered the site key and serial 
number (printed on the DAAAC installation disk), 
press License to enable DAAAC.  

To unlicense the DAAAC software without 
uninstalling it, simply delete the LicMgr.key file in 
the DAAAC directory. 

Note: DAAAC is only licensed to run under 
the directory in which is installed.  Do not attempt to 
move any DAAAC files written by the installer. 

   

   Figure 2-1 - License Manager 
Note: If DAAAC is not properly licensed, Archive and the other modules will not start.  The exe-

cution will simply show the warning: 



                  

DAAAC 4.0 User’s Manual   11

 
Figure 2-2 - Starting and Unlicensed DAAAC Installation 

2.3 First Execution 
This section will walk the first time user through a simple, but complete, system configu-

ration and execution.  A database will be created.  Since this is a Stand Alone example, no sta-
tion will be added to Acquire.  Acquire will be configured by adding a rack, adding an instru-
ment to the inventory and to the rack and configuring the instrument.  A test will be created and a 
shot will be taken and the data displayed for review in Analyze. A simple CalMan data reduction 
will then be configured and a second shot will generate both the raw and processed (reduced) 
data that will again be presented for review in Analyze.   

The instrument to be added will use the Voss Wave driver.  This is a virtual digitizer that 
generates a synthetic signal just as though it were captured by a digitizer.  No instrument need be 
connected.  The Voss Wave driver is available to all users, regardless of key set.  The new user 
should be able to duplicate the actions in this section exactly, but please feel free to experiment. 

2.3.1 Database 

Begin by double-clicking the DAAAC icon  that the installer placed on the 
desktop.  All five DAAAC Modules will open in minimized mode and will be accessible from 

the task bar along the bottom of the desktop.  Click on the Archive task  to show 
it.  The first order of business is to create a database to contain all of the information about 
DAAAC configuration, instrument configuration and acquired data. 

The database is a Microsoft Access format file.  It can have any name and be stored any-
where on the host computer or networked hard disk.  DAAAC may have any number of data-
bases open at a time.  However only one database is active.  That database will receive all of the 
information generated by actions in DAAAC until the active database is changed. 

On first execution, Archive will automatically begin the process of adding a database by 
opening a standard Windows browser dialog.  Navigate to an appropriate folder.  (Folders can be 
created during navigation.)  Assign a file name and click Open.  The new database appears as a 
document in the Archive window.  This document will be discussed in detail in section 5.1.1.  
Note that if an active database was already visible in the Acquire window, the new database 
would appear with it, but the existing database would remain active until databases are changed.  
See section 5.2.1. 
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Figure 2-3 - Creating a New DAAAC Database. 

 
Figure 2-4 - New Database Window in the Archive Module 
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2.3.2 Acquire 
This section walks through each step of the process of configuring Acquire to capture 

data for the first time.  Throughout the process an example is presented that can be duplicated by 
the first time user on any installation that includes Acquire.  A Voss Wave instrument is used to 
generate the data.  The Voss Wave driver is a virtual instrument that is available to all installa-
tions, regardless of key set.  As a virtual instrument, no actual hardware need be connected to the 
host computer. 

2.3.2.1 Add Station 
Before any action can be performed by DAAAC, at least one station must be added to the 

database.  (In a Stand Alone installation, only one station will be added.)  The Acquire module 
will automatically open the station configuration dialog on first execution as in Figure 2-5.   
 

 
Figure 2-5 - Add a Station & Set Rack Count 

As shown in the figure, the station is identified by name (required) and can include a de-
scription (optional).  The network address of the station is set here.  In Figure 2-5, the address is 
fixed at 127.0.0.1.  That is the universal address of the local machine.  Since it is fixed, this indi-
cates that the installation is Stand Alone.  The number of racks is assigned here.  Note that once 
the number of racks is set, it cannot be reduced, though it can later be increased.  Configure this 
dialog as appropriate, then click Next>. The Rack configuration dialog will appear. 
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2.3.2.2 Add Rack 

 
Figure 2-6 - Configure Racks 

Racks are identified by name.  The default name is “Rack #n” and is sufficient, though 
not descriptive.  This dialog allows each rack to be independently named and have its height set.  
“Height” indicates the number of instruments that can be placed in the rack.  Once the racks are 
configured, click Finish to open Acquire. 
 

 
Figure 2-7 - First Instance of Acquire 

 

Double-Click 
Here to Re-
verse Instru-
ment Order 

Right-Click Any-
where Here to Ac-
cess Properties 

Right-Click a Box to Add 
an Instrument 
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To increase the number of racks and/or the size of any rack, right click in an empty space on the 
station window and select Properties from the popup menu.  A single dialog appears that con-
tains, as tabs, the dialogs of Figure 2-5 and Figure 2-6.  This dialog can be used to completely 
reconfigure the station. 

2.3.2.3 Add an Instrument to the Inventory 
Before adding an instrument to a position in a rack, the instrument must be added to the 

available inventory.  This can either be done independently as a distinct operation, or can be 
done as part of the process of adding an instrument to a rack.  This tutorial will examine the latter 
process.  Right-click in any empty box on any rack and select Add from the popup menu. The 
Inventory dialog will appear. 

 

 
Figure 2-8 - Adding an Instrument to the Inventory 

Select the manufacturer of the appropriate instrument from the Manufacturer list (select 
Voss Scientific).  The entries in this list will vary depending on the key set installed.  Select the 
appropriate model (Wave) from the Model column.  The instrument must be added to the inven-
tory by serial number.  The serial number may either be manually typed or generated by 
DAAAC.  Either type into the Serial Number: control or click Generate.  The serial number will 
appear in the Serial Number control.  Click Add New Item to add the item to the Inventory.  The 
item will appear, by serial number, in the Serial Number column. 

2.3.2.4 Add Instrument to Rack 
Select the instrument so that its serial number is highlighted in Serial Number then click 

Next> in the dialog of Figure 2-8. A dialog will appear that will allow the instrument to be 



                  

DAAAC 4.0 User’s Manual   16

named.  The dialog may also have a Setup button enabled.  If it does (as Voss Wave does) the 
button must be clicked to complete the setup. 

 

 
Figure 2-9 - Add Instrument Dialog 

Clicking Setup opens an additional instrument configuration dialog.  In the case of Voss 
Wave, the user chooses between Turbo Mode and Normal.  (Turbo Mode is unique to the Voss 
Wave Driver.  In Normal mode, synthetic delays are added to the acquisition sequence to mimic 
delays in communicating with an actual instrument.  In Turbo Mode, the delays are disabled and 
the acquisition occurs as fast as the software is capable.)  For the purposes of this tutorial, select 
Normal mode.  

Note: For all drivers with a Setup button, the configuration presented in the Setup dialog 
is permanent one the dialog is closed.  Such configuration must be made to accurately reflect the 
hardware configuration since it cannot be changed later during instrument configuration. 

 

 
Figure 2-10 - Additional Instrument Setup 
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Click OK, then Finish.  The instrument will appear in the rack in the position indicated 
when the process started.  The instrument name will appear along with an icon specific to the 
instrument type. 

 

 
Figure 2-11 - Acquire with an Instrument Added 

2.3.2.5 Instrument Status 
Before proceeding, it is important to note that an instrument may be in one of several 

states when located in the Acquire rack.  Furthermore, not all instruments in the rack will neces-
sarily be in the same state.  The state of the instrument is normally designated by text in the rack 
position and by the color of the instrument background.  (The Voss Wave instrument, at this 
point, should indicate “Active” and have a purple background.) Table 1 shows and defines the 
various instrument states as a function of color. 

Double-Click to Configure 
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Table 1.  Instrument Status Codes.  
Inst. Color State Meaning 

Light blue Idle Instrument is not in use. 
Purple Active (in use) Instrument is active and communicating with DAAAC. 
Dark Blue Not available Instrument is active, but not communicating with DAAAC. 
Yellow Initialized Instrument is active, and has been initialized by DAAAC. 
Light Green Armed Instrument is armed and ready for trigger. 
Dark Green Triggered Instrument has triggered and waiting to download data. 
Orange Read Out Instrument is downloading data. 
Red Error An error has occurred while communicating. 

2.3.2.6 Configure Instrument 
Acquire is now ready to create a test, then arm the instrument, wait for a trigger and re-

cover data.  However, the instrument will operate based on a default set of configuration parame-
ters.  These should be reasonable, but do not necessarily reflect the needs of a particular meas-
urement.  To configure the instrument, double-click on its location in the rack.  A tabbed dialog 
will open.  The dialog will be specific to the instrument being configured.  Most dialogs will 
have, as a minimum, a Main Settings tab, a Channel Settings tab and a Utility tab.  

   

 
Figure 2-12 - Voss Wave Configuration Dialog 

 
The Main Settings tab will always include controls to set the instrument to Active or Idle 

and to allow the instrument to be renamed.  The remaining controls will depend on the type, 
manufacturer and model of the instrument.  The Voss Wave driver will generate up to two pulse 
waves and two sine waves depending on the number of channels enabled.  The main dialog is 
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used to determine the total number of point captured and the time between points.  The config-
ured values are applied to all channels. 

 

 
Figure 2-13 - Voss Wave Channel Dialog 

In all drivers that produce data, the Channel Settings dialog is used to name each channel, 
provide an optional description for each and determine which channels are to be captured.  Addi-
tional controls depend on the driver.  In the example of Figure 2-12, Channel 3 is not to be cap-
tured.  Each channel has been assigned a name and description and has been given a voltage 
range over which to produce data.  Other controls have been left as default. 
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Figure 2-14 - Voss Wave Utility Dialog 

The Utility dialog tab is common to all drivers.  It is used to save the current configura-
tion to a file from which it may be recalled to configure other identical instruments.  The current 
configuration may also be set as the default.  Occasionally, this dialog will vary slightly between 
instruments.  Once the configuration is set and reviewed, click OK to return to the Acquire win-
dow. 

2.3.2.7 Add Test 
In order to run an acquisition (or “shot”), the acquisition must be associated with a test.  

A test is created and/or selected as a part of acquisition configuration.  The Global Settings dia-
log will appear when the acquisition is started by clicking , or can be accessed through Acqui-

sition->Acquisition Configuration or by clicking .  The Global Settings dialog will open. 
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Figure 2-15 - Global Settings Dialog 

The Global Settings dialog is used to configure many acquisition parameters.  These are 
detailed in Appendix B, Section 2.1.0.  Here, the interest is in creating a new test. Click Create 
New Test.  A dialog will appear that allows the test to be named and an optional description to 
be applied. 
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Figure 2-16 - New Test Dialog 

After naming the test, click Add.  The dialog will close and the test name will be added to 
the Global Settings dialog Test Name list.  Make sure that the test name is highlighted, and then 
click OK to proceed with the acquisition. 
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Figure 2-17 - Global Setting Dialog with Test Added and Selected 

2.3.2.8 Acquisition Sequence 
Before proceeding with the tutorial example, this section will present a brief overview of 

the automatic acquisition process as shown in Figure 2-18.  A more-detailed description will be 
found in section 4.1.3.  That section will also detail the manual acquisition process and various 
other acquisition modes. 

Once the Acquire module has been populated with configured instruments and the mod-
ule is able to locate at least one of those instruments, automatic acquisition begins by pressing 

 on the Acquire tool bar.  The first thing that will happen is that Acquire will present a dialog 
in which the test is configured.  This is not shown in Figure 2-18, but is discussed in Section 
2.3.3.6.  Once a Test is designated, Acquire initializes and arms all active instruments.  It the re-
peatedly polls the instruments until all are triggered or until a timeout occurs.  When either event 
occurs, Acquire gathers data from all triggered instruments.  The data is then passed to NetCom 
for storage in the database, to Analyze for display and to CalMan for reduction.  Once CalMan 
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has reduced the data, the processed data is also sent to NetCom for storage and to Analyze for 
display.   

This is a very simplified description of the procedure.  The actual operation is much more 
complex and highly variable, depending on the configuration of Acquire, Analyze and CalMan.  
More detailed descriptions will be presented as appropriate.  For now, this will be sufficient to 
run this tutorial. 

 
Figure 2-18 - Simplified Automatic Acquisition Sequence 

Acquire Module 
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2.3.2.9 Make the Shot 

Click .  Create the test as described in Section 2.3.2.7.  The acquisition will proceed 
automatically through the following sequence:  

 

 ->  -> 

 ->  -> 

  ->  

Figure 2-19 - Standard Acquisition Sequence. 

2.3.2.10 Review the Data 
Once the Read Out phase is complete, Acquire will automatically send the data to the da-

tabase and to the Analyze module.  Analyze automatically displays the data as it is received.   
 

Feel free to experiment with any of the options in Analyze.  Many options are available 
by right-clicking on a data plot.  Others will be accessed through the extensive menu system.  All 
of these options will be described in detail in Chapter 7.  Reconfigure the driver and repeat the 
measurement as desired.  
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Figure 2-20 - Voss Wave Data Displayed in Analyze 

 
 

 
Figure 2-21 - Acquired Data in Archive 
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2.3.3 CalMan 
The final stage in this “First Execution” tutorial is to reacquire the data and perform a 

simple data reduction on the raw Voss Wave waveforms.  The reduction is performed by the 
CalMan module.  CalMan is a very complex program that will be detailed in Chapter 6.  For the 
purposes of this tutorial, only those steps necessary to produce the data reduction will be dis-
cussed. 

 
At the highest level, CalMan performs two functions: 
 
1. Process the acquired data to account for the influence of components in the acquisi-

tion signal path that altered the data.  In this case, the acquired data is taken back 
along the signal path and sequentially adjusted for the influence of the physical com-
ponents until an estimation of the signal that entered the sensor is reached. 

2. Manipulate the acquired data in some way that is useful to the process of understand-
ing it.  Rather than unfiltering the data to generate a clearer picture of the actual sig-
nal, this process introduces additional filtering to perform analysis. 

 
The reduction done in this section will perform the second of these functions.  The processing 
performed will have no particular meaning.  The purpose is strictly demonstration.  The process-
ing will be as follows: 
 

• Channel 1 will be linearly transformed by 12.25 X Data – 17.2. 
• Channel 2 will be multiplied by channel 1 (before transformation) 
• A Fast Fourier Transform (FFT) will be performed on Channel 4. 

 
In CalMan, go to Graph->Stations.  In the dialog that appears, select “Voss Wave Tuto-

rial and click OK.   
 

 
Figure 2-22 - Open a Station in CalMan 
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A window for the station opens in CalMan.  The station is represented by a rectangular 
icon in the upper-left corner of the window.  Right-click on the station and select Insert a new 
cal-line from the popup menu to start creating the data reduction. 

 

 
Figure 2-23 - New Station Window in CalMan 

In the dialog that appears, expand the tree and double-click on the Channel 1 entry to add 
a Cal Line. 

 

Right-Click to Start Development 
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Figure 2-24 - Add Cal Lines 

A dialog appears to add an optional description to the Cal line. 
 

 
Figure 2-25  - Describe the Cal Line 

When the New Cal Line dialog is closed, a second appears to configure the Cal Line 
Characteristics.  Accept the defaults and just click OK.   

Double Click 
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Figure 2-26 - Configure the Cal Line 

Repeat the process of Figure 2-24 through Figure 2-26 for channels 2 and 4.  Click Fin-
ished on the dialog of Figure 2-24.  The station window is updated with new icons that are linked 
by gray lines that show association.  To the right of, and slightly below, the station icon is an 
icon that represents the Voss Wave instrument.  To the right of this, vertically aligned, are three 
icons.  Each of these represents a channel. 
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Figure 2-27 - Cal Station with Cal Lines Added 

Right-Click on the Channel 1 Icon and select Insert cal item to the RIGHT from the 
popup menu.  The Item Inventory List dialog will appear. 

 

 
Figure 2-28  - CalMan Item Inventory List 

Right Click 
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Just as with instruments to be added to a rack in Analyze, a data reduction item must be 
added to the CalMan item inventory before it can be used in a Cal Line.  Furthermore, if the item 
is not in the inventory it must be created as part of the inventorying process.  In the Cal-Item 
Types column, select User Process and click Create. 

 

 

 
Figure 2-29 - Start the Cal Item Inventory 

A dialog opens that allows the Cal Item to be named.  As usual, an option description 
may be applied.  There are also fields to specify the axis titles and units.  Click User Processing 
Definition to define the transform. 
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The user process being defined acts as a macro that can perform any number of user-
defined operations, in a series, on the data.  In the dialog that appears, first select the last tab and 
click Start.  This begins the macro recording process.  It will expand the dialog to show the list 
of processes added to the macro and the Start button becomes a Stop Button.  Switch to the first 
(Calculator) tab.  Select y * C and enter 12.25 in the calculator that appears.  Then select y – C 
and enter 17.2.  Close the dialog.  The Inventory dialog will appear with the new Linear Trans-
form 1 item entered.  Make sure that the item is highlighted.  Close the dialog.  The transform 
appears as a new icon to the right of the Channel 1 icon in the station graph.  The entire process 
is shown in the following sequence of figures. 

 

 
Figure 2-30 - Define the User Process - Click Start 
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Figure 2-31 - The Macro Recording Has Started. 

 
Figure 2-32 - Select the Calculator Tab and Click y * C 
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Figure 2-33 - Enter 12.25 

 
Figure 2-34 - Click y  - C 



                  

DAAAC 4.0 User’s Manual   36

 
Figure 2-35 - Enter 17.2 

 
Figure 2-36 - Final Macro List 
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Figure 2-37 - Inventory Dialog with Cal Item Added and Selected 

 
Figure 2-38 - Station Graph with User Process Icon 
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Repeat the process, starting at Figure 2-28, for Channel 4.  This time select the Advanced 
Functions tab.  Click FFT and accept the defaults in the dialog that appears (or configure the 
transform as preferred.) Close the series of dialogs. 

 

 
Figure 2-39 - The Advanced Functions Tab 

 
Figure 2-40 -The FFT Configuration Dialog 
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Figure 2-41 - The FFT User Process Item Appears 

 
Figure 2-42 - Updated Station Graph 

For Channel 2, select the Combine Cal-Item Type.  In the dialog that appears when you 
click Create, select Multiply for the Combine: control option. Close the dialogs.  Again the reduc-
tion icon appears to the right of the Channel 2 icon.  Right-click on the reduction item and select 
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Select Combine Operand from the popup menu. Then click with the left mouse button on the 
Channel 1 icon (not the reduction icon).  A line joining the Channel 1 icon with the bottom of the 
Channel 2 reduction icon appears indicating a data relationship. 

 

 
Figure 2-43 - Combine Item Configuration - Select Multiply 

 
Figure 2-44 - Combine Item in the Inventory 
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Figure 2-45 - Combine Item Added to the Graph 

 
Figure 2-46 - Start the Channel 1 Association 
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Figure 2-47 - Final CalMan Configuration 

CalMan is now fully configured as specified.  Return to the Acquire module and click 
.  Select the same test in the Global Setting dialog and allow the execution to proceed.  Once 

again, Acquire will arm the virtual instrument, wait for data and collect the data.  The data will 
be written to the database and displayed in analyze.  The data will also be sent to CalMan for re-
duction.  CalMan will perform the various manipulations.  The processed data with also be sent 
to the database and presented in Analyze. 
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Figure 2-48 - Raw and Processed Voss Wave Data 

 
Figure 2-49 - Raw and Processed Voss Wave Data in the Database 
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3  Common DAAAC  
Features 

 

3.1 Tool Bar 

The main Toolbar is visible under the applications main menu, provided the user has en-
abled it.  Commonly used operations are placed in the toolbars, but note that some operations 
may only be available via the application menu or right-click menus.  All DAAAC toolbars can 
be docked under the menu, on left side of the window, or floated anywhere on the screen.  To 
move the toolbar, use the left mouse button to grab it in any area that does not contain a button.  
The figure shows the task portion of the toolbar.  All DAAAC modules show this portion.  The 
set of icon represent the three DAAAC modules that are not the module with the task bar.  Click 
an icon starts a module (if it is not started) and switches to it. 

 

3.2 Status Bar 

Status bars are displayed at the bottom of each DAAAC module’s main window.  To dis-
play or hide the status bar, use the Status Bar command in the Preferences menu. 

 
The left area of the status bar describes actions of menu items as you navigate through the appli-
cation’s menus. Similarly, this area shows messages that describe the actions of toolbar buttons 
as you depress them, before releasing them.  If you choose not to execute the command after 
viewing the description, move the pointer off the toolbar before releasing the mouse button.  
During some multi-step operations and automatic sequences, the status bar will also provide in-
structions or sequence information.  In some cases the status bar is the only indication of a pro-
gram action that is occurring. 

3.3 Menu 
While each DAAAC module contains a unique set of functionality, many operations are 

common to all modules or fall into common categories.  The menu structure is therefore similar 
in all DAAAC modules, with the following layout: 
 
Menu Description 

File File functions (open, close, save) and printing. 
Tasks Task switching between DAAAC modules. 
Edit Cut, Copy, Paste and Undo operations. 
Preferences Default settings and display / layout preferences. 



                  

DAAAC 4.0 User’s Manual   45

Module Specific Variable number of module-specific menus. 
Tools High-level operations that are specific to each module. 
Data View Interfaces to view the specific data objects supported by the module. 
Window Functions to arrange the module-specific data windows. 
Help On-line help, tutorial, about box. 

 
The common items under each of these menus are discussed in the following subsections.  

Module-specific menu items are discussed in the sections for those modules. 

3.3.1 Task Menu Item 

The Tasks menu switches from one DAAAC™ module to another. If the requested module 
is not active, DAAAC™ will start and switch to it.  The same function can be performed by se-
lecting a module’s button from the toolbar.  See Section 3.1, for more information.  Each module 
will contain three task icons in its toolbar – one for each of the other user modules.  The icons for 
task selection are shown below. 

Icon Module 

 
Archive 

 
Acquire 

 
Analyze 

 
CalMan 

3.3.1.1 Help 

The Help menu contains the following commands:  
Item Description 

Help Topics Offers an index of available help 
Tutorial Opens DAAAC’s on-line tutorial. 
About Displays DAAAC’s version number and configuration information. 
License  Displays the DAAAC license agreement. 

3.3.1.1.1 Help Topics 

Help Topics invokes Help’s Table of Contents.  Help topics are organized by modules, 
overviews, procedures and features.  Tutorial and setup instructions are also available from 
Help’s Table of Contents.  

Help’s opening window contains tabs to select the following methods of finding help:  
Item Description 

Contents Displays three main topics: Getting Started, How To and Menu. 
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Index Contains an alphabetical listing of Help text, and some items contain sub-items. In-
dex is best for specific help. 

Find  Searches Help for keywords or phrases. When Find is first activated, a database is 
constructed. You may select different levels of detail for building the database. The 
most detailed version is recommended for maximum search capabilities.  

3.3.1.1.2 About Box 

About displays the copyright notice and version information for each DAAAC module. 

 
Figure 3-1 - The DAAAC  "About" Box 

DAAAC’s module name, current version, and release are displayed at the top. 
Item Description 

System Type Standalone (single computer) or networked 

Serial # The unique serial number for this license 

Privilege Level not currently selectable – all DAAAC systems use Admin 

Warning Level not currently selectable – all DAAAC systems use Verbose 

NetCom The computer on which the current NetCom resides 

Database The current active database 

Build Date The date and build number of the current release 

The copyright notice and contact information are displayed at the bottom of the dialog.  
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3.3.1.1.3 Context Help 

Context Help presents help on any DAAAC feature. With Context Help, the mouse pointer 
will change to an arrow with question mark. Help will be presented on any item selected with 
this pointer, such as a toolbar button or data window.  
Shortcuts 

Toolbar:  

Keys: [Shift]+[F1] 

3.4 Waveform Selection Dialog 

The Waveform Selection dialog is displayed when selecting raw and processed waveform 
and image data from the database.  For example, it can open waveforms for editing in Analyze, 
or it can select a waveform as a characterization curve in CalMan.  This interface also is used to 
delete waveforms and images from the database, and to view data records (instrument settings, 
cal lines, system configuration) associated with acquired waveforms and images.   

 
Figure 3-2 - The Waveform Selection Dialog 

The left pane contains the categories Station, Test and Trash. Click the + or – leaves to ex-
pand or contract each category.  Click on the top level Waveforms entry to see all available data 
in the right pane.  

The right pane contains the current list of waveforms and images.  The contents of this list 
can be changed by selecting a category from the control on the left or by performing a Search 
operation.  Clicking on a list column header sorts the list items by that column’s field.  The de-
fault sort parameter is Time.  Right clicking on a waveform in the list opens a popup menu that 
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displays the Log Page, SysInfo, Instrument and Cal Line settings in effect when the data was ac-
quired.  You may also select Restore Historic Configuration from the right-click menu to restore 
the full system configuration that was in effect when the data was acquired.  Restoring a historic 
configuration will replace the current instrument and Cal Line configurations with the historic 
settings. 

The Waveform Selection dialog contains the following menu items, toolbar items, and 
controls: 
Item Description 

Trash Menu Options for removing waveforms from the database.  

Delete Waveforms 
(Trash menu) 

Removes all currently selected waveforms from the database. When wave-
forms are first deleted, they are only tagged as deleted and not displayed in 
the waveform list, but they remain in the database. They are not perma-
nently removed from the database until Empty Trash is selected. A dialog 
is then displayed asking if associated waveforms (raw if deleting proc-
essed, and processed if deleting raw) also should be removed. When Yes is 
selected, the waveforms are permanently removed from the database. 

Recover (Trash 
menu) 

Deleted waveforms that have not been emptied from the Trash can be re-
covered. To recover deleted waveforms, they must be displayed in the list. 
Select View Trashed Waveforms (see below) or click the Trash icon in the 
left pane to see data in the trash. Select the data to recover from the list, 
then select Recover Waveforms from the Trash menu. A dialog is dis-
played asking if associated waveforms (raw if recovering processed, proc-
essed if recovering raw) also should be recovered. If Yes is selected, the 
associated waveform is recovered and again available.   

Empty (Trash 
menu & toolbar) 

When selected, all waveforms and images in the Trash are permanently 
removed, after prompting. 

Warning! Empty Trash permanently removes the items from the data-
base. They cannot be recovered. 

View Trashed 
Waveforms  
(View menu) 

Displays deleted items in the waveform list along with the items that have 
not been deleted.  Deleted data (items currently in the trash) is shown with 
a red icon.  Items that have been emptied from the trash are not displayed. 

Select Data Types 
(menu & toolbar)  

Available only when retrieving raw waveforms, Select Data Types toggles 
the display of waveform, single point and image data.  If a data type is not 
selected, items of that type will not be displayed in the selection list.  

Retrieve associ-
ated processed 
waveforms 

Available when retrieving both raw and processed waveforms. When 
checked, any processed waveforms linked to raw waveforms are retrieved 
as well.  

The associated processed waveforms are not displayed in the list, but are 
available to the module using this dialog. This has no effect when only 
viewing waveforms, such as when this dialog is activated from Archive.  
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Retrieve associ-
ated raw wave-
forms 

Available when retrieving only processed waveforms.  When checked, any 
raw waveforms linked to any processed waveforms are retrieved also.  

The associated raw waveforms are not displayed in the list, but are avail-
able to the module using this dialog. This has no effect when only viewing 
waveforms, such as when this dialog is activated from Archive. 

Save list and re-
store next time 

Select this item to have the Selection dialog remember the list of data that 
is displayed when the dialog is dismissed.  That list will be displayed when 
the Selection dialog is next invoked.   

Limit List Search Limits the number of items displayed in the list to the number entered in 
this field. Only the first N (where N is the number entered into this field) 
items retrieved from the database are displayed. Enter “0” to display all 
items. 

Reset Resets the list of waveforms and images to show all data under the selected 
category (category specified by the tree control on the left).  Used after the 
list had been reduced via the Search function. 

Search This activates a dialog used for searching within the current list of dis-
played items.  See Section 3.4.1, “Waveform Search Dialog,” for details. 

3.4.1 Waveform Search Dialog 

Activated from the Waveform Selection dialog (Section 3.4), the Search Criteria dialog 
configures searches through the database for waveforms and images that match the specified pa-
rameter values.  The parameter list differs for raw and processed data and includes text fields 
(e.g., channel name, acquisition description) and numeric fields (e.g., shot number, figures of 
merit).  Text parameter searches are case-insensitive and match substrings.  Note that Figure of 
Merit (FOM) parameters will not match unless the waveforms in the database had the appropri-
ate FOMs computed before they were stored (see Appendix C – Figures of Merit (FOMs)). 
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Figure 3-3 – Waveform Search Dialog. 

Parameter Lists all parameters that can be included in the search. More than one parame-
ter may be checked. The available parameters are different for raw and proc-
essed data. 

Search Criteria The search string for the corresponding parameter field. Character data entered 
into this field is not case sensitive.  

Save Stores the current search criteria to a text file. 

Load Loads the search criteria from a file. 

Reset Clears all selected parameters and search criteria 

Check the parameter to search, then enter the search string into the Search Criteria field. 
More than one field may be searched at a time by checking each parameter that applies to your 
search criteria – multiple search fields are applied using the logical AND operator (i.e., returned 
data will meet all selected criteria). The search is not case sensitive and any matching sub-strings 
are returned. For example, to find all waveforms from Station 1, Rack 1 (regardless of Position 
or Channel, such as S1R1P*C*), check the Title Parameter and enter S1R1 into the Search Cri-
teria field. All titles that contain S1R1 will be displayed. If you enter s1r1 (lower case letters), all 
titles that begin with S1R1 will match.  

When you select OK, the search results are displayed in the Select Waveform dialog’s right 
pane. Use Reset to clear the search results and reload the default list. 
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3.5 Numeric Data Entry 

Many of the DAAAC interfaces for entry of numeric data support engineering suffixes.  
Instead of entering “3e-3” or “0.003”, you can simply enter “3 m”.  Numeric controls that do not 
support suffixes are either expecting integer values, or the expected units already contain a suf-
fix. For example, controls with units of “Hz” or “seconds” will support suffixes – controls with 
units of “GHz” or “milliseconds” or “number of points” will not.  Supported suffixes are as fol-
lows: 

Suffix Name Scale  Suffix Name Scale 

y yacto 10-24  k kilo 103 

z zepto 10-21  M mega 106 

a atto 10-18  G giga 109 

f femto 10-15  T tera 1012 

p pico 10-12  P peta 1015 

n nano 10-9  E exa 1018 

µ micro 10-6  Z zetta 1021 

m milli 10-3  Y yotta 1024 

3.6 Keyed Features 

Although all DAAAC installations use a common set of executables and libraries, many 
individual drivers and capabilities are “keyed” to allow the creation of custom installations. 
While some of the keyed features are cost items (e.g., instrument drivers, test director mode), 
most items are keyed to avoid cluttering the user interface with unnecessary functionality.   

In some cases, keyed items not included in your DAAAC system will appear in a disabled or 
“grayed-out” state.  Other types of keyed items, such as instrument drivers and CalMan inven-
tory items, will not be visible if not included in your DAAAC keys.  If you have any questions 
about enabling keyed features, contact Voss Scientific, Inc. 

3.7 Notebook   
The Notebook tool is a documentation tool specific to individual users and available from 

all DAAAC Modules.  On first execution, the tool opens a management window.  Here, users 
can be added and/or logged in.  Once a user is logged in, he or she can create a Notebook docu-
ment and add it to the database.  Enter a user ID and click New. 
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Figure 3-4 - Notebook Management View 

 
The Notebook editor window opens.  The user’s name is entered and the document is as-

signed a title.  Editing can proceed with unlimited text.  Text can be configured to have any 
combination of the properties in the table  

 
Option Menu Shortcut 

Bold Font->Bold <Ctrl-B> 
Underlined Font->Underline <Ctrl-U> 
Italics Font->Italic <Ctrl-I> 
Superscript Font->Superscript <Ctrl-P> 
Subscript Font->Subscript <Ctrl-S> 
Black Font->Color->Black <Ctrl-K> 
Red  Font->Color->Red <Ctrl-D> 
Yellow Font->Color->Yellow <Ctrl-W> 
Blue  Font->Color->Blue <Ctrl-L> 
Green Font->Color->Green <Ctrl-G> 
Insert Current Date Insert…->Date Only <Ctrl-F5> 
Insert Current Time Insert…->Time Only <Shft-F5> 
Insert Current Date & Time Insert…->Date/Time <F5> 
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Standard text editing commands Cut <Ctrl-X>, Copy <Ctrl-C> and Paste <Ctrl-V> oper-
ate correctly in Notebook. 

 

 
Figure 3-5 - Document Editing View 

Once the document is edited, it can be exported to text, Rich Text or Excel formats.  
Clicking Export opens a standard Windows file browser dialog to navigate to a folder, assign a 
file name and choose a file type. 

The Print button opens the standard Windows print configuration dialog.  Once OK is 
pressed the Notebook feature opens an additional dialog that allows output to be adjusted for left 
margin spacing and text horizontal and vertical spacing.  Once these parameters are properly 
configured for a particular printer they should not need to be adjusted again.  The dialog also en-
ables or disables the printing of page numbers and assigns a location on the page if they are to be 
printed.  The printout is in standard text with no configuration retained. 
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Figure 3-6 - Notebook Printer Configuration 

When OK is clicked in the Notebook editor window, the window is closed and the docu-
ment is displayed in the Notebook management window.  Clicking OK closes that window and 
stores the document to the database.  When Notebook is re-executed, all archived documents are 
recalled and listed in the management window.   The document may be reopened for review by 
anyone and for editing, provided the User ID: control matches the ID associated with the docu-
ment.  

 

 
Figure 3-7 - Updated Notebook Management View 
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4   Acquire 
 

 
 
 

4.1 Acquire Overview 

Acquire has been introduced in the tutorial Section 2.3.2 in sufficient detail to configure 
and perform a simple acquisition.  However Acquire is a much more advanced tool than hinted at 
in that section.  Chapter 4 presents a complete detailed review of the module’s capabilities.  Keep 
in mind, however, that none of the DAAAC modules operates completely independently of the 
others.  A complete understanding of Acquire will only be gained with the understanding of the 
other modules as well. 

Acquire is DAAAC’s instrument and data acquisition control module.  It configures the 
acquisition station, manages instrument inventories and settings, communicates with the instru-
ments and runs the automatic and manual data acquisition sequences. 

The Acquire module displays the current acquisition station in a rack display that may be 
configured to mimic the layout of the real test hardware; instruments may be positioned in the 
racks as they are in the real station, which makes accessing and configuring the instrument inter-
faces intuitive and less prone to error. 

The module is used to configure the acquisition sequence. Available user controls include 
acquisition mode (single shot, burst, repetitive, live), automated reduction and automated data 
export. Acquire is also used to document the acquisition with parameters such as test name, shot 
number and acquisition description. 

Acquire contains a myriad of instrument drivers (for common and not-so-common in-
struments) that require no programming and, in most cases, can control all of the instrument’s 
common functions. The instrument drivers that are available on your DAAAC system depend on 
the system keys you have installed. 

Once DAAAC is configured properly (station and instruments are configured and cali-
bration lines are set up) the automated data acquisition sequence begins when Acquire’s  but-
ton is pressed. Instruments are initialized, then armed.  Once the instruments trigger, Acquire 
reads the data then sends it to Analyze for display and printing, to CalMan for automatic reduc-
tion and to the database for archival. 
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Figure 4-1 - Typical Acquire Configuration 

4.1.1 Acquire’s Rack 

Acquire’s acquisition rack display contains instrumentation used during acquisition, and 
represents the real acquisition station’s layout. Instruments can be placed in columns and rows, 
and later moved, removed or copied so that they replicate the positions of the actual test instru-
mentation. 

Acquires racks can be modified by using the Rack menu, which is accessed by clicking on 
an instrument with the right mouse button.  For more information about the Rack menu, refer to 
Section 4.4.9.   

The states of the instruments in the rack are designated by the color of the instrument as 
seen in the figure.  Refer to Table 1, for a description of each state by color. 

4.1.2 Adding an Instrument 
Adding an instrument to a position in a rack is a matter of selecting the instrument, by serial 
number, from the inventory of instruments in the open database.  Often, before an instrument can 
be selected, it must first be added to the database inventory.  The instrument is selected for addi-
tion to the inventory from a list of all available instruments.  The selection (in number and type) 
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of instruments available depend on the options purchased with DAAAC and is determined by the 
installed keys . 

4.1.2.1 Adding an Instrument to the Inventory. 
To add an instrument to the database inventory: 
 
1. Right-click in an open instrument slot in a rack and select Add from the popup menu.  

(Add will be the only available option for a rack location with no instrument as-
signed.)  

 

 
Figure 4-2 – Initiate a New Instrument 

2. The dialog of Figure 4-3 appears.  The lists that appear under Manufacturer and 
Model will depend on the drivers allowed by the installed DAAAC keys.  The list un-
der Serial Number will depend on the selected items under Manufacturer and Model 
and instruments that have already been set into the inventory. 
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Figure 4-3 - Database Inventory Dialog 

3. Select the Manufacturer.  The list of available instrument drivers will appear in the 
Model list. 

4. Select the desired model.  Any instruments of that model< already added to the inven-
tory, will appear, by serial number, in the Serial Number list. 

5. Create a serial number.  Either type an appropriate value into the Serial Number: con-
trol, or click Generate to automatically create a random and unique value.  That value 
will appear in Serial Number: 

6. Click Add New Item.  The instrument will be added, by serial number, to Serial 
Number.  The instrument is now in the inventory and may be added to a rack position 
for use. 

4.1.2.2 Adding an instrument to a rack position. 
This process can be continued immediately from the previous sequence or begin by re-

peating steps 1 through 4 of 4.1.2.1. 
1. Select an instrument, by serial number, from the Serial Number control in Figure 4-3. 
2. Click Next >. 
3. An interface dialog will appear.  It can be used to add a name for the instrument and 

review other instrument properties.  The nature of the dialog is variable.  For instru-
ments with a GPIB interface, the GPIB addresses are configured here.  The dialog 
may also include a Setup button. 
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Figure 4-4 - Instrument ID and Setup Dialog. 

4. If the dialog includes a Setup button, the button must be clicked.  Perform any con-
figuration in the subdialog that appears.  Note that once the values in the Setup dialog 
are configured and the instrument is added to the rack, the values may be recalled for 
review but can never be altered. 

 

 
Figure 4-5 - The Setup Subdialog for the Voss Wave Dummy Driver. 

5. Click Finish to add the instrument to the rack. 

4.1.2.3 Configure the instrument in the Rack 
1. Double-click the instrument driver icon in the rack.  The tabbed instrument-specific 

configuration dialog will open. 
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Figure 4-6 - Double-Click to Open Configuration Dialog. 

 
2. The dialog will normally consist of three tabs – Main, Channel and Utility.  Other 

tabs may also be present.  The main dialog configures the acquisition.  The channels 
dialog enables or disables the various signal channels and adjusts individualized 
channel properties.  Utility provides bookkeeping services.  Configure the instrument 
as appropriate and close the dialogs.  Once all instruments are configured, Acquire is 
prepared for acquisition. 

 

Double-Click 
to Configure 
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Figure 4-7 - Voss Wave Main and Channel Dialog Tabs. 
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4.1.3 Acquisition Sequencing 
Section 2.3.2.8 presented a basic description of an automatic acquisition sequence.  That 

description was not only overly simplified, it also focused on a single acquisition mode.  There 
are a number of acquisition modes including: 

 
• Automatic 
• Manual 
• Single Shot 
• Repetitive Single Shot 
• Burst 
• Repetitive Burst 
• Live Video 
• Push Button Acquisition 

 
The first two options, automatic and manual acquisition, form the basic distinction, with the 
other options acting as subcategories under these two.  One option – live Video – is not techni-
cally an acquisition at all.  When it is selected, an image is repeatedly captured and displayed, 
but not processed or stored to the database. 

This section describes both the automatic and manual acquisition processes in detail.  
Other acquisition options are presented as appropriate in this discussion. 

4.1.3.1 Automatic Data Acquisition 
Automatic data acquisition is initiated, after the instruments are fully configured, by 

pressing the  button.  Once pressed, under normal circumstances, the acquisition will proceed 
without further user intervention until all data have been acquired per the module configuration. 
The sequence is as follows: 

 
1. Press . 
2. If the acquisition is configured to display the Global Settings dialog on , display 

the dialog.  Otherwise, go to 3.  Pressing <F2> instead of  will start the automatic 
acquisition sequence and bypass the Global Settings dialog.   

3. Initialize all uninitialized instruments 
4. Arm all instruments 
5. Repeatedly poll all instruments until all instruments have or until the user-

programmed timeout is reached. 
6. Read out the data from the instruments. 
7. Write the data to a spool file. 
8. Transmit the data.  The data is multicast by all stations.  (The multicast is reliable.  

There is handshaking between NetCom and acquire to validate the data.) 
9. NetCom stores the data to the database. 
10. Analyze assembles data packets into waveforms to display. 
11. If there is no reduction, Acquire deletes its spool file, otherwise… 
12. If there is data reduction, CalMan reads the data and deletes the spool files. 
13. If there is data reduction, CalMan reduces the data and spools the processed data. 
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14. If there is data reduction, Multicasts processed data to the database through NetCom 
and to Analyze. 

15. If there is data reduction, CalMan signals Acquire that it is done. 
16. If this is a repetitive acquisition increment the execution count and go to 17.  Other-

wise go to 20. 
17. If there is a finite number of repetitions go to 18.  Otherwise go to 19 
18. If the specified number of acquisitions have occurred or if the user has clicked  go 

to 20.  Otherwise go to 3. 

19.  If the user has clicked  go to 20.  Otherwise go to 3. 
20. Acquire tells the test director that it is done. 

 
There are several things to note about this sequence. 

 
• The discussion is the same in both Stand Alone and Networked mode provided the 

Stand Alone station is regarded as a networked station in a single-station system. 
• There is no distinction between single shot and burst mode, here.  The discussion ap-

plies equally well to both. 
• The discussion is not independent of other DAAAC Modules, including NetCom, 

CalMan and Analyze. 

• The  will abort the acquisition at any time. 
 
The process is shown graphically in Figure 4-2. 
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Figure 4-8 - Automatic Acquisition Flow Diagram 

4.1.3.2 Acquisition Sequence in the Acquire Module 
 
As the Acquire module moves through the acquisition stages, the instruments change color to 
indicate the current acquisition action.  Figure 2-19 is copied here to illustrate the process. 
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 ->  -> 

 ->  -> 

  ->  

Figure 4-9 - Acquisition Sequence in the Acquire Module 
Color-coding is defined in Table 2. 

Table 2 - Acquire Module State Color-Coding 
Inst. Color State Meaning 

Light blue Idle Instrument is not in use. 
Purple Active (in use) Instrument is active and communicating with DAAAC. 
Dark Blue Not available Instrument is active, but not communicating with DAAAC. 
Yellow Initialized Instrument is active, and has been initialized by DAAAC. 
Light Green Armed Instrument is armed and ready for trigger. 
Dark Green Triggered Instrument has triggered and waiting to download data. 
Orange Read Out Instrument is downloading data. 
Red Error An error has occurred while communicating. 

4.1.3.3 Manual Data Acquisition 
The process of manually acquiring data flows in much the same manner as the automatic 

process with the same decision points.  The most significant difference is that user intervention is 
required at several points.  In particular: 

 
• The process starts by clicking  instead of  on the toolbar. 

• The program proceeds automatically through triggering.   may be clicked to force 
any instruments that do not trigger in response to the Arm command to trigger. 

• Once all instruments have triggered,  must be clicked to recover and store data 
and pass it to CalMan and Analyze for reduction and display. 

 
Figure 4-10 reduces Figure 4-8 and emphasizes the manual user interaction with the proc-

ess. 
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Figure 4-10 - Manual Data Acquisition Flow Chart 

4.1.3.4 Live Video Acquisition 
Running Acquire in Live Video mode causes the program to repeatedly capture and re-

display image or waveform data indefinitely, until  is clicked.  The purpose of this feature is 
to allow instruments to be actively adjusted to optimize the data before performing an actual cap-
ture.  No data are processed or stored in live acquisition mode. 

 

4.1.4 Instrument Control dialogs 

Instrument Control dialogs typically contain Main, Channel, Trigger and Utility pages.  
They are accessed by double-clicking the specific instruments in the racks.  

The Main page contains electrical address information, time base settings, record length, 
and calibration controls.  The Channel page contains settings that are set on a per-channel basis 
for the instrument, such as vertical scale and offset.  Auxiliary functions performed on a per-
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channel basis, such as auto-export, are contained on this page also. The Trigger page contains all 
triggering controls. The Utility page may contain as many as five functions to control instrument 
settings. 

 
Figure 4-11 - Demo Instrument Configuration Main Page - Tektronix 2440 Digitizer 
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Figure 4-12 - Tektronix 2440 Channel Page 

Instrument Control dialogs are far too numerous and varied to permit detailed examina-
tion in a dialog.  Figures 4-4 and 4-5 show the Main and Channel tabs for a typical digitizer 
driver: in this case, the Tektronix Model 2440.  A few configuration parameters are common to 
all drivers and are worth noting here. 

 
• The Main Settings tab will include two radio buttons that can switch the instrument to 

Active or Idle.  An instrument that is not in communication with DAAAC cannot be 
set Active. 

• The Main Setting tab will include a section that identifies the instrument.  The Name: 
field can be adjusted.  The Serial Number: field is for review. 

• The Channel tab will show a list of all available data channels.  Channels may be se-
lected for data transfer or disabled from this tab. 

• Each of the data channels can be assigned a name and description from the Channel 
Settings tab. 

4.2 Acquire Toolbar 

The Toolbar is displayed across the top of the Acquire window, below the menu bar. The 
toolbar provides quick mouse access to many of Acquire’s functions, some of which can be se-
lected only from the Toolbar, such as GO.   

To hide or display the Toolbar, choose Toolbar from the View menu, or press [Alt]+[V], [T]. 
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Switch to Archive. 

 
Switch to Analyze. 

 
Switch to Cal Manager. 

 
Start the acquisition sequence.  

 
Arm the system, wait for triggers, and do not proceed when triggered. 

 
Force triggers on any devices not yet triggered. 

 
Force triggers on any timing channel devices set to computer/manual 
trigger mode. 

 
Download waveforms from devices or spool files, and read from trig-
gered instruments. 

 
Stop the current acquisition. 

 
Open the global system settings dialog box. 

 
Display and edit the Info.txt record.  

 
Print the instrument settings for all active, currently displayed instru-
ments. 

4.2.1 Go button 

Selecting the GO button on the Toolbar begins an automatic data acquisition sequence. All 
uninitialized instruments are initialized, the instruments are armed and DAAAC begins polling 
each instrument, waiting for a trigger. When all triggers are detected (or when a user-
programmed timeout is reached), the data is downloaded from each instrument, sent to Analyze 
and stored in the database. If automatic data reduction is enabled, Cal Manager is notified to be-
gin reduction and send the reduced data to Analyze. 

The Global Settings dialog will be activated when GO is selected (if the Show this dialog 
on GO option is enabled from the Global Settings dialog’s Administrative settings page, de-
scribed in Appendix B, Section 2.1.10). This dialog is displayed to permit acquisition configura-
tion changes before acquisition starts.  
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If acquisition is begun with either the F2 or F3 keys, the global settings dialog is NOT dis-
played regardless of this setting.  F2 performs an acquisition exactly as if the user had clicked 
GO and the OK on the global settings dialog.  F3 is effective only with certain instrumentation.  
If cameras or fast (chiefly cPCI) digitizers are present, pressing F3 temporarily initiates live dis-
play mode.  Once the live acquisition is stopped, the previous acquisition mode is restored (ac-
quisition modes are described in Section 4.1.3). 
Shortcuts: F2, F3 

Toolbar:  

4.2.2 Stop button  

Stop halts the current acquisition.  If no instrument has triggered, this button returns all in-
struments to their initialized states. If any instruments have triggered, the available data will be 
downloaded to the database. 
Shortcuts: S 

Toolbar:  

4.2.3 Arm System 

The Arm button arms all active instruments in the system.  When it is pressed, DAAAC 
polls the instruments for triggers and updates Acquire’s instrument rack display when a trigger is 
detected. The time-out settings are ignored when using Arm. If a trigger is not detected, you 
must manually stop the system polling.  This is accomplished by clicking Stop or Force Trig-
gers.  

When acquiring data with Arm, the remainder of the acquisition sequence must be per-
formed manually.  This acquisition method only arms and detects triggers.  Select either Stop or 
Get Waveforms to download data from the instruments. Also, automatic data reduction is not 
performed. 

This differs from an acquisition started with GO, which initializes and arms instruments, 
reads out data after instruments are triggered, then performs automatic data reduction. 
Shortcuts 

Toolbar:  

4.2.4 Force Triggers 

Force Triggers forces triggering on those instruments that have not already triggered. In 
most cases, non-triggered instruments will return baselines.  This function allows the normal ac-
quisition sequence processing to continue when an instrument fails to trigger. 
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Shortcuts 

Toolbar:  

4.2.5 Timing Triggers 

Timing Triggers triggers any timing channels, such as a DG535, BNC555 or V951, that are 
set to computer/manual trigger mode. 
Shortcuts 

Toolbar:  

4.2.6 Get Waveforms 

Get Waveforms manually downloads data from either spooled file data or all active in-
struments.  If Show this dialog on Go is checked from the Administrative Settings page of the 
Global Data dialog, the Global Settings dialog will be activated so that acquisition parameters 
can be set. When settings are entered and OK is selected, the Get Data Specification dialog (de-
scribed below) is activated so that you can choose to download files from the spool directory or 
directly from the instruments. The data is then downloaded when OK is selected. 

This function is normally used when DAAAC has detected triggering, but the data has 
failed to download from the instruments. This occurs when an acquisition sequence is started 
with the Arm button or certain errors occur in the hardware. 

When Get Waveforms is selected, the data is read into Acquire and transmitted to Analyze. 
However, automatic data reduction is not performed even if selected. This differs from starting 
an acquisition sequence with the GO button, which enables automatic data reduction if selected. 

An example use of this function is when data should be read from an instrument that was 
not part of an acquisition sequence. The instrument may have data from another source, and is 
connected to the DAAAC computer and added to Acquire rack. When Get Waveforms is se-
lected, all data are read from the instrument into Acquire.  

Initialize on OK should be unchecked in the Acquisition page of the Global Settings dia-
log, if any of the instrument’s software settings have been changed.  

If multiple waveforms (Fast Frame, segmented memory or burst) were acquired with the 
instrument, the number of Shots In Burst on the Acquisition page of the Global Settings dialog 
should be set to the correct value. 

Shortcut 

Toolbar:  
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4.2.6.1 Get Data Specification dialog 

The Get Data Specification dialog is activated after Get Waveforms is selected.  It selects 
the source for the data, either Spool Files or Instruments. See Appendix B, Section 2.1.15 for de-
tails. 

When OK is selected, the data is read from the selected source.  Note that the Get Data 
Specifications dialog does not appear when Get Waveforms is clicked as part of the normal 
manual execution sequence. 

4.2.7 Global Settings 

The Global Settings dialog was introduced in Section 2.3.2.7 solely for the purpose of cre-
ating a test to allow the tutorial acquisition to occur.  This important function of the dialog is just 
one of several operations and parameters supported by it.  The dialog will be opened automati-
cally when an automatic execution sequence is initiated by the  button, provided the dialog 
display is enabled.  Initiating the automatic acquisition using <F2> bypasses the dialog.  The dia-
log can also be accessed through the menu path Acquisition->Acquisition Configuration. 

The Global Settings dialog’s three pages support functions that apply “globally” to the ac-
quisition sequence.  These functions include configuring activity logs, creating new tests and de-
fining the acquisition parameters.  The following sections describe each page in detail.   
Shortcut 

Toolbar:  

4.2.7.1 General page, Global Settings dialog 

The General page of the Global Settings dialog displays test names and descriptions, cre-
ates new tests, and configures settings related to shots for the currently selected test. This is the 
default page for the Global Settings dialog, and is activated when the Get Waveforms, Global 
Settings, Go or Arm buttons are selected. 
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Figure 4-13 - Global Settings Dialog - General Tab 

The Test Name and Description list groups all system data by test at the highest level. The 
upcoming shot or burst data can be associated with an existing test, or a new test can be created. 

Item Description 

Test Name and Description Listing of previous and current test. The highlighted line selects the cur-
rent test. 

Create New Test Activates the New Test dialog, used to enter test name and description. 
Each new test created with this function is then listed in the main win-
dow of this dialog.   

Acquisition Description An optional descriptive string for the current acquisition. 

Use Remote Shot Number The shot number is from a remote source, such as a DAAAC log, API 
software or user-written software. 

Next Shot Number A serial value to be prepended to the Test Name to uniquely identify the 
acquired waveform.  This value is automatically incremented by 
DAAAC, or may be manually assigned. This control is disabled if Use 
Remote Shot Number is Enabled. 

Log Page(s) Display or edit the Log Pages, which contain user-defined test data.  
[
 

 This is an optional item not included in most systems.]  
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4.2.7.1.1 Create New Test dialog (Figure 2-16) 

When activated from the General page of the Global Settings dialog, the Create New Test 
dialog creates a new Test.  Enter the test name and an optional description. When Add is se-
lected, the test is created and added to the list on the General page. The new test then becomes 
the current test and is highlighted in the list.   See Appendix B, Section 2.1.10 for more details. 

4.2.7.2 Processing page, Global Settings dialog 

The Processing page of the Global Settings dialog configures automated processing set-
tings for the next shot, including data reduction and exports. 

 
Figure 4-14 - Global Settings Dialog - Processing Tab 

 
Item Description 

Auto reduce data  If selected Acquire passes control to CalMan, following acquisition of 
raw data from the instruments, for automatic data reduction.  If not se-
lected, the reduction sequence can be initiated manually at any time from 
Analyze or CalMan. 

Post-burst process If selected, launches custom database processing that follows the main 
acquisition sequence.  [

 This is an optional item not included in 
most systems.]   
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Automatic Export 1 & 2 Supports automatic export of raw waveform data to two different loca-
tions and/or in two different formats. 

Waveform export Allows selection of channel specific export, global export (all raw wave-
forms), or no export. 

Format File format used if global export (all waveforms) is selected. 
Path Location for raw waveform export files. 

Export Log  Export an ASCII representation of the Log Page data, if defined.   
Auto-print Log Print the associated Log Pages if any have been defined 

4.2.7.3 Acquisition page, Global Settings 

The Acquisition page of the Global Settings dialog configures acquisition-related settings 
for the next shot. These settings include the acquisition mode (single shot, repetitive single shot, 
burst and repetitive burst), whether the instrument front-panels are locked out, whether instru-
ments are initialized when OK is pressed in their main interface dialogs, and whether they are 
unconditionally initialized at the start of each acquisition.  If an instrument’s front-panel is 
locked out, the instrument need not be initialized at the start of an acquisition. This saves time 
when the configuration includes instruments that are slow to initialize, such as the TDS family of 
digitizers. 

 
Figure 4-15 - Global Settings Dialog - Acquisition Page 
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Item Description 

Device Polling Instrument polling during idle time.  

Poll Interface When checked, instruments are polled and their status is updated at the time inter-
val specified in the Poll Period field. Polling occurs during idle times, and not dur-
ing acquisition. When polling DAAAC checks for the presence of a device at the 
address of each instrument in the configuration. This feature allows DAAAC to 
determine whether a device is present, powered on and connected at each address.  
It reduces the incidence of interface-related errors when communication is at-
tempted with an instrument.  

Poll Period The time period between successive instrument poll operations. 

Instrument Ini-
tialization 

Defines when to initialize instruments and front panel lockout option. 

Initialize on Go When checked, all instruments are initialized when the GO button is selected, re-
gardless of their present status. 

Initialize on OK When checked, each instrument is initialized when OK is selected from the instru-
ment’s dialog. The instrument dialog is activated by double-clicking the instrument 
icon in Acquire’s rack display.  

Lock Out Front 
Panels 

When this option is checked, DAAAC attempts to lock out the instrument’s front 
panel.  This setting prevents users from inadvertently making the instrument set-
tings inconsistent with the DAAAC settings. 

Arm / Trigger Options for the arm and trigger portions of the acquisition sequence 

Beep when armed Causes the system to beep while armed, at an interval specified by the registry key  
HKLM\Software\VSI\\DAAAC\BeepPeriod. 

Triggering Time-
out 

The number of seconds to wait for all instruments to trigger after any instrument 
has triggered. A zero value means wait indefinitely. DAAAC will continue polling 
for a trigger until all instruments are triggered, or until Stop or Force Triggers is 
selected. 

Single Point Data Settings for acquiring single-point, tabular data.  

Spool Forever Allows the data from single-point instruments (e.g., time interval meters, power 
meters, voltmeters) to be accumulated across many shots/bursts. This allows for 
easy trend analysis and graphing at the analysis stations.  If enabled, single-point 
data from a given instrument channel is spooled cumulatively until the control is 
turned off. 

Number to Spool Number of single-point values to spool.  This setting overrides the number of shots 
in Repetitive Single Shot/Burst mode.  This value is ignored if Spool Forever is 
checked.   

Acquisition 
Mode 

Available modes for acquiring data.  
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Single Shot The system arms each participating instrument for a single shot (trigger event).  
After the system triggers, data is read out, sent to the database and automatically 
processed if auto-reduction is enabled. If this control is selected, Shots to acquire, 
Shots in Burst, Repeat until abort and Instrument Burst Capacity are disabled. 

Repetitive Single 
Shot 

Like single shot except that when the acquisition sequence is complete the system 
will automatically re-arm the specified number of times. . If this control is selected, 
Shots in Burst and Instrument Burst Capacity are disabled. 

Burst The system arms each instrument for the specified number of shots. Multiple shots 
(a burst) are stored internally in the digitizers and rearm rates are determined solely 
by the hardware. After the system triggers (all shots in the burst have been ac-
quired), data is read out, sent to the database and automatically processed if auto-
reduction is enabled.  If this control is selected, Shots to acquire and Repeat until 
Abort are disabled. 

Repetitive Burst Like burst except that the system is automatically re-armed the specified number of 
times after the completion of each acquisition sequence. If this control is selected, 
Shots to acquire, Shots in Burst, Repeat until abort and Instrument Burst Capacity 
are enabled. 

Live Video A window is created for each enabled camera and fast digitizer channel which will 
acquire data as fast as possible from the device and display it.  This data is not 
stored and cannot be analyzed further.  This mode is intended for optical and signal 
alignment purposes.  If this control is selected, Shots to acquire, Shots in Burst, 
Repeat until abort and Instrument Burst Capacity are disabled. 

Pushbutton Ac-
quisition 

Special mode that combines live video and single shot modes.  The system is 
placed in live video mode AND all non-live capable channels are armed.  When the 
“pushbutton” is activated (a special external trigger gating box is required) as 
sensed by a non-live device triggering, the live mode is stopped and the last frame 
captured as in a normal acquisition. . If this control is selected, Shots in Burst and 
Instrument Burst Capacity are disabled. 

Bursts to acquire The number of shots or bursts for the current acquisition. This control may be en-
abled if Acquisition Mode is Repetitive Single Shot, Repetitive Burst or Pushbutton 
Acquisition.  Otherwise it is disabled. In any case, the control is disabled if Repeat 
Until Abort is checked. 

Shots in Burst The number of shots per burst when in single or repetitive burst mode.  This con-
trol is enabled if Acquisition Mode is Burst or Repetitive Burst.  Otherwise it is dis-
abled. 

Repeat until abort When checked, DAAAC acquires data until the Stop button is selected. The 
Shots/Bursts to Acquire field is not used in this mode. . This control is enabled if 
Acquisition Mode is Repetitive Single Shot, Repetitive Burst or Pushbutton Acquisi-
tion.  Otherwise it is disabled.  If this control is checked, Shots to Acquire will be 
disabled. 

Instrument Burst 
Capacity 

Activates the Burst Capacity dialog, which displays the number of channels and the 
burst capacity for each instrument.  See “Burst Capabilities dialog” below. . This 
control is enabled if Acquisition Mode is Burst or Repetitive Burst.  Otherwise it is 
disabled. 
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4.2.7.3.1 Burst Capabilities dialog 

When activated from the Acquisition page of the Global Settings dialog, the Burst Capabili-
ties dialog displays the number of channels and bursts per channel that each instrument in the 
current acquisition configuration can acquire. See Appendix B for more details. 

4.2.7.4 Administrative page, Global Settings dialog 

The Administrative page of the Global Settings dialog defines the I/O, error and diagnostic 
names and paths and several other administrative options. 

 
Figure 4-16 - Global Settings Dialog - Administrative Settings Tab 

Item Description 

Log All I/O When checked, all I/O data is sent to the file named in the I/O Log File field. I/O 
should not be logged except for debugging purposes. The I/O Log file can grow 
very large quickly so this feature should normally be disabled. 

I/O Log File The full path and name for the I/O log file. 

Log All Errors When checked, all system errors are sent the file named in the Error Log File.  Er-
rors should be logged only under unusual circumstances. 

Error Log File Full path name for the error log.  The Error Log file is named Error.log by default..  
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Log State When checked, diagnostic messages are sent to the file named in the Info Log Path. 
Log State is also used for debugging purposes and system tuning. It generates a file 
containing time stamped records of all state transitions in the system (e.g. initializ-
ing, arming, etc.). The InfoLogPath specifies the location of these logs. 

Info Log Path The full path for the log state file. The files are according to the current date, and 
are formatted as YYYYMMDD.Inf, where YYYY is the four digit year, MM is the 
month, and DD is the day. 

Acquire Network 
Communications - 
Number of retries 

The number of times to try to re-connect to a remote network station if communica-
tions is lost. The default is four, which requires a total of eight minutes. This value 
may be changed to suit current circumstances. 

Show this dialog 
on GO 

When checked, the General page of the Global Settings dialog is displayed when 
the Go button is selected. This allows changes to be made for each shot (test name, 
shot numbering, etc.). 

4.2.8 Info.txt 

Info.txt maintains a list of acquisition parameters along with user comments.  It provides a 
quick view of the acquisition history.  The name “info.txt” comes from the original implementa-
tion of this feature, which used an external text file. 

4.2.8.1 Display/Edit Info.txt 

Display/Edit Info.txt activates the Edit Info.txt dialog, which displays the current informa-
tion record for the current test. A new information record is created for each new test.  

The information displayed includes the following: 
Item Description 

Test Name Displays the Test Name. 

Test Description Displays the Test Description. 

Acquisition Description  Displays the first 39 characters of the Acquisition Description. 

Starting Shot  Displays the first shot number for this test. 

Num Shots  Displays the total number of shots acquired under this test. 

Comment field (not labeled)  Field for entry of comments, which are limited to 1024 characters. 

View Old Info.txt  Activates the Info.txt Select dialog, used for viewing old test records 
created when the tests were defined. 

Shortcuts 

Toolbar:  

4.2.8.2 Select Info.txt, Display/Edit Info.txt dialog 

Select Info.txt retrieves an Info.txt record other than the current record.  The retrieved re-
cord then can be edited.  The Info.txt Select dialog below displays most of the fields found in the 
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Edit Info.txt dialog, simplifying record selection. It also searches for pertinent information to ease 
selection.  See Appendix B, Section 2.1.16 for details. 

4.2.8.3 Search Info.txt Records dialog 

Activated from the Info.txt Select dialog, the Search Info.txt dialog searches the list of 
Info.txt records.  Search Info.txt looks for the Info.txt record that contains specified search crite-
ria. Search criteria may include date range, individual words, or text strings in any portion of the 
record. Words or text strings may be an exact match (with or without case sensitivity) or any 
substring.   See Appendix B, Section 2.1.16 for details. 

4.2.9 Print System Configuration 

Print System Configuration prints the configuration of every active acquisition instrument 
in the current station.  The printout shows the time base settings, trigger settings, and channel 
settings for each active acquisition channel.  To print the configuration of timing channels (delay 
/ trigger generators), use the File menu command Print Timing Configuration. 
Shortcuts 

Toolbar:  

4.3 Named Configuration Toolbar  
The Named Configuration toolbar supports rapid selection of named configurations (see 

Section 4.4.1.1) for shot and trigger test modes.  The “S” button and droplist support configura-
tions for “shot” mode, while the “T” button and droplist support configurations for “trigger test” 
mode.  Each of the droplists allow selection of any stored named configuration.  The configura-
tion specified in the shot droplist will be activated if the “S” button is pushed, or if the 
<Shot_#####> command is received via Acquire’s remote control interface (see Appendix D, 
Section 4.2).  Similarly, the configuration specified in the trigger test droplist will be activated if 
the “T” button is pushed, or if the <TrigTest_#####> command is received. 

 
Selection of the rightmost button on the toolbar displays the Named Configuration dialog 

box (Appendix B, Section 2.1.1), which is used to manage the named configuration list. 
 

 
Figure 4-17.  Named Configuration toolbar. 

4.4 Acquire menus 
This section presents the menus, left-to-right and the items accessed by them.  All menu 

items are presented in tables.  Where the table discussion is sufficient, there is no further discus-
sion.  Where more detail needs to be provided, the items are specified immediately below the 
table.  Some menu items will open dialogs.  If the dialog is sufficiently simple it will not be 
shown in the document.   
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4.4.1 File menu 

Acquire’s File menu offers the following commands: 
Item Description 

Print Setup Select a printer and printer connection.  

Print System Con-
figuration 

Print the essential configuration of all digitizers in the system.  Includes digitizing 
rate, channel coupling, trigger settings, address information, etc. 

Print Timing Con-
figuration 

Print the essential configuration of all timing channels.  Includes delays, trigger 
modes, address information, etc. 

Export System 
Configuration 

Export to Excel compatible .csv file the essential configuration of all digitizers in 
the system.  Includes digitizing rate, channel coupling, trigger settings, address in-
formation, etc. 

Export Timing 
Configuration 

Export to Excel compatible .csv file the essential configuration of all timing chan-
nels.  Includes delays, trigger modes, address information, etc. 

Store Named Con-
figuration 

Save the currently displayed Named Configuration (including all displayed sta-
tions) under specified name and description. 

Restore Named 
Configuration 

Restore the selected Named Configuration. 

Exit Exit Acquire.  

4.4.1.1 Store Named Configuration, File menu 

Store Named Configuration saves the current DAAAC configuration as a Named Configu-
ration for later restoration. The configuration includes displayed stations, instruments and their 
settings, Global Settings and Calibration settingsThis dialog names, and supplies an optional de-
scription to, the current configuration. Clicking OK saves the configuration. .  See Appendix B, 
Section 2.1.1 for more details. 

4.4.1.2 Restore Named Configuration, File menu 

Restore Named Configuration retrieves a previously stored Named Configurations. For in-
structions on saving a configuration, see Section 4.4.1.1 immediately above. When a name is se-
lected, the instrument, Global and calibration settings in place at the time when the configuration 
was saved are restored to the original state.  Each station, the station rack, Global Settings and all 
Calibration (graph) settings will be restored exactly as they appeared when the configuration was 
saved.  Restore also returns the configurations of any remote stations that were part of the origi-
nal named configuration.  See section Appendix B, Section 2.1.2 for more details 

4.4.2 Preferences menu 

Acquire’s Preferences menu contains the following commands: 
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Item Description 

Readout Order Specifies the order in which triggered instruments are read out during acquisition. 
FOM Selection Specifies the figures of merit that are automatically computed when data is ac-

quired. 
Configure Perf 
Monitor 

This selection allows the operator to specify a performance-monitoring database 
and to specify which state transitions are monitored with the performance monitor 

configure dialog. [
 

custom feature, unavailable on most installations.]   
Rescale Racks Rescale Racks can be accessed by right clicking with a station window outside of 

any rack.  Rescale Racks activates the Rack Scaling dialog, which changes the size 
of Acquire’s display racks. The numbers for the x and y axes are a percentage of an 
arbitrary size, which, at full scale (100 percent), will display four instruments verti-
cally, and two racks horizontally.  See Appendix B, Section 2.1.5. 

Status Bar Select to toggle the status bar display 

Toolbar Select to toggle the toolbar display 

4.4.2.1 Readout Order, Preferences menu 

Readout Order activates the Readout Order dialog, which specifies the order in which ac-
tive instrument channels are displayed by analysis stations. 

To change the display order, select a instrument with the left mouse button and drag it to a 
different location on the list. When an item is released, it is inserted in the list immediately after 
the item it is released on.  Individual instrument channels are displayed, but the readout order of 

channels within an instrument cannot be changed.  

 

Choose Clear to restore the default readout order, which is based on the instruments posi-
tion in the racks (min to max vertical rack position and left to right rack). 

Networked systems: all instruments within a station must be read out as a group. You cannot 
specify an order that interleaves instruments from different stations.  The station-level readout 
order can be changed by selecting a station name and dragging it to its new position. 
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Figure 4-18 - Read Out Order Dialog 

4.4.2.2 FOM Selection, Preferences menu 

The FOM Selection interface specifies the Figures of Merit (FOMs) that are to be auto-
matically computed and stored with newly acquired (raw) waveforms. It also governs the order 
in which FOMs are displayed with the raw data in Analyze.  Automated FOM calculation for 
manually processed waveforms is specified in the Analyze module (Section 7.4.4.1). Automated 
FOM calculation for reduced waveforms is specified in the CalMan module (Section 
6.2.5.2.3.1.). 

To select a FOM for computation and display, check the FOM name. Those that are not 
checked will not be computed.  To change the display order, select the FOM name with either 
mouse button and drag it to the desired location in the list.  

If a FOM is not computed, you cannot use it as search criteria when retrieving waveforms.  
Additional FOMs can be computed and stored with existing waveforms at any time, using the 
Properties interface in the Analyze module (Appendix B, Section 2.4.4).   

See Appendix B, Section 2.1.4 for a description of the FOM selection dialog.  See Appen-
dix C – Figures of Merit (FOMs) for a detailed discussion of all FOMS. 

4.4.3 Station Config menu 

Acquire’s Station Config menu contains the following commands: 
Item Description 

Add Station Networked Systems: opens the display for a remote acquisition station. Display 
must be opened to control a remote station.  The option is grayed in Stand Alone 
installations. 

Drag an instrument with the left 
mouse button to reorder the readout.  
Channels cannot be reordered. 
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Instrument Inven-
tory 

Adds a new instrument to the inventory list (the list of available acquisition hard-
ware).  Does not add the instrument to the rack.   

Delete Instrument Removes instruments from the inventory list.  Note: Only available in systems that 
used strict inventory control.  Otherwise it is disabled.  

Instrument Set-
tings 

Display / edit common instrument settings for all acquisition channels 

Timing Settings Display / edit common instrument settings for all timing channels 

4.4.3.1 Instrument Settings, Station Config menu   

The Instrument Settings dialog lists all instruments and channels that exist in all open sta-
tions. It also displays several settings common to all instruments. This grid is an efficient method 
of quickly viewing these common settings and changing them without having to activate the in-
strument’s dialog. Instrument Active, Channel Active, Zero base and Auto Export can be toggled 
on/off directly from the map. Alternatively, the instrument’s dialog may be activated by right-
clicking on the instrument’s name.  Any settings, such as Volts Full Scale (VFS), that are not 
grayed out may also be adjusted from this dialog. 

If the current system is networked, then each station’s name is listed in the left-most col-
umn. Also, if any crate instruments exist, they are listed to the left of the instrument name. Chan-
nels are listed within instrument names; the instrument is listed once for all of its channels, on 
the same row as the first channel. 

 

 
Figure 4-19 - Instrument Settings Dialog 
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Item Description 

Station Networked Systems: the station name is displayed in the far left column. If more 
than one station is open, each station and all of its instruments will be displayed 
with the station name. 

Crate If a crate exists (eg. cPCI, VXI, etc.), then the Crate column is to the left of the in-
strument column. Each instrument within the crate is then listed in the instrument 
column. 

Instrument Lists the instrument name. The instrument name is listed once for all channels; the 
first channel is listed on the same row as the instrument name.  

The name can be edited here. Double-click the name to highlight it, then edit the 
name and press [Tab] to exit the field. The instrument’s name must be unique and 
contain only valid characters.  

To activate the instrument’s dialog, right-click the name. Changes made in this dia-
log are automatically updated in the map when OK is selected. 

Active When checked, the instrument is active.  

Channel The channel name for the instrument name last listed. The instrument’s first chan-
nel is listed on the same row as the instrument. 

The name can be edited in place. Double-click the name to highlight it, then edit 
the name and press [Tab] to exit the field. The channel name must be unique and 
contain only valid characters. 

Active When checked, the corresponding channel is active. 

VFS Volts full scale for the channel 

V Offset Vertical offset for the channel as a percentage of full scale. 

Timebase Digitizing rate in samples / second 

Trigger Pos Trigger position in seconds 

Zero Base Offsets the waveform so that is at zero.  

Description Channel description string 

Auto Export 1,2 Enable auto export to path (1 or 2) for this channel.  If enabled globally in the 
Global Settings Dialog, the specified file type will be exported containing the data 
for each channel on which auto export is enabled. 

Auto Export Type Specify the file type to be exported. 

Print Prints the information that is displayed on the grid.  

4.4.3.2 Timing Settings, Station Config menu 

The Timing Settings dialog displays all current timing instruments and their channels, and 
the timing delays for each. This grid is an efficient method for quickly viewing these settings, 
and can be used to change them without activating the instrument’s dialog. 

All fields may be edited in place: double-click the item to highlight it, then make changes 
and press [Tab] to exit the field. Unlike the Instrument Settings interface, the instrument’s dialog 
cannot be activated from this interface. 
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Figure 4-20 - Timing Instrument Configuration 

Item Description 

Instrument The instrument name. The instrument name is listed once for all channels; the first 
channel is listed on the same row as the instrument name. The name can be edited 
in place.  

Active When checked, the corresponding channel is active.  

Channel The channel name. The name can be edited in place.  

Delay The time delay for the channel.  The delay can be edited in place.  

Print Prints the information displayed in the grid.  
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4.4.4 Acquisition menu 

Acquire’s Acquisition menu contains the following commands: 
Item Description 

Acquisition Con-
figuration 

Displays the Global Settings dialog, which is used to configure acquisition parame-
ters (see Section 4.2.7). 

Go Starts the automated data acquisition sequence (initialize, arm, trigger, retrieve, 
archive and display, reduce). 

Arm Arms all active instruments.  Initiates the manual data acquisition sequence. 

Trigger Triggers all armed acquisition instruments. 

Timing Trigger Triggers any timing channels that are set to computer/manual trigger mode, such as 
can be found on a DG535, BNC555 or V951. 

Get Waveforms Retrieves data from all acquisition instruments that have triggered. 

Take Control Networked Systems: takes control of another acquisition station.  Only available on 
the station running in Test Director mode. 

4.4.5 Tools menu 

Acquire’s Tools menu contains the following commands:  

Item Description 

Gang Calibrate All Run the internal calibration procedure on all instruments that support auto-
mated calibration.  See Appendix B, Section 2.1.11. 

Check Addrs Check all instruments in the rack for interface bus address conflicts 

User Security This option is used to administer user security.  DAAAC users may be added 
and privilege and warning levels set or adjusted.  This dialog only appears to 
users with Administrator access level assigned.  This feature has been dep-
recated and is no longer supported. 

Flush Spool Flush Spool deletes all spool files. These spool files are temporary files that 
store the waveforms before they are written to the database.  They are typi-
cally deleted automatically; however, this command should be used if the 
spool files must be purged manually as part of a disaster recovery procedure.  
Flush Spool may also be used to reset the single point data spools without 
sacrificing any data collection time.  Appendix D – DAAAC Installation File 
Structure presents a tree structure of the files added when DAAAC is in-
stalled. 

Notebook Open the laboratory notebook interface.  This feature allows arbitrary length 
text to be associated with the system configuration.  The text entries are in-
dexed by user and a given user may view but not edit another user’s entries.  
The option is discussed in detail in 3.7 and Appendix B, Section 2.1.13. 
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Truncate Error Log Delete the contents of the current error log. 

Truncate IO Log Delete the contents of the current IO log. 

Post Process Activate custom post processing operations.  This is an optional feature and 
may not be present. 

Change Station Address  

4.4.5.1 Gang Calibrate All, Tools menu 

Gang Calibrate calibrates all selected, available and active instruments that support internal calibra-
tion. The dialog (See Appendix B, Section 2.1.11) list represents all instruments in the current configura-
tion that can be calibrated internally. Any checked instruments of the indicated type will be calibrated in 
parallel when Start Cal is selected.  When the calibration is done, a summary dialog is presented showing 
the results of the calibration.   

 

4.4.6 Data View menu 

Acquire’s Data View menu contains the following commands: 
Item Description 

View Error Log Display the contents of the error log file in a text editor.  Note that the times as-
sociated with a message are GMT. 

View I/O Log Display the contents of the I/O log file in a text editor. The I/O log records all 
activity on all of the instrumentation communication busses in the system.  
This log can become very large in a short period of time, and when large nega-
tively impacts system performance.  It should only be enabled to trouble shoot 
specific hardware problems. 

View State Log Display the contents of the state log file in a text editor.  The state log tracks all 

acquisition state (e.g. initializing, arming, etc.) entry and exit times as well as 

selected other performance data.  Note that the times associated with a message 

are GMT. 

Performance Report Displays the Generate Performance Report selection dialog.  This dialog allows 
the operator to limit the report to a user-specified number of shots and or sta-
tions. Once Generate Report is selected a report will be generated directly in the 
users already-installed copy of Microsoft Excel.  If Excel is not installed an error 
will be issued.  The report contains the information specified when performance 
monitoring was configured.  This subsystem is optional and may not be present 
in your system.  It is primarily used to monitor the health of very large installa-

tions or facilities. [
 

 Keyed Item.  See Appendix B, Section 2.1.14 for details 
regarding the dialog.] 

  

Networked Systems: Only the current Test Director may perform ganged calibrations on a remote sta-
tion’s instruments. 
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4.4.7 Window menu 

The Window menu offers the following functions: 

Item Description 

Cascade Arranges windows in an overlapped fashion. 

Tile Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of closed windows. 

4.4.8 Help menu 

The Help menu offers the following commands:  
Item Description 

Help Topics Offers an index to help topics. 

Tutorial Activates DAAAC’s Tutorial. 

About Displays general information about the DAAAC installation and the current con-
figuration.  

License Agreement View the DAAAC system End User License Agreement (EULA) 

4.4.9 Rack menu 

The Rack pop-up menu is activated by clicking with the right mouse button inside Ac-
quire’s rack display. It contains functions for adding or modifying instruments in the racks, and 
for moving and copying instruments and settings. 

When activated in an empty rack slot, the single available menu item is Add instrument. 
When activated on an instrument within the rack, the Delete, Copy Settings, Paste Settings, 
Save Settings, and Read Settings instrument commands are available. 

You also can use the mouse’s right button to drag an instrument from one location to an-
other. When the button is released on an empty slot, the Rack menu offers Move and Cancel.  

 
Figure 4-21 - Rack Right-Click Menu. 

Right-click menu items 

Item Description 

Add Adds an instrument at the selected rack location 

Delete Deletes the selected instrument. 
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Active Temporarily activate the selected instrument.  This selection is NOT persistent and will 
be lost when the software is shut down unless the instrument dialog is opened by dou-
ble clicking and dismissed with OK. 

Idle Temporarily idle the selected instrument.  This selection is NOT persistent and will be 
lost when the software is shut down unless the instrument dialog is opened by double 
clicking and dismissed with OK. 

Copy Settings Copies the settings of the current instrument to the buffer. These settings may be 
pasted later to any other instruments of the same type. The copied settings are 
available for pasting until Acquire terminates. 

Paste Settings Paste Settings pastes any instrument settings that were previously Copied (from the 
Rack menu) to the currently selected instrument. This paste operation is valid only if 
the instruments are of the same type. Copy/Paste operations may be performed across 
stations. 

Save Settings Saves the settings from the selected instrument in a specified file, including pre-
processing, channel options,  interface bus settings, and instrument name. Save Set-
tings is primarily useful for cloning a station.  This command can be used to 
save a whole crate and will restore to a crate with the same instrument types in 
the same positions. 

Read Settings Reads settings from a file created with Save Settings item to an instrument of the same 
type. This command can be used on a whole crate. After the settings are read, 
the instrument will no longer be initialized. 

Right-drag menu items 

Item Description 

Move Moves the dragged instrument to the selected position. 

Cancel Cancels the drag operation in progress. 

4.4.9.1 Add Instrument, Rack menu 

Adding an instrument to the inventory and inserting it in a rack was presented briefly in the 
“Getting Started” tutorial, Sections 2.3.2.3 and 2.3.2.4.  This section discusses the process in 
greater detail.  

Add Instrument uses a two-step wizard to: 1) select an instrument from the inventory; and 
2) specify interface settings and select instrument hardware options. 

The Inventory dialog is activated from the rack’s right-click pop-up menu->Add or when 
copying an instrument from one rack position to another. It is the first page in the setup wizard, 
and selects an instrument (manufacturer, model and serial number) from the existing inventory. 
The list of supported instrument types in the inventory list is controlled by your system keys. 
Only those manufacturers supported by your DAAAC license are displayed.   
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Figure 4-22 - Selecting an Instrument from the Inventory 

To select an instrument from the inventory, select the Manufacturer from the left list. All 
models supported by your system for the selected manufacturer are displayed in the center list.  

For example, to install the Stanford Research DG535, select the Stanford Research manu-
facturer name. If your system includes a DAAAC driver for the DG353, it will be listed in the 
center list.  Note that some devices are not listed under a specific manufacturer name, but under a 
general group name such as Cameras/Spectrometers or Misc.  The manufacturer Voss Scientific, 
if present, contains virtual instruments used to test the acquisition and reduction sequences. 

Select a Model from the center list. A list of serial numbers will appear in the right list if 
any instruments of this model type have been added to the database. If no serial numbers exist 
for the selected manufacturer & model, enter a serial number in the edit control and select Add 
New Item.  The new serial number will appear in the list. Optionally, Generate will create a 
unique serial number for you. 

Select a serial number from the Serial Number list, then select Next to continue with the 
configuration step.  The Next button will only be enabled after a manufacturer, model and serial 
number have been selected. 

If your system does not enforce strict inventory control, then a given item instance (manu-
facturer, model, serial number) may be added to the racks (crates) as many times as you like.   

Once you have selected an instrument from the inventory, the Interface dialog configures 
the hardware interface (GPIB, cPCI, etc.), instrument hardware options and instrument name.  
The displayed interface configuration information is specific to the instrument’s interface type, 
and some interface types have no required parameters at this step.  If an instrument has any spe-
cial setup then the Setup button will be enabled.  If Setup is enabled you must click it and spec-
ify whatever options are present before you can add the instrument.  If you are adding an instru-
ment to a crate, the Interface dialog will not appear, but the unit’s Setup dialog will be invoked 
directly when required. 

After specifying the required parameters, click on Finish to add the instrument to the rack. 
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Figure 4-23 - Instrument Interface Configuration 

 

4.4.9.2 Move Instrument, Rack menu 

To move an instrument, select the instrument with the right mouse button and drag it to the 
new location. Release the right mouse button when it is positioned over the proper location on 
the rack. The Rack menu is then activated. Select Move to move the instrument.  

 

4.4.10 General Right-Click Menu 
Right-clicking in the open area of a station window produces a popup menu that allows 

access to the Rescale Racks menu of Appendix B, Section 2.1.5.  It also provides access to Ac-
quire’s properties dialog.   

 
Figure 4-24 - Acquire General Right-Click Menu. 

The station properties dialog is exactly like the interface that appeared when the station 
was created.  This dialog allows the user to adjust station level settings conveniently after the 
station has been added.  All the names of objects may be edited.  The number of racks may be 
increased, but NOT decreased.  Similarly the heights of racks may only be increased after the 
station is added.  Once increased, a decrease may only be accomplished by restoring a previous 
configuration or generating a new database.  (In the networked system, stations may also be de-
leted). 

Networked systems: Copy and Paste operations may be performed across stations. 

Networked systems: instruments may be moved only within a station. 
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Figure 4-25 - Station Properties 

 
Figure 4-26 - Rack Properties 
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5  Archive 
 
 

Archive provides the user’s interface to the database.  From Archive, you can create and se-
lect databases, import and export file data and organize and transfer data.  Archive is also the 
starting point for the DAAAC application.  When you run “DAAAC”, you are actually starting 
the Archive module.  

5.1 Archive Overview 

The database is used to store configurations and such data as waveforms, instrument set-
tings and Cal Item data, and to link all this data together so that the conditions under which any 
set of data was recorded are associated with the data.  

All DAAAC modules, including Archive, connect to the database via the NetCom module. 
NetCom also acts as a communicator between the DAAAC modules and the network, if the in-
stalled DAAAC system supports networked operation.  NetCom is started automatically when 
Archive starts, and it must always be running for any DAAAC module to access the database, 
whether standalone or networked.  

New databases are created from Archive, and Archive is used to select the DAAAC sys-
tem’s operating (active) database.  Archive displays open databases in a two-pane window for 
viewing information such as current configuration and waveform data.  Archive can have several 
databases open at the same time – each displayed in its own window.  Only one of these data-
bases is considered active, however.  The active database is the one that the DAAAC modules 
use to store and retrieve waveform data, instrument configurations and Cal Item data.  A * before 
the title in the database window indicates the active database.   
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Figure 5-1 - Example Archive View with Open Database 

5.1.1 Archive views 

 Archive’s views contain data in a two-pane window. The vertical divider in the center of 
the view sizes the windows. The view’s title displays the computer network name, IP address, 
directory path and current database name.  In non-networked systems, the IP address will always 
be 127.0.0.1 (which refers to the local computer).  The toolbar on the left or Archive’s Data View 
menu activates the view for each module: 

• Database View,  
• Named Configurations View,  
• Waveform View and  
• Calibration Settings View.  

Sections 5.1.1.1 through 5.1.1.3 describe these views in detail.  

5.1.1.1 Database View 

Database View displays DAAAC’s Stations and Tests in the left pane of the database 
window in typical hierarchical directories.  Click either the + leaf to expand the directories, or 
the - leaf to collapse the directories. Other information relating to the current entry is displayed 
in the right pane.  The current DAAAC configuration (Acquire and CalMan settings) can be cop-
ied by dragging the Database View entry from the left pane of the source database to the left 
pane of the target database. 
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The following example shows one station and two tests. Databases used in non-networked 
systems only have one station (representing the local computer).  The current selection is Tests, 
and the time of each test is displayed in the database’s right pane.  To change the name of a his-
toric test, right click on the entry in the right pane and select Rename Test from the popup menu. 

 
Figure 5-2 - Archive Database View 

5.1.1.2 Named Configurations View 

Named Configurations View displays all existing Named Configurations in the window’s 
left pane in hierarchical directories. Click either the + leaf to expand the directories, or the - leaf 
to collapse the directories. Other information pertaining to the current entry is displayed in the 
right pane. 

Named Configurations can be restored from this view:  Select Named Configurations from 
the buttons on the left side of the window. Click on the configuration displayed in the right side 
of the window with the right mouse button, then select Restore Named Configuration from the 
pop-up menu to restore the specified Named Configuration. 

5.1.1.3 Waveform View 

Waveform View displays raw and processed waveform data in the window’s left pane in 
hierarchical directories, using a calendar layout. Click either the + leaf to expand the directories, 
or the - leaf to collapse the directories. Information pertaining to specific waveforms is displayed 
in the right pane.  Waveforms are grouped by year, month, week and day as the directory is ex-
panded. 

All waveforms for the selected time period are displayed in the right pane. For example, if 
the year 2001 is selected, the right pane will display all waveforms acquired during 2001.  If No-
vember is selected, all of November’s waveforms will be displayed. Likewise, when a single 
week or day is selected, all waveforms acquired during that period will be displayed. 
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Figure 5-3 - Waveform Database View 

5.2 Working with Archive 
This section presents a series of step-by-step instructions to guide the user through the 

various Archive operations. 

5.2.1 Creating databases 

To create a database:  

1. From the File menu, select New.  A standard Windows browser dialog will appear. 

2. Browse to the directory into which the new database should be created.  

3. Enter a file name.  If the file name already exists, you must confirm your intent to over-
write the existing file. 

4. Choose Open.  DAAAC will create the new database (or reinitialize an existing database) 
and open it in Archive.   

Creation of a new database does not affect the active database, or any other databases open 
in Archive. 

An alternate method of database creation is to use the Change Database operation.  In the 
Change Database dialog, enter a new, unique database name instead of selecting an existing da-
tabase name. Archive will then create the database and copy the system configuration from the 
currently open database into the new database, if desired.  This is often the preferred way to cre-
ate a new database as it also makes the new database the active database. 
Shortcut 

Keys: [Ctrl]+[N] 

5.2.1.1 Create DAAAC Database dialog 

This standard Windows file/directory dialog allows selecting a directory folder and enter-
ing a name for creating a new DAAAC database. The file dialog can be used to create new fold-
ers and delete existing databases or other files. 
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When a new name is given for a database, DAAAC will create the new database and it is 
then available for use. 
Shortcut 

Keys: [Ctrl]+[N] 

5.2.2 Opening databases  

To open an existing database:  

1. From the File menu, select Open. 

2. Browse to the location of the database.  

3. Select the database.  

4. Choose Open.  DAAAC™ will open the database in Archive.   

This operation will open a database for viewing and for copying data to another database, 
including DAAAC’s current database. It does not close any databases that may be open and it 
will not make this newly opened database the current system database. See Section 5.2.3, imme-
diately below, for instructions on changing DAAAC’s current system database. 

Note: Since the action does not change the active database, this operation will normally 
occur prior to a drag-and-drop transfer of data between databases, including the newly opened 
one.  

Shortcut 

Keys: [Ctrl]+[O] 

5.2.3 Changing databases 

DAAAC’s default database may be changed to another at any time other than during an 
acquisition sequence.  

To change databases:   

5. Switch to Archive if necessary.  

6. Select Change Database on Archive’s toolbar.  The file directory dialog will be activated for 
selecting an existing database, or for entering a name to create a new one. If a name is en-
tered to create a new database, Archive will display a message box asking if the current con-
figuration is to be copied. Select Yes to copy the configuration from the currently open data-
base, including everything but waveform data. If No is selected, a new blank database is cre-
ated and Acquire is activated so that the station can be configured. 

7. Select a database, then choose Open. The currently open database is first closed, and then the 
selected database will open.  

Note: When the active database is changed, the change extends to all of the DAAAC modules.  
The process of changing databases may produce warnings and be prevented if any of the modules is in 
active communication with the database.  For example, if Acquire is actually performing an acquisition 
sequence, the database may not be changed. 
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5.2.4 Copying waveforms   

Note: This and subsequent sections discuss moving data using a technique known as Drag-
and-Drop.  This is the same operation that is familiar to users of the Windows Explorer.  The 
technique begins by selecting the object to be moved (ex: a file in Windows Explorer) with the 
left mouse button.  While continuing to hold the left mouse button, the object is moved from its 
original location to the target location (ex: another folder) with the mouse.  Once the object is 
positioned, the mouse button is released.  The object will either be moved or copied (depending 
on the circumstances) to the new location.  Once the operation is understood, it is a simple and 
practical way to reconfigure objects under Windows.  It is used extensively throughout DAAAC.   

Raw or processed waveforms may be copied from one database to another, either in entire 
groups or within a specific year, month, week or day. 

To copy waveforms from one database to another: 

1. Switch to Archive if necessary.  

2. Open the source and the destination databases, then select Waveform View in the source’s 
left-hand toolbar (the destination database’s current view does not matter). 

3. In the source’s left pane, select the time period from which the waveforms are to be copied.  

4. Drag the selection into the left pane of the destination database.  The pointer will display the 
text of the copied waveforms. If the pointer does not change, the copy is either invalid or the 
pointer is not positioned properly. Archive will ask you to verify the copy. 

5. Choose OK to complete the copy.  As Archive copies the waveforms, the Transfer Status dia-
log will appear.  Archive will notify you when it has finished copying the waveforms. 

6. Choose OK.   

5.2.5 Copying data  

Data from one open database may be copied to another, including the current active data-
base.  Current Configuration, Named Configurations and raw or processed waveforms can be 
copied from one database to another in Archive.   

To copy data from one database to another: 

1. Switch to Archive if necessary.  

2. Open the source and the destination databases, then select Database View, Named Configu-
ration View, or Waveform View with the left-hand vertical toolbar.  (Calibration Settings View 
is not implemented in this version of DAAAC.) 

3. In the source database’s left pane, select the test, configuration or data to be copied.   

• Current configuration: Select the database view for the source database.  Select the “Da-
tabase View” text in the left pane of the source. 

• Named configurations:  Select the configuration view for the source database.  Expand 
the “Named Configuration” tree item.  Select the desired Named Configuration from the 
source’s left pane.   
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• Waveforms: Select the Waveform view.  Expand the calendar control as needed. Select 
any portion of the calendar control from the left pane (day, week, month, etc.) or select 
any group of waveforms from the right pane.  

4. Drag-and-drop it into the left pane of the destination database.  The pointer will display the 
text of the copied item when you have a valid copy. If the pointer does not change, the copy 
is either invalid or the pointer is not positioned properly. Archive will ask you to verify the 
copy. 

 
Figure 5-4 – Validate the Copy 

5. Choose OK to complete the copy.  As Archive copies the data, the Transfer Status dialog will 
appear.  If necessary, choose Suspend or Abort.  Archive will notify you when it has finished 
the copy. 

 

 
Figure 5-5 - Transfer Progress 

6. “Transfer Complete!” appears.  Choose OK.   

5.2.6 Deleting Stations and Tests 

When in Database View, you can select Stations or Tests in the directory on the left side of 
the window to display the list of stations or tests.  When the stations or tests are being displayed 
in the directory on the right side of the window, you can select stations or tests to delete.  Press-
ing [Delete] removes the selected items. 
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5.2.7 Deleting waveforms 

To delete waveforms from the database, the Waveform Selection dialog is opened and data 
is moved to the database Trash receptacle.  Waveforms may be held in Trash indefinitely.  From 
there they can be restored back to the database or permanently removed.  The process is de-
scribed in detail in 3.4.  To open the Waveform Selection dialog, select: 

a) File->Export Waveforms… 

b) Data View->Raw Waveforms…, or  
c) Data View->Processed Waveforms… 

5.3 Archive Toolbar 

Archive’s Toolbar provides the following functions. 

 

Switch to Acquire. 

 

Switch to Analyze. 

 

Switch to Cal Manager. 

 

Change databases.  Make a new database the active database. 

 

Transfer data from one database to another. 

 

Import waveforms. 

 

Export waveforms. 

 

Display program information (About box). 

 

Display online help. 

 

Exit Archive. 

5.4 Archive menus 

The Archive module has the following menus:  
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Item Description 

File menu Performs file operations 

Tasks menu Invokes other DAAAC modules 

Preferences Sets module and display preferences 

Tools Performs database and network administrative operations 

Data View Selects database view mode, displays database information and logs 

Window Arranges displayed windows 

Help  Displays module information and on-line help 

5.4.1 File menu 

The following commands are available under Archive’s File menu: 

Item Description 

New Creates a new DAAAC database 

Open Opens an existing database 

Change Changes the active database 

Close Closes the current database window.  

Import Waveforms… Imports waveform files into the database. Importing images is not sup-
ported in the Archive module, but external image files can be opened in 
the Analyze module. 

Export Waveforms… Exports waveform data to files. If multiple waveforms are selected for ex-
port, the file dialog does not allow selection of a file name and all ex-
ported waveforms are automatically named.  Auto-named files use the 
format <channel name>_<shot number>.<extension>, where extension 
depends on the selected file type.  Exporting images is not supported in 
the Archive module, but images displayed in the Analyze module can be 
exported to several file formats. 

1... N Lists the N (up to 10) most-recent databases 

Exit Exits Archive 

5.4.1.1 New, File menu 

File->New creates a new, empty DAAAC database.  A standard Windows file browser dia-
log is used to select the database name and location.  Selection of an existing name must have the 
overwrite confirmed.  Warning: If you select an existing database name, Archive will reini-
tialize that database, destroying any existing contents.  Archive will then display the new da-
tabase in its own window, along with any databases that are already open.  The active database is 
not affected by this operation.  Data can be copied from the active database into the new data-
base, including test configurations and raw or processed waveforms. 

A new database also can be created when you select Change Database.  See Section 5.2.3, 
for more information.  Creation of a new database using the Change operation is often prefer-
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able, because it allows you to automatically copy the current DAAAC configuration into the new 
database during the creation process. 

Note that this process will create an Access database on a station running a local copy of 
NetCom.  This menu item will not create an MS-SQL database.  Creating a database from the 
file menu normally applies only to standalone operation. 
Shortcuts 

Keys: [Ctrl]+[N] 

5.4.1.2 Open, File menu 

Open is used to connect to additional databases while maintaining the connection to the ac-
tive database.  This command creates a new database window with a connection to a selected 
database from the local or a remote computer.  A standard Windows file browser dialog is used 
to select the database name and location.  Secondary databases opened with this command are 
only used to copy and view configurations.  Archive does not make the newly opened database 
the current system database. To do that, use the Change command (see Section 5.2.3). 

You can have any number of databases open simultaneously, but only one will be the ac-
tive database.  Use the Window menu commands to switch between multiple open database 
views, tile, etc.  Note that any database window except the currently active database may be 
closed.   
Shortcuts 

Keys: [Ctrl]+[O] 

5.4.2 Tasks menu 

The Tasks menu switches between DAAAC’s other modules: Acquire, Analyze or Cal-
Man. If the module is already running, it will become the top, active module. If not, it will be 
started and activated.  The toolbar contains an icon for each of the other DAAAC modules.  
Shortcuts 

Toolbar:  

5.4.3 Preferences menu 

Archive’s Preferences menu selects default application settings and layout preferences. 
Options DAAAC module startup and shutdown behavior, database pre-start cleanup, data migra-

tion, and Log Page selection. 

Toollbar Display/Hide Archive’s toolbar. 

Status Bar Display/Hide Archive’s status bar. 

5.4.4 Options, Preferences menu 

Options opens the Options dialog’s four pages, that control various DAAAC and SQL 
functions. 
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Page Description 

Modules The Modules page contains settings that control the behavior of the DAAAC mod-
ules when Archive is started and stopped. Checking AutoStart starts the module 
when Archive first opens. Checking AutoStop stops the module when Archive exits.  
Checking Minimized minimizes the module’s window after it is started via AutoStart.  
The dialog is presented in detail in Appendix B, Section 2.2.6. 

Database The Database page contains functions to do a pre-start cleanup for SQL databases, 
and SQL transaction log truncation.  These options are valid only if the system data-
base is SQL.  These functions are accessible only to those with Administrative privi-
leges, as set in the User Security options in Acquire.  Refer to Appendix B, Section 
2.2.7 for details. 

Data Migration Data Migration controls the automatic migration/copy of SQL data to the off-
line Access databases that are created for each day, by date.  See Appendix B, 
Section 2.2.8. 

Log Page The Log Page contains a list of log page names, or it will be blank if none 
exist. The Log page is defined and accessed in Acquire.  See Section 4.2.7.4, 
for more information. 

5.4.5 Tools menu 

Archive’s Tools menu provides Administrative utilities for modifying how Archive func-
tions, as well as network administration.   
Item Description 

Stop NetCom or 
Administrative 

If Netcom is running, the first entry in the Tools menu will allow it to be stopped 
from Acquire.  The user will be warned that all modules will be denied access to 
the database. 

Network administrative utilities (network mode only).  This function is available 
only when NetCom is closed. (Advisable only in special circumstances in net-
worked mode.) 

Migrate Data Optional function available only in networked mode.  Allows all data older than a 
user specified interval to be removed from the online database to offline Access 
databases.  This option is available only with NetCom running. 

Minimize Tables Removes records with no linkages (e.g. orphaned as a result of deleting data) and 
compacts the database file in standalone mode..  This option is available only with 
NetCom running. 

Rectify Inventory Copies graph items from a dedicated Cal System database.  This option is available 
only with NetCom running.   

Truncate Transac-
tion Log 

Flushes transactions and tests system integrity.   You can monitor the NetCom 
window during these operations for important messages or review the same 
data in the NetCom log. This option is available only with NetCom running and 
is for networked SQL Server databases only. 

Logs : Truncate 
Error Log 

Delete the current system error log file. 
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Logs : Truncate 
Netcom Log 

Delete the current Netcom Log file. 

Notebook Open the laboratory notebook interface.  Allows arbitrary length text entries to be 
added to the database.  The text entries are indexed by user and a given user may 
view but not edit another users entries.   This option is available only with NetCom 
running. 

5.4.6 Administrative menu 

The Administrative menu is available from Archive’s Tools menu when NetCom is not 
running. This sub-menu contains utilities that perform network and database administrative func-
tions. 
Item Description 

Change Database Selects the ODBC Data Source used by NetCom in the Network Mode. Change 
Database changes DAAAC’s current default database to any existing database. 
This function cannot be used to create a new database. 

A file directory is displayed so that you may select a database name from the disk. 
When the database is opened, Archive informs the other DAAAC™ modules so 
they can reload appropriate data: Acquire will close the current station and open the 
new database’s station. Cal Manager will close all graphs and open the local sta-
tion’s graph. 

Select NetCom 
Server 

When in standalone mode, Select NetCom Server runs NetCom from a different 
computer than the local computer.  Your computer must be networked to use this 
function.  

Select Networked 
Server 

When in networked mode, Select Networked Server runs NetCom from a remote 
computer via the network. Your computer must be networked to use this function.  
See Appendix B, Section 2.2.11 for dialog details. 

Start NetCom Activates the NetCom database server.  See Chapter 8 for details regarding the im-
portance and role of NetCom.   

Stop NetCom Stop NetCom stops DAAAC’s Netcom module. Because NetCom is the 
communications link between all DAAAC™ modules and the database, 
DAAAC™ cannot operate without NetCom running.  This selection will 
always be grayed.   

Manage Data 
Sources 

Manage Data Sources accesses the ODBC Data Source Administrator.  For 
more information, open the ODBC Data Source Administrator, then select 
Help. 

Initialize Database Initialize Database accesses the ODBC Select Data Source utility.  For more 
information, open the ODBC Select Data Source, then choose Help.  
WARNING: This function completely destroys the contents of the selected da-
tabase! 

Inventory Control Sets the Location Code for inventory control, as well as selects the calibration da-
tabase.  See Appendix B, Section 2.2.12 for details.   
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Standalone Selects standalone or networked modes. This disables networking, and the entire 
acquisition system is expected to reside on the current computer.   

5.4.7 Data View Menu 

Archive’s Data View menu provides utilities for examining database records and selecting 
viewing modes: 

Item Description 

Database View Switches the selected database window to Database view mode, which displays 
Stations and Tests in the database. 

Configuration View Switches the selected database window to Configuration view mode, which dis-
plays Named Configurations in the database. 

Waveform View Switches the selected database window to Waveform view mode, which displays 
Waveforms and Images in the database. 

Table Info The Table Info option opens a dialog that lists the various database tables alpha-
betically.  For each of the tables, the number of entries held by the currently ac-
tive database is listed.  See Appendix B, Section 2.2.13. 

Raw Waveforms…  Activates the Select Raw Waveforms dialog, for viewing listings of the raw data 
in the active database.  See 3.4 for a general discussion.   

Processed Wave-
forms...  

Activates the Select Processed Waveforms dialog, for viewing listings of the 
processed data in the active database.  See 3.4 for a general discussion.   

Error Log Views the contents of the Error log file – error and warning messages generated 
by all DAAAC modules. 

State Log Views the contents of the Acquisition State log file – sequence information and 
performance metrics generated during the acquisition sequence. 

NetCom Log Views the contents of the NetCom log file – database related status and error 
messages generated by the NetCom module. 

Data Migration Log Views the contents of the Data Migration log file. The Data Migration Log lists 
the dates on which data were migrated, the files the data were migrated to, 
and which expired data have been deleted, along with any errors encoun-
tered during migration. 

Registry Settings…  

5.4.8 Window menu 

Archive’s Window menu provides the following functions: 
Item Description 

Cascade Overlaps and cascades all open database windows.  

Tile Horizontally Arranges and sizes all windows horizontally.  

Tile Vertically Arranges and sizes all window vertically. 

Arrange Icons Arranges all minimized window icons.  
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1... N Lists all open database windows. 

5.4.9 Help menu 

Archive’s Help menu provides information concerning how to use DAAAC, as well as in-
formation about the current system and database.  

Item Description 

Help Topics Opens the Help Topics Contents.  

Tutorial Opens a tutorial that explains DAAAC’s primary functionality.  

Info Displays the number of records in each table within the active database.  

About... Presents information about DAAAC and its copyright. 
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6 CalMan 
CalMan is DAAAC’s signal line management and data reduction module.  It automatically 

reduces raw data based on the contents of the acquisition signal lines—called Cal Lines—and is 
the inventory manager for the signal line components—called Cal Items—used in the acquisition 
system.  A brief and simplified introduction to CalMan was presented in Section 2.3.3.  This 
chapter provides a complete, detailed discussion of CalMan. 

6.1 CalMan overview 

CalMan displays the current acquisition station as a hierarchical graph of Cal Items linked 
into Cal Lines as in Figure 6-1. This graph represents the electrical connections in the acquisition 
signal lines by displaying each component of the Cal Line, from the sensor that detects the sig-
nal, left, to the destination instrument channel. CalMan then reduces the recorded data based on 
the Cal Line definition and the characterizations of each Cal Item in the line. 
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Figure 6-1 - The DAAAC CalMan Module with a Graph of Signal Paths 

A graph displays the components used in the acquisition system, along with their connec-
tions, in four distinct tiers. Individual graph items – called nodes – represent the signal line com-
ponents, the instruments and the controlling computer (station).  Except for the Station and In-
strument nodes, each component has a settings dialog that configures its properties to match the 
electrical properties of the component in the real acquisition line. 

The first graph tier contains the single Station node at the graph’s top-left corner. It can be 
used to create new lines and print the graph, but has no settings dialog. 

The second tier, or column, holds instrument nodes.   Like the station node, the instrument 
node has no settings of its own, and is used to add new signal lines or print portions of the graph.  
If the Acquire module is running, double-clicking an instrument node in CalMan will transfer 
control to the corresponding instrument interface in Acquire.   

The single column of channel nodes occupies the third tier.  They are used to specify the 
type of data present in this signal line (e.g., image, wideband waveform, narrowband waveform), 
and whether or not this line is part of the automated reduction process.  See Section 6.2.4.1.1, for 
details on channel reduction settings.   

The final tier is made up of any number of columns of nodes.  Multiple nodes representing 
Cal Items are attached to the right of the channel, to create a Cal Line. Cal Items are added to the 
graph from an Inventory List that manages the available items. Once a Cal Item has been added, 

Station 
Node

Instrument 
Nodes

Channel Nodes 

Cal Lines Start Here 

Nodes Representing Cal Items
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its settings dialog can be accessed by double-clicking the Cal Item node or pressing [Enter] after 
selecting the node.  In addition to displaying the item’s electrical characteristics, the settings dia-
log is also used to specify what happens to computed data during the reduction process. 

Edges between the station, digitizers, and channel nodes show the hierarchical relation-
ships between those components (stations contain instruments that contain channels).  Edges be-
tween the channels and signal path components represent physical links (e.g. an attenuator con-
nected to a cable) and data flow.  Edges typically extend horizontally between connected signal 
path components and do not indicate direction (several special cases are discussed below). 

The user builds a graph by connecting new nodes to existing nodes, beginning with the station 
node.  The user determines the component connections, but component placement and edge routing is 
automatically determined by the software.   

In CalMan, data reduction is enabled at two levels – the channel and the individual Cal 
Items.  The channel level control simply turns reduction on and off for the entire Cal Line.  Each 
Cal Item node has controls to specify what happens to the data computed at that node.  Among 
other things, the user can select whether each node’s data is displayed, printed or archived.  It is 
important to note that, if reduction is turned on for a particular channel, all nodes in the corre-
sponding Cal Line will be processed, even if some or all of the Cal Items are not configured to 
display / print / archive their data. 

6.1.1 Terminology 
Several terms were introduced in the previous section.  They are presented here in more 

detail.  In particular please note the distinction between an Item and a Node. 
• Item (also cal item or inventory item) – the definition of a signal path component or proc-

essing algorithm that includes all information required to characterize the item for pur-
poses of data reduction.  Cal Items are maintained in a CalMan inventory.  A Cal Item 
may be represented by a Node on the CalMan graph. 

• Hard item – represents hardware components in the signal path.  Includes characteriza-
tion data that is used during the data reduction sequence to “unfold” the effects of the 
component on the signal passing through that component.  Examples: attenuator, ampli-
fier, cable, filter, sensor. 

• Soft item – algorithms used to automatically process data during the reduction sequence.  
Examples: user process, waveform / image branch, overlay, combine. 

• Node – a representative container for a hard or soft1 cal item that has been added to the 
graph.  The node is used to access the item, maintain connection information and store 
data reduction information.  Not all nodes on the graph represent Cal Items.  The first 
three columns in the graph contain nodes that represent the Station, Instruments in the 
Station and Channels in the Instruments, respectively. 

• Edge – lines that represent the connections between nodes.  
• Cal Line – A linear collection of cal item nodes, originating at a channel node, and con-

nected by edges.  Data collected by the channel is processed at each node as it is moved 
to the right along the cal line. 

                                                 
1 While several connection restrictions and special cases exist, hard and soft items/nodes are largely treated in the 
same manner (i.e., not segregated in the inventory list, no display characteristics to distinguish them in the graph, 
etc.) 
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• Graph – the complete collection of nodes and edges.   

6.1.2 CalMan’s role in acquisition 

During the acquisition sequence, CalMan’s primary function is to compute data reduction 
for each acquisition line and for all Cal Items attached to those lines.  To perform an on-line 
automated reduction, CalMan should be running and configured before acquisition begins. See 
Section 6.2.1 for information about configuring the system.  Auto Reduce Data (Global Settings | 
Acquisition) must be selected in Acquire for reduction to be performed as part of the acquisition 
sequence. See Section 4.2.7 for more information. 

During acquisition, Acquire spools the newly-collected data to disk files.  If automatic re-
duction is enabled, Acquire will notify CalMan to start the reduction on the data in those files. 
CalMan must be running for reduction to be performed – Acquire will not automatically start 
CalMan for data reduction. 

Next, CalMan traverses each line of the graph and computes reduction outputs for each Cal 
Item in the line. Cal Manager then sends the data to the database to be permanently archived and 
to Analyze to be displayed and printed.  

Each of the Cal Items in the signal line must be configured properly for the reduction to be 
effective. Many Cal Items are characterized with a curve, which is typically a waveform pro-
duced by a network analyzer to define the item’s electrical characteristics, such as dB loss over a 
frequency range. This characterization also can be a simple polynomial value instead of a com-
plex waveform. The polynomial type is most often used with devices such as attenuators and 
splitters that have relatively constant or linear response over the expected frequency range. 

Some Cal Items contain additional property settings to further characterize the physical 
item. For example, Cables require a length entry to compute the time delay based on the cable 
type.  Sensors contain many different options (e.g. equivalent area, impedance, transmission line) 
to characterize the specific type of sensor. 

In addition to the Cal Items that represent physical components, CalMan contains several 
items that support automated, custom data processing.  These include the User Process, Com-
bine and Overlay items.  Systems that support image acquisition also include items for image 
processing and image-to-waveform conversion. 

Each Cal Item that is used in a signal line contains a Reduction page for selecting output 
handling (display, print or archive), Figures of Merit (FOMs) and display options.  FOMs are 
metrics taken directly from or computed from the reduced data. The FOMs dialog lists the Fig-
ures of Merit that may be selected, configured and attached to the Cal Item’s reduction output. 
These FOMs then are archived with the data and can be displayed with the reduced data in Ana-
lyze. 

6.1.3 Data reduction 

When performing data reduction for physical components (e.g., amplifier, cable, mixer, fil-
ter, sensor), CalMan proceeds to “undo” the effects of each component on the input signal.  
Starting with the recorded data in at the digitizer, CalMan works backwards through each com-
ponent until it has computed the physical quantities present at the sensor. The processing used to 
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correct for the components depends on both the signal type (e.g., wideband waveform, narrow-
band waveform, image) and the component type.  

For example, before a raw waveform is acquired by an instrument, suppose it passes 
through a sensor, an attenuator and a 10-foot cable. The raw data acquired by the instrument is 
not the same as was seen at the sensor because each component has an effect on the original sig-
nal. CalMan reduces the data by using the original captured input signal then compensating for 
the loss through the cable and attenuator.  The sensor reduction is based on the specific sensor 
type used, and would likely involve a conversion of units (e.g. to power density, E-field, amps).  
CalMan precisely determines the data conversion by applying each item’s reduction algorithm, 
which is used in conjunction with the item’s characterization data. 

Item Data pages for many Cal Items include a curve specification that characterizes the 
item’s effect on the input signal. Selecting Curve in the item interface activates the curve dialog, 
which either creates a polynomial or selects a calibration waveform file.  Preferably, this curve 
should be the waveform that resulted from a direct characterization of the particular device, such 
as a network analyzer sweep. 

When performing data reduction on Cal Items that do not represent physical components, 
CalMan is simply applying user-specified functions in an automated fashion.  Common user 
processing includes waveform scaling, integration, dividing one channel by another, creating 
overlays and extracting rows from images.  There are three primary advantages to CalMan’s 
method of data processing: 1) it automates the entire data processing effort – once CalMan is 
configured, multiple data channels over multiple acquisitions can be processed with a few mouse 
clicks; 2) it provides complete documentation – a permanent record of the processing steps is 
associated with the processed data; and 3) it uses a simple graphical interface that does not re-
quire the user to write code. 

6.1.4 Direction and Input / Output naming conventions 
Nodes may have a notion of signal inputs and outputs (or also parent and child), but it is 

important to understand that the input and output sides may change depending on the context.  
For example, examine the CalMan graph shown in Figure 6-1 with digitizers on the left side and 
sensors on the right.  During data acquisition data flows from right to left (from the sensor to the 
digitizer), so the node outputs are on the left side.  During data reduction data flows from left to 
right (digitizer to sensor), so outputs are on the right side.  A physical component like a splitter 
has multiple outputs that would be drawn on the left side.  A processing component like an im-
age branch has multiple outputs on the right side.  Also note that some cal items, such as 
switches, can be oriented with their multiple ports on either side.  Physical inputs and outputs are 
referred to as ports, which indicates flow from sensor to digitizer.  Data processing node inputs 
and outputs will be preceded by the tag “reduction”, indicating flow from digitizer to sensor. 

The following section presents particular Cal Items or classes of Cal Item that have mul-
tiple input and/or output ports.  

6.1.4.1 Multi Input / Output nodes 
The majority of the cal items have a single input and a single output, whether referring to 

their physical connections or data flow during reduction.  Here the special cases are presented – 
those nodes that have either multiple inputs or multiple outputs (at present no items are sup-
ported that have both).   
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6.1.4.1.1 Waveform and Image branch 

These soft items make multiple copies of the input data during the reduction sequence for 
processing along parallel paths (see Figure 6-2).  Only the primary path that follows the branch 
node can contain hardware components.  Link lines out of the branch nodes are not labeled, be-
cause all branch node reduction outputs are identical (i.e. the reduced data generated for each 
output is the same).  To create a new branch, select Insert an item to the RIGHT from the branch 
node’s right-click menu or drag-n-drop the item onto the branch node.  Branches are displayed 
and reduced in the order added. 
 

 
Figure 6-2. Waveform branch node. 

6.1.4.1.2 Multiple reduction output (multi-out) 

Soft items that are currently limited to the image divider, but will soon include the FROG 
item, the mixer item and any other item that generates multiple output waveforms and/or images 
during reduction.  Multi-out items behave like branch nodes, but have unique outputs.  Connec-
tion of a node to the multi-out’s output side requires user selection of an available reduction out-
put. A label identifying the selected reduction output is displayed next to the connected node 
(Figure 6-3).   
 

May not be Hard Items
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Figure 6-3. Image divider node with four reduction outputs. 

6.1.4.1.3 Coax switches and multi-port (adder/splitter) 

These items are hardware components that have a single port on one side, multiple ports 
on the other side, and can be oriented with their multiple port sides towards the instrument or to-
wards the sensor.  A multi-port item that splits one signal from a sensor into multiple outputs is 
called a splitter.  A multi-port item that combines multiple sensor signals into a single output is 
called an adder.   

 
If the switch or multi-port has multiple inputs (ports on the sensor side), parallel sub-lines 

are constructed to indicate the components connected to each port.  All sublines are located be-
low the main line, in the order constructed (see the switch in the first row of Figure 6-4).  If the 
switch/multi-port item is added with multiple outputs (ports on the instrument side), one of its 
outputs is on the same line as the switch/multiport item and all other outputs are connected via 
graph edges to other signal lines (see the switch in the third row of Figure 6-4).  Switches select a 
single input or output port to be connected at any given time.  The current switch position is dis-
played under the switch node and the active port’s connecting edge is displayed with a solid line, 
while all other port edges are displayed with a dashed line. 

 
Switch/multi-port items have individual characterization curves for each port, so each 

port is numbered.  An available port number must be selected whenever a node is attached to the 
switch/multi-port’s multiple port side.  The port number is then displayed in the graph near each 
node that connects to the switch/multi-port.  The port numbers are not shown near the multi-port 
node because the diagram is already crowded at that node. 
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Figure 6-4. Switches and multi-port (splitter) nodes 

6.1.4.1.4 Combine and Overlay 

This is a group of soft items that are initially added to the graph like any other single-
input/single-output node.  Once added in the normal manner, the user can select outputs from 
any other node as combine/overlay reduction operands.  To specify an operand, choose Select 
Combine / Overlay Operand from the combine/overlay node’s right-click menu, then click on the 
operand node.  Directional connecting edges from operand node to combine/overlay node origi-
nate and terminate at the bottoms of the nodes and are drawn using a dotted pen (Figure 6-5). 
 

 
Figure 6-5. Overlay node 

6.1.5 Inventory Cal Items 

Cal Item nodes are the graphical representations of signal line components. Each compo-
nent (or component group) in the real acquisition line should be represented in CalMan’s graph, 
and the Cal Item should accurately characterize the real component. All Cal Items are invento-
ried and therefore must be created, configured and added to the database before they can be used 
in the graph. 
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Cal Items are created with the main Inventory List that is available from the Inventory 
menu.  See Section 6.2.5, for more information.   

For systems with strict Inventory Control, each Cal Item’s configuration dialog has at least 
two pages: the Inventory Data page and the Item Data page. The Inventory Data page is the same 
for all Cal Items, and contains mandatory fields that uniquely identify each item. CalMan will 
not allow duplicate information in these key fields.  

 
Figure 6-6 - Sample Cal Item Configuration Dialog- Attenuator 

For systems without strict inventory control, only the Item Data page is displayed when 
Cal Items are created. The Item Data page contains characterization information specific to each 
Cal Item type, as well as the item Name and Description fields. The Name field is the key field 
and it must be unique. For inventory-controlled systems, the Item Data page is always the second 
page after the Inventory Data page.   

Strict inventory control is not a user-selectable option and is not a standard DAAAC deliv-
ery configuration.   

Cal Item data is specific to each item type.  Many parameters are for bookkeeping purposes 
only.  These do not affect the item processing.  CalMan will alert the user if any required data 
has not been supplied. For example, Multi-Port Cal Items require information about how many 
ports they support and Cable Cal Items require a length to be entered. 

If data reduction is supported, a third page will appear for reduction configuration, but only 
after the item has been added to the graph. The Reduction page is not displayed during item crea-
tion, or when accessed through the main inventory list. The Reduction page is the same for most 
Cal Item types. Items that have more than one output waveform type (Mixers, FROG, etc.) allow 
specification of reduction options for each output object. 

Cal Item inventory data may not be changed, but most item data properties may be 
changed after the item is created.  For example, the cable’s type and length can be altered, and 
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the integrator’s type, time constant and delay may change.  For all Cal Items, the curve, delay 
and reduction page data may be changed at any time.  

6.2 Working with Cal Manager 

6.2.1 Setting up Cal Manager 

Before Cal Manager can reduce data or track inventory, it must be configured by following 
these steps:  

1. Select a station from the Stations dialog (Graph | Stations…). This creates a new station 
graph, consisting of a single Station positioned in the top-left corner. Only one station is 
available with standalone systems.  The procedure for doing this is described in “Creating 
the graph” immediately below. 

 
Figure 6-7 - Select a Station to be Calibrated 

2. Once the station is in place, instruments and channels can be added.  To do this, refer to 
section 6.2.3.1, and section 6.2.4.1. 

3. Cal Items then must be created and added to Cal Manager’s Inventory, as described in 
6.2.5.2.  These then can be added to the acquisition lines that stem from each instrument 
channel.   

Once the Cal Lines are populated with the Cal Items, Cal Manager can be configured for 
automatic data reduction, as described in Section 6.1.3.  

6.2.2 Cal Manager’s graph 

6.2.2.1 Creating the graph 

To create a new graph: 

1. Activate Cal Manager. 

2. If no graph window is present in CalMan, select the Graph | Stations menu.  The Stations 
dialog will open.  Otherwise, skip to step 4. 
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3. Open the desired station by double-clicking it.  Networked DAAAC configurations can 
contain multiple stations.  Stand-alone configurations will contain a single entry. 

4. If the selected graph is new, a single station node will be displayed. 

5. Right-click on the station node and select Insert a new cal-line from the pop-up menu.  
The Cal Lines dialog will open. 

6. Open the channels for the desired instruments by clicking the instrument. 

7. Double-click the desired channel.  The New Cal Line dialog will open. 

8. Enter an optional description, then choose OK. The new channel’s settings dialog will 
open. 

9. Configure the channel settings, being sure to specify the signal class, then choose OK.   

10. Continue adding channels from the Cal Lines dialog if desired (steps 5-9).  

11. Choose Finished to close the Cal Lines dialog and return to the graph.   

Populate the new Cal Line by using either the Inventory List available from the Inventory 
menu, or by using the Drag and Drop Inventory List. 

If the selected station has a graph that was previously created, that graph then will be 
loaded. The loading status will be displayed in the status bar’s first pane, at the lower-left corner 
of the window. Each item’s name is displayed as it is created and displayed in the graph. 

6.2.2.2 Editing the graph’s appearance 

Many aspects of the displayed graph’s appearance can be changed, including the size, 
color and style of the components within the graph.   

To edit the graph’s appearance:  

1. Right-click over a blank area in the graph to display the graph’s pop-up settings menu. 

2. Select the desired commands to edit the graph display settings. 

6.2.2.3 Printing the current graph 

When printed, all Cal Items in the graph are listed and grouped by instrument and channel. 
The items are printed in the order that they appear in the graph. Cal Item information includes 
item type, name, description, delay and calibration factor.   

As an option, barcodes can be printed above each Cal Item. The option for enabling bar-
code printing is found in the Barcode Tuning dialog, which is available by selecting Preferences 
| Barcode Print Setup from the menu. 

To print the current graph:  

1. From the File menu, select Print Graph Items. Alternatively, select Print Graph Items 
from a station, instrument or channel node.  The standard Print dialog will appear. 

2. Make any changes that may be necessary to the print settings, then choose OK. A tabular 
listing or graphical display of components in Cal Manager’s current graph will be printed. 
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The following is a sample tabular graph printout. This graph contains two channels with 
two identical lines. 
Calibration Lines for Station: Test 
12-31-03 
8:00:00 
Page 1 of 1 
 
Instrument: Wave 
Channel: W1-C1 (reduction is on) 
Description: Test reduction 
Type Name Description Delay (n-sec) Cal.Factor 
Cable 10’ cable Line one cable 14.287 0 
Attenuator 3dB attenuation Line one atten 0 0 
Sensor Open End WG Line one sensor 0 0 
 
Instrument: Wave 
Channel: W1-C2 (reduction is on) 
Description: Test reduction 
Type Name Description Delay (n-sec) Cal.Factor 
Cable 10’ cable Line one cable 14.287 0 
Attenuator 3dB attenuation Line one atten 0 0 
Sensor Open End WG Line one sensor 0 0 

6.2.2.3.1.1 Printing Options, Cal Manager 
Printing options are available to print the current graph contents, a graphic description by 

instrument or single channel, and Cal Item inventory by single-type or the complete inventory. 

6.2.2.4 Exporting graph files 

Graphical representations of selected instruments in the current graph can be exported in 
DXF format.   

To export the graph to a DXF file:  

1. From the File menu, select DXF Export Graph.  A dialog will open that instructs you to 
use the mouse to select the instruments that should be exported.  

2. Press OK. 

3. With the mouse, click on the instruments that should be included in the DXF file.   

4. When all of the instruments are selected, click within the background space of the graph 
to indicate that the instruments have been selected and the file export should begin. A 
Save As dialog will open.  

5. If desired, navigate to a directory for the DXF file to be exported to and enter a name for 
the file. If the name entered here matches the name of an existing DXF file in the same 
directory, DAAAC™ will overwrite the existing file. No warning will be displayed be-
fore this occurs.   

6. Choose Save. A confirmation dialog will open to display the number of lines exported to 
the DXF file and the directory location of it.   

7. Choose OK to close this confirmation dialog and return to Cal Manager’s graph. 
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6.2.3 Instruments 

6.2.3.1 Inserting instruments 

Instruments that are available in DAAAC’s inventory from Acquire can be added to Cal 
Manager’s graph for reduction. (Refer to Section 4.4.9.1 for instructions on adding instruments 
to DAAAC’s inventory.)  Instruments are automatically added and placed into the graph when a 
channel is selected from the Cal Lines dialog. They cannot be added unless a channel is selected.   

To insert an instrument:  

1. Select the Graph | Lines menu. The Cal Lines dialog will appear. 

2. Double-click the instrument to be added, then double-click a channel. The New Cal Line 
dialog will appear. 

3. Enter an optional description, then choose OK.  The channel’s Reduction page will ap-
pear. 

4. Change the Reduction settings as desired, then choose OK.  The new channel will be 
listed under the new instrument in the Cal Lines dialog.   

5. If desired, continue adding channels by following steps 2 through 4, or choose Finished.  
The new instrument and the selected channels will appear in the graph.   

To add Cal Items to the channel, see Section 6.2.5.2 and Section 6.2.5.4. 

6.2.3.2 Moving Instruments 

Once placed in the graph, instruments can be repositioned with their attached channels and 
Cal Lines by using either the keyboard or mouse. 

To move an instrument with the keyboard: 

1. Select the instrument to be moved by clicking it with the mouse or scrolling with the 
keyboard arrow keys. 

2. Press [Control]+[C].  The instrument will be highlighted to indicate that it is marked 
to be moved. 

3. Select any other instrument and press [Control]+[V] to place the instrument below the 
second instrument or press [Control]+[A] to place the instrument above the second 
instrument. 

To move an instrument with the mouse: 

1. With the left mouse button, click on the instrument to be moved and drag it to the 
new position within the instrument column.  The graph will scroll if needed. 

2. Release the left mouse button. 

Moving instruments does not break any Splitter or Combine links that may exist between 
Cal Items attached to the moved instrument and others. 
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6.2.3.3 Deleting instruments 

When an instrument is deleted, its channels are removed and the Cal Items attached to each 
channel are removed and returned to the Inventory List.  Deleting an instrument in CalMan does 
not affect the instrument in Acquire. 

To delete an instrument:  

1. Right-click the instrument to display the pop-up menu.   

2. Select Delete this instrument. A confirmation dialog will appear before the instrument is 
deleted. 

3. Choose OK to delete the instrument, or Cancel to leave the instrument in the graph. 

6.2.4 Channels and Cal Lines 

6.2.4.1 Inserting channels 

Channels mark the beginning of the Cal Line.  They are placed to the right of the instru-
ments from which they extend. An acquisition line must begin with an instrument’s channel.  

To insert a channel: 

1. Either:  

• Right click the instrument from which the Channel and Cal Line should extend and 
choose Insert channel or… 

• Graph | Select the Lines menu.  

The Cal Lines dialog will appear.  (See Figure 6-11) 

2. Double-click the instrument to open its list of channels, then double-click the desired 
channel.  The New Cal Line dialog will appear.  

3. Enter an optional description, then choose OK. The channel’s Reduction page will ap-
pear.  

4. Modify the settings as necessary, then choose OK. 

5. If desired, continue selecting channels to add from the Cal Lines dialog by repeating 
steps 2 through 4.  

6. Choose Finished.  The new channels will be added to the graph.  

Once an instrument and its first channel are inserted into the graph, subsequent channels 
for this instrument are inserted the same way. 
Shortcuts 

Toolbar:  

6.2.4.1.1 Channel Reduction page 

The Channel Reduction page configures the reduction settings for channels.  It will be ac-
tivated automatically when a new channel is created, and can be accessed at any time by double-
clicking on a channel node.   
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Figure 6-8 - Cal Item Configuration Dialog - Channel Reduction Page 

 Item Description 

Output waveforms  

Display When checked, write reduced data to the display 

Print When checked, send reduced data to the printer 

Archive When checked, write reduced data to a file. 

FOMS  

Settings  

Display Set the display axis limits.  Allow automatic 
setting or manually adjust. 

Channel Options  

Reduce this channel When checked, reduction is performed during online or offline reduction. If it is 
not checked, no items in the line will be reduced. 
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Signal Class Selects the type of data that this line will process (wideband, narrowband or im-
age). The Settings button (described below) activates a configuration dialog that 
sets the reduction options based on the Signal Class. 

Settings Activates a configuration dialog corresponding to the currently selected Signal 
Class. See Section 6.2.4.1.1.1 and Section 6.2.4.1.1.2, immediately below. 

Be sure to specify the proper signal class before adding Cal Items to the Cal Line.  The 
various Cal Items are not compatible with all signal classes (e.g., you cannot add an image proc-
essing Cal Item to a channel with a wideband signal class). 

See Section 6.2.5.2.3 for information on Cal Item reduction settings. 

6.2.4.1.1.1 Wideband settings, Channel Reduction page 

When the Wide Band setting is selected from the Signal Class control on the Channel Re-
duction page, clicking Settings opens the Wideband Reduction Settings dialog.  The dialog is 
used to configure the reduction settings for wideband waveform data. 

 
Figure 6-9 - Wideband Reduction Configuration 

Compensate in the 
frequency domain 

If not selected, the DC (0 Hz) value of the characterization curve is applied directly 
to the input waveform in the time domain.  If the curve is not defined at 0 Hz, the 
curve value at the lowest frequency is used. 

If selected, the input waveform is converted to the frequency domain.  The gain at 
each input waveform frequency is looked up in the gain vs. frequency characteriza-
tion curve, and then applied to the input waveform.  The reduced waveform is then 
converted back to the time domain. 

Filter Definition This filter is used to prevent over-amplification of high frequency noise in the in-
put waveform.  The filter is applied to the input waveform after it is converted to 
the frequency domain.  The applied filter is a cosine function that rolls from a scale 
value of 1.0 to a scale value of 0.0, 

Filter Start Indicates the starting frequency (in GHz) of the roll-off filter.  At this frequency, 
the filter scale value is 1.0. 
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Filter Stop Indicates the end frequency (in GHz) of the roll-off filter.  At this frequency, the 
filter scale value is 0.0. 

Number of Points Number of points in the filter waveform.  This value determines the frequency 
resolution of the filter.  A value of 100 is typically adequate. 

6.2.4.1.1.2 Narrowband settings, Channel Reduction page 
When the Narrow Band Signal Class is selected, Settings opens the Narrow Band Reduc-

tion Options dialog. It configures narrowband parameters for the Cal Line.  Narrowband reduc-
tion assumes that at each point in time, only one frequency is present in the signal.  That fre-
quency, however, may change over time.  Narrowband channels may also use mixer or crystal 
detection to convert high frequency signals to lower frequencies that can be digitized.  Mixer 
channels are capable of performing the down-conversion in a manner that allows construction of 
a frequency vs. time waveform.  This waveform can then be referenced by other channels to de-
termine the frequency at any point in the signal, and thus use the appropriate correction factor. 

 
Figure 6-10 - Narrowband Reduction Configuration 

From the Frequency Source During Reduction list, select the source of the frequency vs. 
time information. The options are as follows: 

Freq Envelope – Other 
Chan 

Use the frequency vs. time information from some other channel.  Select the 
channel from the list in this dialog box. 

Freq Envelope – This 
Chan 

Use this channel’s frequency vs. time information. 

Local Constant Use the default frequency (specified in this dialog) over the entire waveform. 

Global Constant Use the global frequency (specified in the Reduction | Global Parameters 



                  

DAAAC 4.0 User’s Manual   125

menu) over the entire waveform. 

The Min Freq and Max Freq values limit the returned value from the frequency lookup.  
The Time Offset accounts for time delays between the data on this channel and the data from the 
frequency vs. time reference channel.  The specified time offset is subtracted from this Cal 
Line’s waveforms before the frequency vs. time lookup is performed. 

6.2.4.1.1.3 Image settings, Channel Reduction page 
The Image signal class has no channel reduction settings at this time. 

6.2.4.2 Inserting Cal Lines 

Because Cal Lines start with a channel, Cal Line creation begins when channel nodes are 
inserted into the graph.  See Section 6.2.4.1 for instructions.  Once the Channel is included in the 
graph, Cal Items can be added to complete the Cal Line.  See Sections 6.2.5.2 and 6.2.5.4 for 
more instructions. 

6.2.4.2.1 Cal Lines dialog 

The Cal Lines dialog lists all available instruments and channels for the current station.  
A check mark beside the channel indicates that it is already selected and displayed in Cal Man-
ager’s graph. Only those channels that have not been selected are available.   The dialog is 
opened by selecting the instrument in the graph, right-clicking and selecting Insert channel from 
the popup menu.  An alternative is to go to the menu Graph | Lines… option. 

 
Figure 6-11 - Cal Lines Dialog 
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Channels are selected for insertion into the graph by double-clicking them.  The New Cal 
Line dialog will appear for entering appropriate information. Channels are always placed in the 
graph beside and under their corresponding instrument.  If necessary, an instrument node is 
automatically created when a channel is selected.  

 
Figure 6-12 - Cal Line Configuration Dialog 

6.2.4.3 Deleting channels 

To delete a channel: 

1. In Cal Manager’s graph, activate the channel with the right mouse button to display its 
menu.   

2. Select Delete this item. A confirmation dialog will appear. 

3. Choose OK to delete the channel, or Cancel to leave it in the graph. 

An alternate method is to select the channel so that it is active, then press [Delete].   

When a channel is deleted, all Cal Items for the deleted Cal Line are removed from the 
graph and returned to the inventory. When the last or only channel under an instrument is de-
leted, the instrument node also will be removed. 

6.2.4.4 Copying Cal Lines 

To copy a Cal Line:  

1. Click on the left-most Cal Item in the Cal Line segment to be copied. It should be the Cal 
Item that marks the beginning of the Cal Line segment.  This does not have to be the first 
Cal Item on the line, and it cannot be an instrument or a channel node.  

2. Press [Ctrl]+[C] to copy the Cal Line segment to your computer’s Clipboard.  

3. Click on the Cal Item to the left of where the Cal Line segment should be copied. Press 
[Ctrl]+[V] to insert the Cal Line segment. The copied Cal Line segment will appear in the 
destination Cal Line.  

If the copied Cal Line contains Multi-Port Cal Items such as Adders, then all lines attached 
to it will be copied as well. When copying Splitters, the outputs that branch to other lines will be 
disabled, but the first output to the left will be enabled and set to Port 1 automatically. 
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6.2.5 Cal Items 

6.2.5.1 Inventory List dialog 

The Inventory List dialog creates, edits and deletes Cal Items and is also used to select 
items for insertion into the graph.  The list is available from Inventory | Inventory List… or by 
selecting a channel or cal item, right-clicking and choosing Insert Cal Item… from the popup 
menu. 
Item Description 

Cal Item Type This list contains all Cal Item devices supported by Cal Manager. Select the Cal 
Item type to edit, create, delete or print. Items already existing in the database are 
listed in the right-hand list. When the Cal Item Types selection changes, the cur-
rently inventoried types are displayed in the Inventory List, an icon of the current 
item is displayed and the total number of items listed in the Inventory List is dis-
played. 

<Type> Inventory 
List 

This list contains the Cal Items already in the inventory for the current type se-
lected from the Cal Item Types list on the left. The items displayed in this list de-
pend on the features of the installed DAAAC™ system. For all systems, at least 
Name, In Use and Description are listed.  For performance reasons, the Description 
field is not initially displayed for any item. To display the description, select the 
item with the mouse by clicking it once. 

 
Figure 6-13 - Item Inventory 

A compact drag-and-drop inventory list is also available, but is used only for inserting 
items into the graph; you can’t create or edit items from this dialog. See Section 6.2.5.4.1 for 
specifics. 
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Name/Retrieve 
Item by Name 

Retrieves items for editing if the name is known. This speeds retrieval operations for 
large inventory systems. After this field is completed, use [Tab] to exit the field. This 
retrieves the item from the database. If found, it will be listed alone in the Inventory 
List box. If it is not in the database, a message is displayed.  

Create  To create a new Cal Item, select the type of item from Cal Items Type list (Ampli-
fier, Attenuator, Balun, Bdot, etc.), then select Create. An Inventory Data page for 
that Cal Item will open. Enter the data to configure the new Cal Item, then select OK. 
The new Cal Item is then added to the Inventory List. 

Edit To edit the settings for an existing Cal Item, either double-click the item in the Cal 
Item’s Inventory List column, or highlight the desired item then select Edit. Edit the 
item as desired, then select OK. The Cal Item is then updated in the Inventory List. 

Copy  

Print To print a listing of the entire inventory of items, or only the current items displayed 
in the Inventory List, select the 
print command. This activates 
a message dialog that requires 
you to select an option. 
Choose either “Only the items 
displayed in the item inventory 
list” to print the current 
selection’s inventory, or select 
“The ENTIRE list of items in 
the inventory” to print all of 
the Cal Item types. Selecting 
the entire list of items in the inventory prints all Cal Items in the database, which 
may require considerable time if the database is large.  

Delete To delete a Cal Item, highlight the item in the Item Inventory List and press Delete. 
Be certain that you really want to delete the item because it will be permanently re-
moved from the list and cannot be undeleted without special access privileges. 

Undelete  

Display deleted 
items 

Include items that have been deleted in the Inventory List. 

6.2.5.2 Creating Cal Items 

Before Cal Items can be added to the Cal Lines in Cal Manager’s graph, they must be cre-
ated and added to the Inventory List.   

To create and add Cal Items to the Inventory List:  

1. From the Inventory menu, select Inventory List.  The Item Inventory List dialog will ap-
pear.   

2. Select a Cal Item Type from the left column.  A list of similar Cal Items will appear in the 
right column, if any have been previously created.   

3. Choose Create.  An empty Cal Item dialog will appear.  

4. Enter a name and description, as well as any item-specific settings.  
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5. Choose OK.  The new Cal Item will appear in the right column of the Inventory List.  

6. To close the Inventory List, choose OK.  

The new Cal Items are now ready to be inserted into Cal Lines.  For more information, see 
Section 6.2.5.4. 

6.2.5.2.1 Item Data page, Cal Item dialog 

The Item Data page is first displayed when opening the Cal Item dialog. The dialog is 
opened when creating a cal item in the inventory list or by double-clicking a cal item in the graph 
to edit it.  It contains item type-specific properties, most of which can be edited.  At a minimum, 
the page will contain a name and description.  The name field must be unique, as this is the pri-
mary identifier for the Cal Item.  (Inventory control systems use Barcode instead of name.)  The 
description field is optional.  The figure shows an Item Data page for a User Processing cal item. 

 
Figure 6-14 - Example Item Configuration Dialog 

Cal Items that are used in the graph multiple times share a single copy of the Item Data.  
For example, if the cal factor for a 6 dB attenuator is changed from –6.1 to –6.2, every occur-
rence of that attenuator in the graph will use the new –6.2 value.  Data entered on the Reduction 
page, however, is unique to each node in the graph.  So, continuing the example, changes to the 6 
dB attenuator’s FOM list will affect only that occurrence of the attenuator. 

6.2.5.2.2 Inventory Data page, Cal Item dialog 

The Cal Item Inventory Data page is used for entering and displaying Cal Item inventory 
data for systems under strict inventory control. Strict inventory control means that each item 
must be uniquely identified by manufacturer/model/serial number and no item may be used more 
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than once in a system configuration graph.  When present, the Inventory Data page is the first 
page of every Cal Item’s interface.  It does not appear in systems without strict inventory control.  

The Inventory Data page is the same for all Cal Items. The first three fields — Serial num-
ber, Manufacturer and Model number— create a unique database key.  When combined, this key 
must be unique to the Cal Item. 

PropID (property identification) and File # are not required as unique identifiers.  

Although not part of the Cal Item’s key, Barcode is a required field.  Each barcode entry 
must be unique.  In inventory-controlled systems, the Barcode is used in place of the Item Name 
to identify the item. 

 

6.2.5.2.3 Reduction page, Cal Item dialog 

The Reduction page of the Cal Item dialog is used to specify post-reduction options for 
each node in the graph.  If the node generates multiple output waveforms / images, each output 
will have its own set of reduction options.  For items that generate a single output, the default 
output waveform name is “Corrected”.   Cal Items that generate multiple waveforms and/or im-
ages will list outputs by name.  Reduction options are only available for Cal Items that have been 
added to the graph.  If a Cal Item is added to the graph multiple times, each occurrence of the 
item has its own set of reduction options. 

 
Figure 6-15 - Cal Item Reduction Tab 
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Item Description 

Output list Lists the available output data objects (waveforms or images) supported by the cur-
rent item.  Most items support a single output called “Corrected”. 

Display When enabled, the resulting, reduced waveform is displayed in the Analyze module 
(if Analyze is running and configured to display reduced data) during reduction. 

Print When enabled, the resulting, reduced waveform is printed from the Analyze mod-
ule (if Analyze is running and configured to accept reduced data) during reduction. 

Archive When enabled, the resulting reduced waveform will be archived to the database. 

FOMs Activates the FOMs dialog, which configures various Figures of Merit.  See the 
discussion immediately below. 

Settings Activates the appropriate Settings dialog, based on the output waveform type se-
lected. Currently, the Mixer item’s waveform types are the only waveforms that 
can be configured. 

Display (Button) Set the display axes limits.  X and Y 
Axis limits may be independently as-
signed to auto adjustment or fixed, 
user-defined values. 

6.2.5.2.3.1 FOMs page 
The FOMs page configures Figures of Merit for the current Cal Item. FOMs are metrics 

derived or computed from the graph node’s output data. FOMs are archived with the data and 
displayed on the waveform in the Analyze module.  See Appendix C – Figures of Merit (Foms) 
for a complete description of FOMs. 
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Figure 6-16 - FOMs Configuration 

Item Description 

Available FOMs List of available FOMs. To add a FOM to the reduction waveform, highlight the de-
sired name in this list, then select Add FOM .  

Add FOM  Add the currently selected FOM name to the Selected FOMs list. 

Selected FOMs Listing of selected FOMs.  

Min The minimum acceptable value for the highlighted FOM in Selected FOMs. 

Max The maximum acceptable value for the highlighted FOM in Selected FOMs. 

FOM parameters  Specific settings for the highlighted FOM in Selected FOMs.. 

To specify and configure a FOM, highlight the desired FOM from the list of Available 
FOMs, then select Add Fom  to add the FOM to the Selected FOMs list.  The FOM is moved 
from the available list to the Selected FOMs list; each FOM may be selected only once. 

To delete a FOM from the Display FOMs list, highlight it and press the [Del] key or the 
Delete button. It then will be removed from the Selected FOMs list and added back to the avail-
able list. 

Each FOM type defines different parameters. These parameters may be entered when the 
FOM is created (added to the Display FOMs list), or may be edited when the FOM in the Display 
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FOM List is highlighted. The edited data is accepted when the dialog is dismissed or when an-
other FOM is selected. 

To edit the min, max and FOM-specific parameters, click on a FOM in the Selected list.  
The min and max values are available for all selected waveform FOMs, but need not be entered.  
If they are entered and the computed FOM value falls outside the specified limits, the waveform 
is marked “out of spec”.  Out-of-spec waveforms are displayed with a yellow background in 
Analyze. To disable use of the min and max limits, set both values to 0.   

6.2.5.2.3.2 Curve dialog 
Many Cal Items are characterized by a function, such as gain vs. frequency.  The Curve 

dialog configures this type of characterization for a Cal Item. This dialog can be accessed 
through the Curve button on the Item Data page for such Cal Items.  A curve can be either a 
polynomial value (up to tenth-order), or an actual calibration waveform produced specifically to 
characterize the item. 

 
Figure 6-17 - Cal Item Curve Configuration – Polynomial Configuration. 

Item Description 

Polynomial When selected, activates the Polynomial curve interface. The defined polynomial then 
is used to characterize the Cal Item during reduction.  
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dB The polynomial can be a single value (power == x^0), or it can be a tenth-order poly-
nomial. To create the polynomial, enter the dB value in the dB field. Next, select the 
Power (x^0 .. x^10). Finally, select Accept to add the current dB value to the total 
polynomial. The Current Polynomial box displays the current polynomial definition. 
Note: if creating a value other than a first order polynomial, the order of entry does not 
matter. That is, x^5 can be entered before x^2, etc. The program will create the poly-
nomial properly (f(x) = -12.5 – 0.2x + 0.03x^2…). Values may be altered simply by 
entering a new dB value, selecting the proper Power value and selecting Accept. 

Accept Enters the current dB value with the current Power Value into the polynomial. 

Power Current polynomial power of x. 

Current  

Polynomial 

The specified polynomial. 

Waveform When selected, activates the Waveform curve interface. Displays the expected units 
and the currently selected waveform. 

Get Raw Select a Raw waveform from the database. 

Get Processed Select a Processed waveform from the database. 

File Import Import a waveform file from the disk. 

Polynomial curve specifications are typically used for items that have a relatively flat or 
linear response over the operational frequency range, although higher order polynomials are sup-
ported.  Note that the standard units for polynomials are dB vs. GHz.  The use of GHz instead of 
Hz removes the need for excessively small scaling factors for the high-order terms.  Also note 
that most items use gain vs. frequency, which means that attenuation is specified as a negative 
value.  For example, the cal factor for a 6 dB attenuator would be –6. 

If a characterization waveform has been created for the Cal Item with a network analyzer 
or other instrument, the waveform can be directly assigned to characterize the Cal Item.  The 
Waveform view of the Curve Specification dialog displays the current waveform, and allows se-
lection of a new waveform.  If you select Raw or Processed, a retrieve file dialog will appear for 
choosing a waveform from the database.  If you select File Import, an Open File dialog will ap-
pear for choosing a data file to import.  Once the file is selected, the Waveform Import Titles dia-
log will appear, that allows you to enter axis titles and units.  This version of the file importer 
supports only comma-separated ASCII data without header information.  Magnitude-only files 
should contain x, y pairs; real / imaginary and magnitude / phase files should contain x, y, z tri-
ples.  To import additional data formats, import the file in Archive, then select the imported 
waveform using the Processed button in the Curve Specification dialog.  Note that the standard 
units for waveform characterization files are dB vs. Hz.  Some components use other units, so be 
sure to check the expected units text at the top of the Curve Specification dialog.   
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Figure 6-18 - Cal Item Curve Configuration – Waveform Configuration. 

If Polynomial is selected and no polynomial is defined, the calibration factor will be zero. 
If Waveform is selected and none is assigned, then the curve again defaults to a polynomial 
value of zero. A zero value is acceptable, but the item will be considered one that does not alter 
the signal.  

6.2.5.3 Printing the Cal Item inventory 

Printing Cal Items is available only from the Inventory List dialog of the Inventory menu.  
You can either print the inventory of Cal Items by type or print the entire inventory of Cal Items.  

To print the Cal Item inventory:  

1. Open the Inventory List by selecting it from the Inventory | Inventory List…  menu.   

2. If you want to print the inventory of only one type of Cal Item, select the type from the 
left column.   

3. Choose Print.  The Inventory Printing dialog will appear. 

4. Select whether the inventory for a single type of Cal Item should be printed, or if the en-
tire inventory of Cal Items should be printed.  

5. Choose OK to continue, or Cancel to abandon the printing. If OK is selected, the standard 
Print dialog will appear. 

6. Make any changes that may be necessary to the print settings, then choose OK. 

7. Choose OK to close the Inventory List. 



                  

DAAAC 4.0 User’s Manual   136

6.2.5.4 Inserting Cal Items 

Cal Items can be added to the right or left of other Cal Item nodes in the graph, but only to 
the right of channel nodes. Two methods are available for inserting Cal Items into CalMan’s 
graph: the main Inventory List, and Drag-and-Drop Inventory List.  

From within the graph, the Inventory List inserts a single Cal Item to either side of other 
Cal Items, or to the right of channels.  

To add a Cal Item to the graph: 

1. Right-click the Cal Item beside which the new Cal Item should be inserted. A popup 
menu will appear.  

2. Select either Insert new item... command. The Inventory List will appear.  

3. Select the type of Cal Item from the left column, then a specific Cal Item from the right 
column.  

4. Choose OK.  The selected Cal Item will appear in the graph. 

An alternate method is to use the Drag-and-Drop Inventory List. Unlike the regular Inven-
tory List, this list is used only for adding items to the graph; items cannot be created, edited or 
deleted from the Drag and Drop list.   

Some Cal Items require additional information before they can be inserted into the graph. 
When adding Splitters or Coax-Switches, CalMan will ask you to select an output port. This port 
will be linked to the Cal Item beside which the new Cal Item is to be inserted. Likewise, an input 
port must be selected for Cal Items that are attached to the right of Adders.  See section Appen-
dix E, Section 5.3 for more information. 

6.2.5.4.1 Using the Drag and Drop Inventory List 

Once the Cal Items are created with the Inventory List dialog, they can be added to Cal 
Lines with the Drag-and-Drop Inventory List.  

The Inventory | Drag and Drop Inventory List… dialog inserts Cal Items into Cal Man-
ager’s graph by “dragging” them from the list, then “dropping” them on top of other Cal Items in 
the graph. The new Cal Item then is inserted to the right of the target Cal Item. 

This interface is much more efficient for inserting numerous Cal Items when the Cal Items 
have already been created and configured from the main Inventory List. 

The Drag and Drop Inventory List differs significantly from the main Inventory List.  First, 
once the Drag and Drop Inventory List is opened, it can remain open while other parts of 
DAAAC™ are used.  Also, Cal Items are dragged from the dialog onto the graph to be inserted. 
The list of Cal Items (on the right) displays only the item’s name and the description fields.  De-
scription fields are not filled in until the item is clicked on in the list. 



                  

DAAAC 4.0 User’s Manual   137

 
Figure 6-19 - Drag-and-Drop Item Insertion Dialog. 

Item Description 

Left List Lists the Cal Item types supported by the current DAAAC™ installation.  

Right List Current inventory of all cal items of the type selected in the left-side list. 

To add a Cal Items with the Drag and Drop Inventory List: 

1. Using the Scroll bars, position the graph so that the Cal Item’s intended drop position is 
visible. The graph cannot be scrolled while dragging and dropping a Cal Item with the 
mouse. 

2. Open the Drag and Drop Inventory List by selecting it from the Inventory menu, then 
move it to a convenient location that does not cover the destination Cal Line.  

3. Highlight the Cal Item type in the left column. A list of specific Cal Items will be dis-
played in the right column.  

4. Click on and hold the specific Cal Item in the right list with the left mouse button, then 
drag it to the drop position in the graph.  The mouse pointer will change into a standard 
Window’s arrow, plus the Cal Item icon.  

5. Drop the Cal Item onto an existing node. The tip of the mouse pointer’s arrow is the cen-
ter of the drop point, and it must be within a Cal Item node’s boundary for the drop to be 
valid. The new item will always be inserted to the right of this target Cal Item. 

6. When done adding Cal Items to the graph, close the Drag and Drop Inventory List by 
clicking its Close box in the top-right corner.   

When running in networked mode, a separate Drag and Drop Inventory List must be 
opened for each graph that will have Cal Items added. For example, when two stations are open, 
a separate inventory dialog must be opened for each. Also, when dragging items out of the win-
dow assigned to this dialog, the pointer will change to a circle to indicate dropping will not be 
allowed. The pointer with the Cal Item icon indicates that the current window is valid. 

6.2.5.5 Copying and Moving Cal Items 

Cal Items can be copied or moved from one Cal Line to another, but some restrictions ap-
ply. Strict inventoried systems may copy only those few Cal Item types that are not under inven-



                  

DAAAC 4.0 User’s Manual   138

tory control.  These are the Combine, Overlay and User-Process Cal Items. These may be copied 
only if they are last components in the Cal Line. If an inventoried item follows a Combine or 
User-Process Cal Item, then the line may not be copied. For all systems, Cal Items or Cal Lines 
may be copied only to other Cal Lines. 

To copy or move Cal Items individually or as a group:  

1. Use the mouse to drag a selection box around the Cal Item—or a series of Cal Items 
within a single Cal Line—to select it/them.  When you release the mouse button, the se-
lected Cal Items will be highlighted.  

2. With the left mouse button, click into and drag the selected Cal Items to the location 
where they should be copied.  When you release the mouse button, a popup menu will 
appear beside the cursor.  

3. Choose Copy or Move.  Choosing Cancel will abort the copy or move. 

If any Cal Items that are moved include Multi-port nodes – or are attached to Multi-port 
Cal Items – any links to the Multi-port items will be broken.  See section Appendix E, Section 
5.3 for more information on Multi-port items. 

An alternate method of copying or moving Cal Items is to use the keyboard.  Cal Items can 
be selected with the arrow keys. Holding the [Shift] key selects a range of Cal Items.  Once the 
Cal Items are selected, press [Control]+[C] or select Copy from the Edit menu to copy the Cal 
Items to the computer’s Clipboard.  Scroll the graph to the destination, then press [Control]+[V] 
to paste copied Cal Items or [Control]+[X] to move the Cal Items to the new location.   

For more information, see Section 6.2.4.4. 

6.2.5.6 Editing Cal Items 

After a Cal Item is placed in Cal Manager’s graph, most of its properties can be edited.  
However, for strict inventoried systems, inventory data may not be changed.    

To edit a Cal Item: 

1. Double-click the Cal Item node in the graph, or press [Enter] if it is active and high-
lighted.  The appropriate Cal Item dialog will appear.  Make the required changes. (Refer 
to CalMan’s on-line help for documentation on item-specific controls.) 

2. Choose OK to implement the changes, or Cancel to abandon the changes.   

A Cal Item’s settings are also available from the Inventory List by selecting it from right-
hand column, then choosing Edit.  

Some Cal Item settings cannot be changed after the item is created. For example, the num-
ber of ports for Multi-Port Cal Items can only be specified when the item is created. Also, the 
direction of the signal (multi-in/multi-out) may not be changed for Multi-Port Cal Items once 
placed in the graph. Finally, the attenuator’s type (inline or rotary) may not be changed from the 
type specified when it was created.  Most other properties for other items may be changed from 
the original settings at any time.  
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6.2.5.7 Deleting Cal Items 

Cal Items can be deleted either individually or as a group within a Cal Line. To delete a 
Cal Item:  

1. Select the Cal Item or group of Cal Items to be deleted by dragging a selection box 
around the Cal Items to be deleted.  They will be highlight to indicate that they are 
marked for deletion.   

2. Click any Cal Item in the series of selected Cal Items and press the [Delete] key, or chose 
Delete from the Edit menu.  A confirmation dialog box will appear.   

3. Select Yes to remove all selected Cal Items, No to remove only the currently active Cal 
Item, or Cancel to abort the deletion without making changes to the graph. 

An alternate method is to click inside the block of highlighted Cal Items with the right 
mouse button to activate the pop-up menu, then select Delete from the pop-up menu. 

When a Cal Item is deleted, it is returned to the Inventory List for use later.  Likewise, 
channels that have been deleted become available again from the list of Cal Lines in the Cal 
Lines dialog. 

6.2.5.8 Types of Cal Items 

CalMan supports three general categories of Cal Items – Waveform Reduction, Image Re-
duction and No Reduction.  As the names imply, Waveform items operate on waveform and sin-
gle-point data; Image items operate on image data; No Reduction items are for signal line docu-
mentation and do not support reduction.  The item types currently supported under each category 
are shown below.  Appendix E – Cal Items presents each of the Cal Items in detail. 

 

Waveform Image No reduction 

 Antenna  FROG  Bdot 

 Attenuator  Image Branch  BiasT 

 Balun  Image Combine  BPM 

 Cable  Image Divider  CVR 

 Coax Switch  Image Process  Delay/Phase 

 Combine  Image to Contour  Edot 

 Coupler  Image to Waveform  Feed through 

 Crystal  ND Filter  Reference  
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 Filter 
 

 Terminator 

 Free Space 
 

  Transformer 

 Integrator 
 

 Volt Divider  

 Mixer 
  

 Multi-port 
  

 Overlay 
  

 Probe 
  

 Sensor 
  

 Sensor Offset 
  

 SPIDER 
  

 User Process 
  

Waveform Branch 
  

Descriptions of the specific controls for each item type can be found in CalMan’s on-line 
help or in Appendix E – Cal Items.  Press F1 while the Cal Item interface is active to view the 
help for that item.  Cal Items with special abilities or additional configuration requirements are 
discussed in the following sections. 

6.3 Cal Manager Toolbar 

The toolbar is displayed across the top of the Cal Manager’s window, below the menu bar. 
The toolbar provides quick access to many of Cal Manager’s features.  
Click To 

 Switch to Acquire. 

 Switch to Archive. 

 Switch to Analyze. 

 Add, delete, or checkout Cal Items from the Inventory List. 
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 Search the graph for specific Cal Items. 

 Select a Station with which to create a new graph of the test set-up. 

 Insert a new Cal Line in the graph.  

 Show Cal Manager’s program information. 

 Start Cal Manager’s online help. 

6.4 Status Bar 

The status bar at the bottom of the Cal Manager window displays information about Cal 
Manager current operation. To display or hide the status bar, use the Status Bar command in the 
View menu. 

The left-most area of the status bar describes the current menu actions. This area also 
shows messages that describe the actions of toolbar buttons when they are pressed. 

The right-most status bar area displays the graph row and column number of the compo-
nent under the mouse pointer.  

 

Figure 6-20 - Status Bar 

6.5 Cal Manager menus 

6.5.1 File menu  

Cal Manager’s File menu offers the following commands: 

Item Description 

Print Graph Items  Prints a tabular listing of all components in the graph grouped by instrument, 
channels, and individual Cal Lines attached to each channel. The fields listed for 
each Cal Item are type, barcode or name, description, delay and calibration fac-
tor.  

DXF Export Graph Creates a graphics file of Cal Manager’s graph in DXF format. Item information, 
including barcode (or name), is listed.  

File Export Graph 
Items (Entire Graph) 

 

Exit Closes Cal Manager.  



                  

DAAAC 4.0 User’s Manual   142

6.5.2 Tasks menu 
This menu simply lists the Archive, Acquire and Analyze modules, allowing the user to 

switch to (and, if necessary, start) the selected module.  This mirrors the module options in the 
toolbar. 

6.5.3 Edit menu 

Entries in the Edit menu operate on one or more Cal Man nodes that have been selected by 
rubber banding the items.  To do this, click the mouse in the empty graph space above and to the 
left of the left-most item and drag the mouse to the empty graph space below and to the right of 
the right-most item.  This encloses the item group in a rectangle called a rubber band.  Releasing 
the mouse selects all enclosed items as a group.  (Only items on a single Cal Line can be rubber 
banded.) Rubber banding highlights the grouped items in yellow, by default.  After rubber band-
ing the desired nodes, the Edit menu items can also be accessed by right-clicking and selecting 
from the popup menu.  Note that actions performed in the Edit menu cannot be undone.   The 
Edit menu includes the following functions: 
Item Description 

Cut Deprecated – See the Move option.  Deletes data from the document and moves it to the clip-
board. If no data is currently selected, this command is unavailable. Data cut to the clipboard 
replaces data previously stored there.  <Ctrl-X> is a shortcut to the option. 

Copy Copies data from the document to the clipboard.  It is unavailable if no data has been selected. 
Data copied to the clipboard replaces its previous contents. <Ctrl-C> is the shortcut. 

Paste Pastes data from the clipboard into the document at the insertion point. This is unavailable if 
the clipboard is empty.  Use <Ctrl-V> for a shortcut. 

Move Not Implemented 

Delete Removes the selected Cal Items or active item from the graph. This option will allow the user 
to choose between deleting all rubber banded items or deleting only the single selected node.  
The selected node is highlighted in green, by default.  Selection can also be deleted with the 
<Del> key. 

Clear Clears the rubber-banded selection. 

6.5.4 Preferences menu. 

The Preferences menu controls CalMan’s visual display. 

Graph Display… Opens the Graph Display dialog that allows users to customize the appearance of the 
graph. The dialog may also be called up by right-clicking in an empty area of the 
graph and selecting Graph Display… from the popup menu.  See Appendix B, Sec-
tion 2.3.3 for details regarding the dialog. 

Barcode Print 
Setup… 

Activates a dialog that allows the user to configure the print format of barcodes and 
print test barcodes.  The dialog is detailed in Appendix B, Section 2.3.4. 
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New Item 

Defaults… 

This option opens a dialog that allows the user to specify the default values for pa-
rameters that are common to all Cal items when a new node is added to the graph. 
The Item Reduction Defaults dialog sets the default settings that each new Cal Item 
will have when first added to Cal Manager’s graph. These options can be changed at 
any time after the Cal Items are in the graph by activating their Reduction page from 
the Cal Item dialog. The Reduction page is also accessible from the Global Reduc-
tion Options Map.  Details of the dialog are found in Appendix B, Section 2.3.5. 

Tool Bar Making this selection toggles between showing and hiding the toolbar 

Status Bar Making this selection toggles between showing and hiding the status bar 

Large Icons Making this selection toggles between showing larger or smaller icons on the tool-
bar. 

6.5.5 Inventory menu. 

The Inventory menu contains commands that activate inventory list dialogs. 

Inventory List Activates the main inventory list, which creates, edits, deletes and prints Cal Items. 
Also, the Inventory List can be activated from the graph and used for insertion items 
into the graph (right-click a Cal Item to activate the popup menu and select the direction 
of insertion—left or right).  See section 6.2.5.1or Appendix B, Section 2.3.6. 

Drag and Drop 
Inventory List 

Activates a dialog for inserting Cal Items into the graph by dragging the item from the 
list onto the graph. This is more efficient than the standard Inventory List when the Cal 
Items are already created and many Cal Items are to be added at a time to the graph. See 
section 6.2.5.4.1or Appendix B, Section 2.3.7. 

6.5.6 Graph menu 

The Graph menu contains commands that control the stations and the Cal lines within each station.  

Stations… The Stations menu activates the Stations dialog for creating, loading and selecting a station 
graph.  Select Stations opens the Stations dialog to select a station and begin a graph. To 
open or change a station, simply select the station from the list then select OK.  Cancel will 
dismiss the Stations dialog without changing the graph.  If operating in standalone mode, 
only one station is available.  See Appendix B, Section 2.3.8. 

Lines… This option opens a dialog that maps the instruments and channels available to a given sta-
tion.  The map can be used to insert new lines into the Cal graph for channels not yet as-
signed Cal lines.  Section Appendix B, Section 2.3.9. 

6.5.7 Reduction Menu 
Reduction menu 

Item Description 

Global Selection Map… Opens the Global Reduction Options Map. 

Global Parameters… Entries in this menu enable or disable auto reduction of selected Cal Lines 
and affect CalMan behavior during reduction. See Appendix B, Section 
2.3.11. 

Off-line Reduction… Display the toolbar’s icons in large and regular sizes. 
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6.5.7.1 Global Reduction Options Map 

The Global Reduction Options Map configures reduction options for CalMan’s current 
graph. Each entry in this dialog contains the same reduction functions that can be found in each 
Cal Item node’s reduction page and in each channel node’s reduction page. Use this interface 
when changes are necessary for many Cal Items, or to view the entire reduction configuration. 

This reduction options map displays all instruments, Cal Lines and Cal Items attached to 
each channel. Line reduction can be toggled on and off, and output options for each line can be 
set. The entire graph’s display/print/archive options can be set or cleared at one time.  

The instrument is displayed in the first column. There are no options for the instrument en-
try.  

Each channel is displayed in the second column. The first row for each channel contains a 
Line Reduction check-box, which is the same check-box option contained in the channel’s dia-
log. When checked, reduction will be performed for the entire line. Double-clicking this column 
within the Line Reduction text activates the channel’s reduction dialog.  Any changes made in 
the reduction dialog are updated in the options map when OK is selected. 

Every channel row and every Cal Item row contain a Waveform type. The channel wave-
form name is Raw. Most Cal Items’ waveform type is Corrected. However, some nodes do con-
tain other waveform types. Every channel contains a Display and Print check box—the same op-
tions that are contained in the item’s Reduction page.  

 
Figure 6-21 - Global Reduction Options. 
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All Cal Items attached to the channel are listed after the channel name. Each Cal Item row 
contains the same options: Cal Item (name), Waveform (type) and the waveform output selection 
(Display, Print and Archive columns). If the Cal Item supports more than one waveform type, 
then each type is listed on a separate row and each has its own set of Display, Print and Archive 
check boxes.  

Double-clicking inside the Cal Item name field activates the appropriate Cal Item dialog. 
This is the same dialog that is activated from the graph.  Any changes made in this dialog are en-
acted when OK is selected. Likewise, changes made in the Reduction page of the Cal Item dialog 
are updated in the Global Reduction Options Map when OK is selected. 

A Search function at the bottom left opens a dialog that searches the map names of instru-
ments, channels or Cal Items.  If found, the row containing the target string will be highlighted. 

The buttons beneath the Cal Item name column set or clear all channel-line reduction op-
tions.  The buttons beneath each output column (display, print and archive) set or clear each col-
umn.  Set All sets all output types in the map and Clear All clears all of them. 

Select OK when you have made the required modifications.  All reduction information is 
then updated in the graph. Selecting Cancel abandons any changes made.  If any settings in any 
of the Cal Item dialogs have been altered (by double-clicking the Cal Item column), then Cancel 
will be disabled and all changes become permanent. 

6.5.7.1.1 Searching the Global Reduction Options Map 

To search the Global Reduction Options Map:  

1. Select the Search button.  The Search Global Reduction Options Map dialog will open.   

2. Select the field type to search (instrument, channel, or item).  In the Search String field, 
enter the text to search for.  

3. Select Find.  If the item is found, its first occurrence will be highlighted in the 
map.  Choose OK when done searching. 

6.5.7.2 Off-line Reduction 

Automated reduction during the acquisition sequence is referred to as “on-line” reduction.  
CalMan can also be used to perform “off-line” reduction at any time, using any raw data in the 
database.   

To perform an off-line reduction: 

1. Select the Reduction | Off-line reduction… menu item.   

2. The raw waveform selection dialog will appear.  Select the waveforms and images to 
reduce.  Data can be selected from multiple shots.  Any selected data that does not have a 
corresponding Cal Line will be ignored. 

3. Select OK in the selection dialog.  CalMan will begin reducing the selected data.  
CalMan’s status bar will display the current channel and shot being reduced.  When all 
reduction complete, the reduced data will be transmitted to the database and the Analyze 
module. 
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Note that the off-line reduction always uses the current Cal Line definitions to reduce the 
data.  If you want to reduce data with historic definitions, the historic configuration must be re-
stored before the reduction operation.  See Section 3.4 for information on how to restore a his-
toric configuration.   

6.5.8 Tools menu 

Cal Manager’s Tools menu provides a variety of useful services.  

Item Description 

Search Opens the Search dialog described in Appendix B, Section 2.3.12. 

Line Summary Alters the CalMan display to show detailed summaries of each item in the cal 
line.  (See Section 2.3.13.) 

Conversions A simple calculator that allows conversion of distances from one set of units to 
another (Ex. 196 ft -> 5974.08 cm) and from scalar values to dB or dB to sca-
lar in both power and voltage. Appendix B, Section 2.3.14. 
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7 Analyze  
 
 

7.1 Analyze Overview 

DAAAC’s Analyze module is used to view, analyze and manipulate waveform and image 
data acquired during acquisitions, processed during reduction or imported from disk.  Raw data 
is sent to Analyze during automated data acquisition from Acquire and reduced data is sent from 
Cal Manager if automatic data reduction is enabled.  Data can be imported directly from a file, 
processed or copied, then exported to a file or saved in DAAAC’s database. Database data can 
also be re-processed, copied or saved to DAAAC’s database. 

Analyze uses individual windows to display waveforms, data tables and images. Each 
window can be resized, tiled, minimized or maximized.  Within each window, waveforms can be 
edited with various analysis functions.  

Raw acquisition data contains information about the system configuration.  This configura-
tion data includes the test name, test description, acquisition settings and the instrument and its 
settings from the test that created the waveform.  All data stored with, or linked to, the waveform 
data can be viewed in Analyze.   

Any number of waveforms can be retrieved from the database and viewed, processed, 
overlaid, combined with other waveforms and otherwise analyzed.  Waveform and image data 
can be analyzed with the Cursors operations (view individual points/pixels and remove and/or 
expand parts of the waveform), processed with Process functions (arithmetic, calculus, trans-
form, smoothing, filtering, trigonometric, hyperbolic and other functions), overlaid with other 
data and combined by applying arithmetic functions.  

 



                  

DAAAC 4.0 User’s Manual   148

 
Figure 7-1 - Examples of Waveform and Image Data displayed in the Analyze module. 

7.2 Working with Analyze 

7.2.1 Preparing for acquisition  

Analyze’s primary function is to display waveform and image data.  If desired, Analyze 
can display and print this data as it is acquired.  

Analyze must be running to display and print incoming, newly acquired data.  Acquire will 
not start Analyze.  Before acquisition, Acquire’s display and print options should be configured 
to suit the desired output format.  Open the Acquisition Configuration dialog to select what and 
how data is displayed and printed (see Appendix B, Section 2.4.15). 

During acquisition, Acquire reads the newly acquired data from the instruments and noti-
fies Analyze to prepare to receive the data.  Raw data is then transmitted to Analyze for direct 
display and printing.  If CalMan is active and configured for reduction, then it will perform data 

Networked Operation: to participate in a networked acquisition, an Analysis computer must be located 
on the same subnet and must be connected to the same database as the other DAAAC computers.   
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reduction and transmit the reduced data to Analyze.  Raw and processed data then can be ana-
lyzed and edited, copied and saved back to the database. 

7.2.2 Retrieving waveforms and images 

Raw and processed waveforms and images can be retrieved and displayed from the active 
database.  With the Select Waveforms dialog, waveforms can be found either by Station, by Test 
or by specifying search criteria.  See Section 3.4, for more information. 

To retrieve waveforms and images:  

1. From Analyze’s File menu, select Retrieve, then either Raw or Processed.  The Se-
lect Waveforms dialog will appear.  

 
Figure 7-2 - Select Waveforms Dialog 

2. Select either a Station or Test from the directory in the left pane.  The available wave-
forms and images will be displayed in the right pane.  By default, this data will be 
displayed in order of time and date; however, it also can be sorted by Burst Shot, 
Name, Description or other category by selecting the column heading with the mouse.  

3. Select the desired waveforms in the right pane.  Use [Shift] to select a contiguous se-
ries of waveforms, or [Ctrl] to select a discontinuous series.   

4. Select the option to retrieve any associated raw or processed waveforms if these are 
desired.   

5. Choose OK. 
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Shortcuts 

Toolbar:  to retrieve raw waveforms and images.   to retrieve processed data.  

7.2.3 Combining waveforms or images 

To combine waveforms displayed in Analyze:  

1. Activate the first waveform by clicking on it.  

2. Open the Combine Waveforms dialog by selecting the toolbar button, pressing [F7], 
or choosing Combine from the Analysis menu.  

3. Select a function. The title of the first waveform will change to “Selected”. 

4. Click the second waveform (or multiple waveforms for the Average operation).  

5. If applying the Average operation, click outside a waveform (e.g., on the Analyze ti-
tle bar) to end selection. 

6. The result of the math operation will either replace the contents of the active window 
or, if selected, be placed in a new window.  If the operation is Correlate Only, only 
the selected window will be modified. 

7. An analogous interface is available for combining images.  The procedure for com-
bining images data is the same as for waveforms. 

Shortcuts 

Toolbar:  

Keys: [F7] 

7.2.4 Copying waveforms and images 

Waveforms and images can be copied for editing without changing the original.   

To copy a waveform or image:  

1. Select the waveform that should be copied so that it becomes active.   

2. From Analyze’s Window menu, select Copy.  Analyze will create a copy of the origi-
nal waveform.   

The Copy function is also available by right-clicking the waveform or image.   

7.2.5 Creating waveforms 

Analyze can create constant, ramp, step, pulse and other waveforms from parameters en-
tered into the New Waveform dialog.  

To create waveforms:  

1. From Analyze’s File menu, select New.  The New Waveform dialog will appear.  
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Figure 7-3 – Create a User-Specified Waveform. 

 
2. Select the type of waveform from Function in the Waveform Type group.  The avail-

able types are Constant, Ramp, Step, Pulse, Modulated Pulse, Gaussian or Formula. 
3. Enter the x- and y-axis parameters.  
4. Choose Create, then OK.   

 

 
Figure 7-4 - User-Specified Waveform. 

7.2.6 Overlaying waveforms 

Multiple waveforms can be overlaid onto a single plot for comparing data.   

To overlay waveforms: 
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1. From the Analysis menu, select Overlay.  
2. Select the waveforms to be overlaid by clicking within each.  Their titles will change 

to “Selected”.  
3. Click the mouse outside of a waveform, such as on the Analyze title bar or status bar.  

Analyze will open a new waveform plot that overlays all selected waveforms.   

 
Figure 7-5 - Five Overlaid Waveforms. 

Shortcuts 

Toolbar:   

Keys: [F8] 

 [shift] + [F8] automatically overlays all displayed waveforms  

7.2.7 Printing waveforms and images 

Analyze can print one or all currently open and displayed waveforms.  

To print waveforms:  

1. To print a single waveform, click the desired waveform to make it the active wave-
form. 

2. From Analyze’s File menu, select either Print to print the active waveform or select 
Print All to print all open waveforms.  The Print Title dialog will appear.  

3. Select Title, Date and Time in the checkboxes if they should be printed as a header to 
the waveforms, then change the Title, if desired.   

4. Choose OK.  The waveforms will be spooled to the printer chosen in Print Setup.  
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If printing an individual waveform, the Print function is also available by right clicking on 
the waveform.  The print all function prints all displayed waveforms on a single page.  Images 
are always printed one per page. 
Shortcuts 

Toolbar:  

7.2.8 Storing waveforms and images 

Processed and raw waveforms, overlays and images that have been edited with Analyze’s 
utilities can be saved in the database for later applications.  All data stored from Analyze will be 
saved as processed data – including raw data that has not been modified.   

To store data:  

1. Select a displayed waveform, overlay or image so that it is active.   
2. From the File menu, select Store, then either Active to store only the active waveform 

or All to store all open waveforms.  The waveforms will be available for later applica-
tion by using Retrieve | Processed.   

Or 

3. Right-click on a displayed data window and select Store from the pop-up menu. 
Shortcuts 

Toolbar:  

7.2.9 Opening images 

Analyze can open files with many common image formats, including JPEG, Windows 
Bitmap and TIFF.  

To open images: 

1. From the File menu, select Open image.  The Open a File dialog will appear.  
2. Select a file format from Files of type.  
3. Locate and select the image file within the directory to the left.  A preview of the 

image will appear if Enable Preview is checked.   
4. Choose OK. 

7.3 Analyze Toolbar  

Analyze’s toolbar is displayed below the main menu bar. The toolbar provides direct ac-
cess to many of Analyze’s features.  To hide or display the toolbar, choose Toolbar from the 
View menu, or press [Alt]+[V]+[T].   

Click To 

 
Retrieve raw waveforms. 

 
Retrieve processed waveforms. 
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Save all displayed waveforms as processed data. 

 
Print all displayed waveforms and images. 

 
Set the Global Display/Print options for waveforms, overlays and im-
ages.  

 
Copy the active waveform or image. 

 
Cascade the data windows. 

 
Tile the data windows. 

 
Close all windows and empty the data buffer.  This icon is disabled if 
Use Cursors is selected. 

 
Display the previous page of data. 

 
Display the next page of data. 

 
Process the active waveform or image. 

 
Use cursors to examine waveform or image values. 

 
Combine waveforms or images using basic arithmetic. 

 
Overlay waveforms in a single graph. 

 
Configure Analyze to receive acquired and reduced data.  This icon is 
disabled if Work off-line or Use Cursors is selected. 

 
Reset running overlays, as selected in the Acquisition Settings dialog. .  
This icon is disabled if Work off-line or Use Cursors is selected. 

 
Work off-line.  If selected, ignores all acquired and reduced waveform 
and image data transmitted from Acquire and CalMan. 

7.4 Analyze menus 

7.4.1 File menu 

Analyze’s File menu includes the following commands, some of which are available only 
when data is open while others are available only when no data is open: 
Item Description 

New Waveform… New Wavform… activates the New Waveform dialog, used to create a custom 
waveform.  This dialog is also displayed as a property page in the Process Data 
dialog. See Section 7.2.5 for details. 

Retrieve->Raw Retrieves raw waveform data from the database for display and processing in 
Analyze.   
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Retrieve-
>Processed 

Retrieves processed waveform data from the database for display and process-
ing in Analyze. 

Store->Active Stores a copy of the currently active waveform in the database. If the wave-
form already exists, it is NOT replaced, but a second copy is created and 
stored. 

Store->All Stores all displayed waveforms in the database as processed waveforms. If the 
waveforms already exist, they are NOT replaced, but stored in the database as 
copies. 

Import Waveform Imports a waveform from an external file. 

Open Image Opens and displays an external file that contains data in a standard image for-
mat (e.g, TIFF, Windows Bitmap, JPEG). 

Import Image Open a standard windows browser to navigate to an image to be imported into 
Analyze.  Files of type ASCII Z List (*.txt), ASCII Z Array (*.txt), Sensors 
Unlimited Binary (*.img), Imaging Technology Binary (*.img) and Femtosoft 
FROG (*.dat) may be imported. 

Export Open a standard windows browser to navigate to a location and identify a file 
name for the exporting of data.  Waveform data may be exported to a text file 
(*.txt) as columns of X/Y pairs or the Analyze waveform image may be stored 
to a bitmap or JPEG format. 

Screen Capture Selecting this option initiates a process in which the user may select any visi-
ble window on the desktop.  A browser dialog is then opened to allow the im-
age of the window to be saved in bitmap (*.bmp) or JPEG form.   

TWAIN->Acquire  

TWAIN->Select  

Close Closes the active waveform or image.  Analyze does not prompt to save modi-
fied data before closing. Closing a waveform or image without saving it will 
result in lost data. 

Properties Properties displays general and statistical information about the data in the ac-
tive window, as well as allowing the setting of label and display options for the 
data.  General data information and acquisition information are available under 
the General page; parameters and Figures of Merit (FOM) are available under 
the Statistics page; data title and comments and axis titles and units can be set 
under the Labels page; and the plot type and styles can be set under the Dis-
play page.  See Appendix B, Section 2.4.4.1 through Appendix B, Section 
2.4.4.9 for details regarding the Properties dialogs.  

Print Print… spools the selected waveforms to the printer.  Before executing Print, 
Analyze will ask which title should be included, as well as if the date and time 
the waveforms were printed should be included. Analyze can print as many as 
64 waveforms per page, but can print tabular data only on single sheets.  

Print All Print All spools all active waveforms to the printer.  Before executing Print All, 
Analyze will ask which title should be included, as well as if the date and time 
the waveforms were printed should be included. Analyze can print as many as 
64 waveforms per page, but can print tabular data only on single sheets.   
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Print Setup Print Setup opens the standard Windows printer configuration dialog allowing 
the adjustment of such parameters as page orientation, paper size and source 
and which printer to send the document to. 

Exit Exits Analyze 

7.4.1.1 Open Image, File menu 

Open Image activates a file directory dialog for selecting an image file.  The selected im-
age is displayed in a new window.  Supported graphic formats include the following: 

Bitmap (Windows) PCX 
GIF PhotoShop PSD 
JPEG TGA 
MS Paint TIF 
Photo CD Windows Metafile 

 

 
Figure 7-6 - Image Retrieval Browser 

Enable Preview displays a thumbnail of the image selected in the file window. A preview 
of the file is displayed for those formats that support thumbnail displays.  Select File Info to view 
additional information about the image selected in the file window. 

7.4.2 Tasks menu 

The Tasks menu switches execution focus to Acquire, Archive or CalMan.  It causes the 
program to start if it is not already running. 

7.4.3 Edit menu 

The Edit menu provides the following commands: 
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Item Description 

Undo Undo reverses the last operation, if possible.  If Undo is disabled, the last ac-
tion cannot be reversed.  Undo is only enabled when the currently active wave-
form is the waveform to which the last operation was applied. [Ctrl]+[Z] or 
[Alt]+[Backspace] are the shortcuts. 

Cut Cuts the current selection to the Clipboard. Not available in this version of 
DAAAC. 

Copy Copies the current selection to the Clipboard. Not available in this version of 
DAAAC. 

Paste Pastes the contents of the Clipboard into the current document. Not available 
in this version of DAAAC. 

7.4.4 Preferences menu 

The Preferences menu provides the following commands for setting user preferences in Analyze: 

Item Description 

Display Options The Display/Print Options dialog configures the display and print options for 
waveforms, overlays and images. Fields are divided into Global Options – 
those options that will be immediately applied to all displayed items, and New 
Object Defaults – those options that are applied when an item is created for 
display in Analyze.  Most new object defaults can be modified after the object 
is created by selecting Properties from the objects right-click menu.  See Ap-

pendix B, Section 2.4.6 for details. Shortcut:  

Processed FOMs Selects Figures of Merit (FOMs) to be computed for processed data.  Add view 
options moved from the View menu. 

Tools Toggles the presentation of the toolbar in the program window 

Status Bar Toggles the presentation of the status bar in the program window. 

Large Icons Toggles the appearance of the icons on the tool bar between smaller and larger. 

7.4.4.1 Processed FOMs, Preferences menu 

Processed FOMs selects the Figures of Merit that are computed when a manually processed wave-
form is created. The list of computed FOMs determines which FOMs are displayed with the waveforms 
and which FOMs can be searched for when retrieving a manually processed waveform that has been 
stored in the database.  

The Processed FOMs dialog allows the user to select how the specified list of FOMs is applied.  
The specified FOM list can either: 1) replace the existing list; 2) be appended to the existing list; or 3) 
only be used when the data has no existing FOMs.  

FOMs for automatically processed waveforms are selected in Cal Manager (Section 6.2.5.2.3.1).  
FOMs for raw waveforms are selected in Acquire (Section 4.4.2.2). 

Unlike FOM selection in CalMan, most FOMs specified here to not include user-defined parame-
ters.  For those FOMs that do include parameters, the parameter values are not stored in the database with 
the FOM. 
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Figure 7-7 - Analyze FOM Selection. 

7.4.5 Analysis menu 

Analyze’s Analysis menu offers the following commands for processing and examining wave-
forms:  

Item Description 

Process Process activates the Process Data dialog, that applies math operations to the active 
waveform. For overlay waveforms, the operations are applied to the currently se-
lected waveform, which is marked with a yellow triangle in the waveform key.  
See Appendix B, Section 2.4.8.   

The Image Process dialog applies math operations to the active image. It’s layout is 
similar to that of the Waveform Process dialog.   Like the waveform dialog, all op-
erations applied from this interface are applied immediately to the active image.  
Pressing the Cancel button will undo all operations applied while the dialog was 
open.  Appendix B, Section 2.4.9. 

Shortcut: , <F5> 

Cursors Toggles Cursors operations for the detailed examination of the waveform. 

Combine Combines waveforms by applying various math operations.  See Appendix B, 
2.4.10 for details 

Create contour 
plot 

Generates a contour waveform, based on the z values in the active image.  (Image 
Only) 

Visualize… Image data only. 

Overlay Overlays two or more selected waveforms into a single window.  (Waveform Only) 
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Overlay all Overlays all displayed waveform data. (Waveform Only) 

Extract Extracts a single waveform from an Overlay and places its data in a new window. 

Off-line Reduc-
tion 

Off-line Reduction performs data reduction from previously acquired raw wave-
form data (the raw waveform contains configuration data in addition to the wave-
form data that is displayed). One or more raw waveforms (instrument channels) can 
be selected at a time. The reduction is always performed using the current settings 
in Cal Manager, and the data is displayed/printed using the Acquisition settings in 
Analyze (see pages 111 and 166).  To reduce data with historic reduction settings, 
first restore the appropriate configuration by right clicking on the waveform and 
selecting Restore Historic Configuration from the pop-up menu. 

Reduce Processed Reduce processed data, using the signal line information from an instrument chan-
nel. 

Custom Performs custom analysis, including Velocity..., Cal Report..., Antenna Field..., and 
Modulation Stats.. 

Apply Last Op Apply Last Op applies the last waveform processing operation to the active wave-
form. Although the last operation may be applied any number of times, Undo re-
verses only the last application. Shortcut <F4>. 

Macro List This selection open a modeless dialog that lists available macros.  Any number of 
macros can be selected and applied to the selected waveform. Appendix B, Section 
2.4.13. 

Image Adjuster This selection open a modeless dialog that allows the brightness, contrast and 
gamma setting of the selected image to be adjusted. Appendix B, Section 2.4.14. 

7.4.5.1 Cursors, Analysis menu 

Cursors enables the “cursor” operations for the current waveform, which allows examining indi-
vidual waveform point data, and extracting parts of the waveform by setting tags with the mouse cursor. 

When Cursors is activated, the active waveform is maximized and its toolbar is displayed (initially 
on the right side of the window but can be moved anywhere).  The active waveform is maximized, but 
can be reduced or minimized. Also, other waveforms can be activated, but Cursors will continue to oper-
ate on the original waveform until the option is turned off with the main menu or right mouse button 
popup menu. 

A floating dialog is also initially displayed, containing information about the current cursor point 
and general waveform statistics. The cursor point information is also displayed in Analyze’s status bar.  

Waveform statistics are computed from the first point in the waveform to the current position if no 
tags have been placed on the waveform. If a single tag has been placed, the statistics are computed from 
the tag position to the cursor’s current position. If two or more tags have been placed, the statistics are 
computed between Tag 1 and Tag 2. See “Cursor Measurement Selection dialog” below for step-by-step 
instructions on placing measurement tags. 

To close the Cursors position dialog, activate its window by clicking on it, then press [Esc]. The 
main Cursors window will remain on until turned off from the menu or toolbar. 
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Figure 7-8 - Cursor Tracking Information. 

Cursors can be used on raw, processed and overlay waveforms. For overlay waveforms, Cursors 
tracks the currently selected waveform, which is marked with a yellow triangle in the overlay waveform 
key. 

Shortcuts 

Toolbar:  

Keys: [F6] 

7.4.5.1.1 Cursor Measurement Selection dialog 

Within Cursor Operations, the Cursor Measurement Selection feature displays the delta x and delta 
y measurements between tags. The selected measurements are displayed in the measurement list on the 
Cursor Statistic area of the Cursor Operations window and printed in the waveform’s legend when the 
waveform is printed from the Cursor Operations window.  

 
Figure 7-9 - Cursor Measurement Selection Dialog. 

To add a measurement to the displayed list: 

1. Place two (or more) tags on the waveform by clicking on the desired points with the mouse.  
(The keyboard arrow keys also can be used for greater accuracy.) 
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2. Select Setup from the Measure group in the Cursor Operations window.  The Cursor Meas-
urement Selection dialog will appear.  

3. Choose Measurement type.  

4. Select Tag 1 and Tag 2 to define the beginning and ending positions of the measurement.   

5. Choose Insert.  

6. Continue selecting tags for measurements as needed.  

7. Choose OK.   

To delete measurements from the list:   

1. Open the Cursor Measurement Selection window.  

2. Select the measurement to be deleted from the left list.  

3. Choose Delete. To remove all listed measurements, choose Clear All. 

4. Choose OK. 

If any tag used to compute a measurement is deleted, the measurement will be automatically re-
moved from the list. 

To print the waveform with the tags and measurements:  

1. Place the tags on the waveform and define the measurements.  

2. Select Print from the File menu or from the pop-up menu available by clicking on the wave-
form with the right mouse button.   

3. Make any necessary changes to the waveform’s print title, date, and time options.  

4. Choose OK.   

Selecting Print All from the File menu or the Toolbar prints all waveforms that are open in Analyze, 
including any tags that are defined in Cursor Operations.  Print All will not include the legend of tags and 
measurements however. 

7.4.5.1.2 Zooming, Cursor View functions 

Zoom In enlarges the selected region. The waveform is re-scaled using the first and second tags as 
the waveform x-axis limits. 

Zoom Out shrinks to the previously selected region. The waveform is rescaled using the previous 
set of tags as the waveform x-axis limits. 

Zoom Off displays the entire waveform. The waveform is re-scaled using the minimum and maxi-
mum x-axis values as the waveform limits. 

7.4.5.1.3 Zeroing, Cursor Edit functions 

Zero Between sets the y values of all points that fall between first and second tags to zero. Zero 
Outside sets the y values of all points outside the region between the first and second tags to zero. Zero 
Left sets the y values of all points left of the first tag to zero. Zero Right sets the y values of all points 
right of the first tag to zero.   

For all methods of zeroing, the tag points are not modified. 
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7.4.5.1.4 Deleting, Cursor Edit functions 

Delete Between removes all points that fall between first and second tags. Delete Outside removes 
all points outside the region between the first and second tags. Delete Left removes all points left of the 
first tag.  Delete Right removes all points right of the first tag.  

For all methods of deleting, the tag points are not modified. 

7.4.5.2 Overlay and Overlay All, Analysis menu 

The Overlay function plots multiple waveforms in a single window. This function is normally used 
to make qualitative and quantitative comparisons of related waveforms. 

To create an overlay waveform, select this operation, then click on each waveform to be added to 
the overlaid window. Click outside of the waveform (e.g., on the Analyze title bar) to end selection. Al-
ternatively, you can overlay all displayed waveforms by selecting Analysis | Overlay All from the menu.  
A new window is then created that contains the selected waveforms, and a color-coded legend.  The ini-
tial display properties are determined by the settings in Preferences | Display Options, Overlay tab (see 
Section Appendix B, Section 2.4.4.9).  Display settings may be changed after the overlay is created by 
right-clicking on the overlay and selecting Properties from the menu. 

The first waveform in the overlay is the active waveform and is marked with a yellow triangle in 
the legend. To make a different waveform active, use the left mouse button to click its entry in the legend.  
The active waveform is always drawn on top of all other waveforms.  Cursors and Process operations ap-
ply to the active waveform.  

Some operations, such as Combine, cannot be performed on overlay waveforms. 

Overlay All automatically creates a single plot that overlays all waveforms in Analysis.  No user 
selection is necessary. 

Shortcuts 

Toolbar:  

Keys: [F8],  [Shift+F8] (overlay all) 



                  

DAAAC 4.0 User’s Manual   163

7.4.5.3 Custom menu, Analysis menu 

The Custom submenu of the Analysis menu provides the following specialized analysis functions: 

Item Description 

Velocity The Velocity Plot Generation dialog plots velocity versus time, given pin clo-
sures versus time. The input waveform is assumed to be a series of pins versus 
time, where each pin is represented by a voltage spike. 

Level History…  

Cable Cal Cable Cal activates a dialog that facilitates the creation of a waveform for use 
as cable characterization curve with CalMan’s data reduction operations. Sev-
eral common cable types are supported. 

When OK is selected, the waveform is created; however, it is only displayed. 
To store the waveform in the current database, select File | Store | Active.  If 
this procedure is not followed, the waveform will not be saved in the database 
and will not be available to other modules. 

Modulation Stats Modulation Stats is not available in this version of DAAAC™. 

FOM v Shot Plot the selected FOM data ordered by shot number.   

Data v Shot The Data v Shot dialog applies analysis routines that plot imported, tabular text 
data to show trends and relationships over a series of shots or range of num-
bers. The shot number (or any number) is used as the independent x-axis value, 
and the value extracted from the column of data is the dependent y-axis vari-
able. 

Fom v Data Plot the selected FOM data with corresponding imported columnar data. 

FTIR preproc-
ess… 

Adjust cycle to cycle variation on FTIR waveforms, based on a reference 
waveform. 

Data Miner…  

Waveform 
Builder… 

 

Image Builder…  

Due to their highly custom nature and limited application, these features are keyed and do 
not appear in most systems.  With a few exceptions, no further discussion is provided in this 
document.  Please see the online help for more information. 

7.4.5.3.1 Fom v Shot, Custom menu 

FOM v Shot plots a processed waveform’s FOM values to view trends and relationships 
over a series of shots or bursts. The FOMs are Cal Item FOMs computed during data reduction in 
Cal Manager. The shot or burst number is used as the independent x-axis value, and the FOM 
value is the dependent y-axis variable.  

The entire database (the current database) is searched and all matching waveform names 
and associated FOMs are extracted and plotted as waveforms. Cursor and Process functions then 
may be applied to further analyze the plot. 
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The waveform name (processed waveform for a Cal Item) must be in the database, and the 
FOM name must have been computed already and stored with the processed waveform.  

Any number of FOMs may be selected for the given waveform name (no duplicates), and 
any number of waveform names may be added to the FOMs to plot list. The output may be di-
rected to an Overlay where each separate FOM is normalized and stacked one on top of the 
other. Alternatively, all can be overlaid without normalization in one window, or each FOM can 
be plotted in separate windows.  Caution: too many FOMs plotted in an overlaid window can 
result in a plot that is difficult to read and interpret. If many FOMs are to be plotted at one time, 
they should be placed in separate windows (select Separate windows from the Waveform type 
group). 

A filter may be applied to limit the FOMs to a range of shots or bursts. Also, the x-axis 
may be either the shot or burst number, or it can be numbered sequentially from 1-n shots or 
bursts. 

 
Figure 7-10 - FOM vs Shot Configuration. 

When plotting FOMs by burst number, the number of shots per burst determines how the 
FOM is plotted. Analyze determines the number of shots in a burst by testing the first burst (as 
defined by the burst filter), and then numbers the x-axis title as a percentage. For example, if the 
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number of shots per burst is set to four and the first burst to plot is one, then the first four shots 
are plotted as 1.00, 1.25, 1.50, and 1.75. Caution: If the number of shots per burst changes within 
the selected burst range, then how Analyze plots the FOM is undetermined. Therefore, the burst 
filter should always be set to include only those bursts that contain the same number of shots. If 
uncertain about the number of shots per burst in a range of bursts or for all bursts, send the data 
to a text file (from the Destination group, select Output to text file). This file listing displays shot 
number, FOM name, FOM value, burst and shot in burst. 
 
Search attributes Defines the search criteria 

Wfm Name Waveform name to find in the database. This is the name of a processed 
waveform; raw waveforms are not used. 

Fom Name FOM-name listing of available FOMs. The ones selected must already 
have been computed for the given waveform name (during data reduction 
in Cal Manager). More than one FOM name can be associated with a 
waveform name. 

Add to list Add the waveform name and FOM to the list. 
 
Waveform type Results go to Overlays or individual windows. 

Stack in one window All FOM plots are normalized and stacked above each other in an Overlay. 
This is useful when FOMs have different value ranges, but it is necessary 
to view the FOM plots in the same window to see any correlation. 

Overlaid in one window All FOM plots are overlaid in the same area. This is meaningful only when 
all plots have the same range of values. 

Separate windows Each FOM plot is plotted in an individual window. 
 
Foms to plot Listing of configured waveform and FOM name search data. 
 
Filter Select begin and end shot/burst numbers 

Filter is Shot number The shot number is used for the “Start Shot” and “End Shot” values. 

Filter is Burst number The burst number is used for the “Start Burst” and “End Burst” values. 

Start Shot Define the first shot/burst in the series of waveform names and associated 
FOMs. Numbers less than this entry are excluded from the plot. 

End Shot Define the last shot/burst in the series of waveform names and associated 
FOMs. Numbers greater than this entry are excluded from the plot. 

 
Shot Numbering (x-axis) Select the numbering type 

Use FOM/Burst shot  The first x-axis value will be the “Start Shot/Burst” number. 

Start x-axis at 1 The first x-axis value will be 1. If filtering FOMs by burst, Analyze again 
will determine the shots per burst and assign a percentage to each shot 
within the burst for the plot. 
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Destination Create a waveform or send the data to a text file. 

Output to window(s) Search results are sent to a window. The Waveforms/FOMS values are plotted 
like a waveform. The independent axis (x) is the shot number (also extracted 
from the database) and the dependent axis (y) is the actual FOM value. 

Output to text file Search results are sent to a text file and in a columnar format that is easily im-
ported into a spreadsheet. The data sent to the file is as follows: Shot, Fom 
Name, Fom Value, Burst, Shot In Burst. 

Export filename The full path (or default if no path is supplied) and the name of the file to write 
the search results into.  

Get File Activates the Window’s File Directory dialog for selecting a path and a file 
name to overwrite. 

7.4.6 Acquisition menu 

The Acquisition menu offers the following commands for specifying how Analyze handles ac-
quired data.  

Item Description 

Work Offline Sets Analyze to ignore new waveforms being transmitted from other modules dur-
ing acquisition or reduction.  

Fast Arm Automatically rearms DAAAC™ for another acquisition. If Acquire is not running 
on this computer, Fast Arm has no effect. 

Configuration The Acquisition Configuration dialog sets the display and print options for incom-
ing acquired or automatically reduced data. The Acquisition Configuration options 
determine only how Analyze manages acquired and reduced data transmitted from 
other modules or computers. Analyze does not control what data are transmitted or 
when data are transmitted. See Appendix B, Section 2.4.15. 

Reset Overlays Reset all running overlays displayed during acquisition.  See the Acquisition Con-
figuration interface for running overlay options. 

7.4.7 Tools menu 
Contains custom functions not presented here. 

7.4.8 Data View menu 

The Data View menu offers the following commands: 

Item Description 

Next Waveform Next Waveform activates the next waveform in a multi-waveform display.  This 
feature is available for Real, Imaginary or Magnitude and Phase waveform pairs 
following a Fast Fourier Transform. 

Go to Signal Line Transfers control to CalMan and highlights the Cal Line that originates at the chan-
nel that produce the selected waveform, provided the channel is active in CalMan. 
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Go To Instrument  Go to Instrument activates Acquire and opens the interface for the instrument that 
acquired the current waveform. This command can be used on a raw or automati-
cally processed waveform.  This function has no effect on imported or user created 
waveforms, or on Overlays.  The instrument’s dialog is activated so that changes 
can be made to the instrument settings.  

Log Page Log Page displays the associated log page in effect when this data was created, if 
one exists.  This display shows historic settings and cannot be edited. 

Acquisition Set-
tings 

Acquisition Settings displays the associated acquisition settings in effect when this 
data was created, if any exist.  This display shows historic settings and cannot be 
edited. 

Cal Lines Cal Lines displays the associated Cal Line configuration in effect when this data 
was created, if any exist.  This display shows historic settings and cannot be edited. 

Instrument Set-
tings 

Instrument Settings displays the associated instrument settings in effect when this 
data was created, for the associated channel.  This display shows historic settings 
and cannot be edited. 

Info.txt See the discussion in section Appendix B, Section 2.4.17. 

Error Log Open the DAAAC execution ASCII error log in Notepad.  This feature is useful for 
debugging DAAAC configuration errors.  VSI personnel may also require access to 
the log to determine why the program may be failing. 

7.4.9 Window menu 

The Window menu provides the following commands for displaying waveforms in Ana-
lyze: 
Item Description 

Next Page Next Page displays the next page of waveforms.  Next Page (and Previous Page) 
are enabled when there are more waveforms in the display buffer than will fit on 
one display page. The number of waveforms per page and the buffer size are set in 
Acquisition Configuration dialog (Section 4.2.7.3). 

If the remaining number of waveforms in the buffer is less than the Graphs Per 
Screen setting in the Acquisition Configuration dialog, then all remaining wave-
forms are displayed. 

Previous Page Previous Page displays the next page of waveforms. Previous Page (and Next Page) 
are enabled when there are more waveforms in the display buffer than will fit on 
one display page. The number of waveforms per page, and the buffer size, are set 
with the Acquisition Configuration dialog (Section 4.2.7.3). 

Selecting Previous Page removes the current waveforms from the display, then dis-
plays the last set of waveforms. 

Copy Copy creates a copy of the active waveform and displays it in a new window. The 
new, copied waveform then becomes the active window and is displayed on top of 
all other windows. Modifications to the copy have no effect on the original wave-
form. 

Cascade Overlaps all open windows.  
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Tile Tiles all open waveforms without overlapping.  

Arrange Icons Arranges icons of minimized windows.  

Close All Close All closes windows and removes all waveforms from the waveform buffer.  
The size of this buffer is set in the Acquisition Configuration dialog (Section 
4.2.7.3). 

1, 2, ... Activates the specified window. 

 

7.4.10 Help menu 

The Help menu provides the following functions for working with Analyze:  

Item Description 

Help Topics Opens an index of help topics.  

Tutorial Opens DAAAC’s on-line tutorial. 

About Analyze Displays Analyze’s version number, build date and other information.  

License Agreement Displays the DAAAC end-user license agreement. 

7.4.10.1 Index, Help menu 

Index displays the opening screen of Help. Instructions and reference information for using 
Analyze are available from the opening screen.  
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8 NetCom 
 

8.1 Overview 

NetCom is the communicator between DAAAC’s modules, the database, and the network.  Net-
Com starts automatically when Archive starts, and it must be running for DAAAC to access the database. 

The DAAAC database stores the system configurations and such data as waveforms, instrument 
settings and Cal Item data. As such, DAAAC™ relies on an active, open database. Each module (Ar-
chive, Acquire, Analyze and CalMan) must have access to this database, and NetCom must be running—
it is the communications link between the DAAAC™ modules and the database. 

NetCom does have a minimal user interface that displays status information, but you will rarely 
need to interact directly with this module.  NetCom’s configuration settings can be modified from Ar-
chive, as described in Section 5.4.6. 
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9  Glossary 
 
 
Acquire  The DAAAC module that manages 

communication between instruments and the 
DAAAC station.  Acquire displays the in-
strumentation racks as they are physically 
arranged.  Rearranging the rack setup is a 
simple drag-and-drop task.  Also, Acquire 
can capture data directly during acquisition, 
or download data stored in instrumentation. 

Adders  Signal path items that have multiple 
input ports and a single (combined) output 
port, all of which are active simultaneously.  

Analyze  The DAAAC module that displays and 
prints data, and provides tools for analyzing 
and manually processing waveforms and 
images.   

Archive  The DAAAC module that is 
DAAAC’s database manager.  From Ar-
chive, users can change databases, import or 
export data, and organize and transfer data. 

Cal Items  The DAAAC representation of 
physical signal path such as sensors, attenu-
ators, and cables.  Also includes components 
for automated signal processing. 

Cal Lines Data acquisition signal lines, such as 
channels stemming from instruments, that 
include components – called Cal Items – 
leading to a signal source. 

Cal Manager (CalMan) The DAAAC module 
that documents every channel’s signal path, 
providing a graphical display of the test 
setup and organizing the signal line compo-
nents.  CalMan uses this information to 
automatically reduce the data to physically 
meaningful quantities by unfolding the ef-
fects of components, or Cal Items. 

Channels  An instrument’s input or output 
ports. 

Characterization data  The defining set of pa-
rameters that describes the behavior of a Cal 
Item within a signal line.  DAAAC uses 

these parameters during automatic reduction 
to unfold the signal as received by the sen-
sor. 

Coax-Switches Signal path items that have mul-
tiple input and/or output ports; only one in-
put and one output are active at any given 
time.  

Database View  The Archive module view that 
shows which stations and tests are loaded.  
Copy data by dragging and dropping to 
other databases. 

Figures of Merit (FOMs)  Metrics computed 
from acquired or processed data. Some ex-
amples of figures of merit are X min and 
max, Y min and max, risetime, falltime, and 
pulse width. 

Global Settings  A collection of controls for 
configuring “global” acquisition settings.  
These features include configuring activity 
logs, creating new tests, and defining the ac-
quisition parameters.    

Graph  The two-dimensional representation of 
CalMan’s documented signal lines.  Includes 
connection information for instruments, 
channels, and signal line components. 

Instrument  Any device that is controlled via 
the Acquire module.  Typically a device that 
collects and converts an analog signal into 
digital data. 

Inventory data  Identification data that is 
unique for each Cal Item.  Inventory data in-
cludes serial numbers, bar code numbers, 
model numbers, and property control num-
bers. 

Inventory List  DAAAC’s inventory of Cal 
Items.   

Multi-Port Cal Items  Signal line components 
that have multiple input or output ports, such 
as Adders, Splitters and Coax-Switches. 
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Named Configurations  An entire test system 
description that can be pre-configured and 
recalled in seconds, which makes test recon-
figuration a simple point-and-click task.  
Also, instruments can be configured from 
their front panels and DAAAC 4.0 will cap-
ture and store those settings for use in future 
tests. 

Named Configuration View  The Archive dis-
play of the various Named Configurations 
used for restoring DAAAC to a previous test 
setup, as well as copying Named Configura-
tions to other databases. 

NetCom  The DAAAC module that provides an 
interface between the other DAAAC mod-
ules and the database. 

Nodes  Graphical elements in CalMan’s graph 
that represent the various signal line compo-
nents. 

ODBC  The Object Database Connectivity ap-
plication programmer’s interface (API) for 
standardized access to database management 
systems. 

Processed waveforms / images  Data that have 
been changed or edited after acquisition. 

Raw waveforms / images  Data that have been 
retrieved from an instrument and have not 
been processed. 

Reduced waveforms / images Data that have 
been processed after acquisition by applying 
the item specific algorithms specified in the 
CalMan module. 

Reduction Data  Post-processing settings for 
each node in CalMan’s graph. 

Signal lines  Also called Cal Lines, signal lines 
are the signal paths that stem from an re-
cording instrument to a sensor.  They are 
comprised of various components, called 
Cal Items. 

Splitters  Signal path items that have a single 
input port and multiple output ports, all of 
which are active simultaneously.  

Station  A single computer that has instrumenta-
tion connected to it via GPIB or other inter-
face to form a data acquisition system. 

Test  An organizational unit for acquisition data. 

Trash  The cache of deleted waveforms and im-
ages.  Trashed data can be recovered. 

Waveform View  The Archive View that dis-
plays raw and processed data by date. 
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